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1 Introduction
Welcome to this User Guide for Ocula 3.0 on Nuke. Ocula is a collection of tools that solve common problemswith
stereoscopic imagery, improve productivity in post production, and ultimately help to deliver amore rewarding 3D-
stereo viewing experience.

All Ocula plug-ins integrate seamlessly into Nuke. They are applied to your clips as any other node and they can all be
animated using the standard Nuke animation tools.

About this User Guide
This User Guidewill tell you how to install and use theOcula 3.0 plug-ins and tools. Each plug-in or tool is described
in detail in later chapters. Licensing Ocula is covered in the separate Foundry Licensing Tools (FLT) User Guide, which
you can download fromhttp://www.thefoundry.co.uk/licensing.

This guide assumes you are familiar with Nuke and themachine it is running on.

NOTE: For themost up-to-date information, please see theOcula on Nuke product page and the latest
Ocula 3.0 user guide on ourweb site at http://www.thefoundry.co.uk.

What’s New?
Have a look at the new features and improvements in Appendix A.

Example Images
Example images are provided for usewith all of the plug-ins. You can download these images fromourweb site at
http://www.thefoundry.co.uk/support/user-guides#ocula and try Ocula out on them.

Installation
Installing Ocula 3.0 will NOT overwrite any versions of Ocula 2.x or Ocula 1.x.

To see the installation instructions for your operating system, go to:

http://www.thefoundry.co.uk/support/user-guides#ocula
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• Installation onWindows on page 9

• Installation onMac on page 10

• Installation on Linux on page 11

NOTE: You can put theOcula plug-ins anywhere as long as you set the environment variable NUKE_PATH
to point to it.

Installation on Windows

Ocula is distributed as a software download fromourweb site at http://www.thefoundry.co.uk/. To install Ocula on
a computer runningWindows, follow these instructions:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourweb site at http://www.thefoundry.co.uk/:
Ocula_3.0v4_Nuke_<version>-win-x86-release-64.zip

2. Unzip the file you downloaded.

3. Double-click on the exe file to launch the installer. Follow the on-screen instructions to install the plug-ins.

4. Proceed to Licensing Ocula on page 12.

Installing Ocula from the command line

To install Ocula from the command line, do the following:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourweb site at http://www.thefoundry.co.uk/:
Ocula_3.0v4_Nuke_<version>-win-x86-release-64.zip

2. To open a command prompt window, select Start > All Programs > Accessories > Command Prompt.

3. Use the cd (change directory) command tomove to the directory where you saved the installation file. For
example, if you saved the installation file in C:\Temp, use the following command and press Return:
cd \Temp

4. To install Ocula, do one of the following:

• To install Ocula and display the installation dialog, type the name of the install file without the file extension
and press Return:
Ocula_3.0v4_Nuke_<version>-win-x86-release-64

1 INTRODUCTION |
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• To install Ocula silently so that the installer does not prompt you for anything but displays a progress bar, enter
/silent after the installation command:
Ocula_3.0v4_Nuke_<version>-win-x86-release-64 /silent

• To install Ocula silently so that nothing is displayed, enter /verysilent after the installation command:
Ocula_3.0v4_Nuke_<version>-win-x86-release-64 /verysilent

NOTE: By running a silent install of Ocula, you agree to the terms of the End User License Agreement. To
see this agreement, please refer to Appendix D on page 154 or run the installer in standard, non-silent
mode.

Installation on Mac

Ocula is distributed as a software download fromourweb site at http://www.thefoundry.co.uk/. To install Ocula 3.0
on aMac, follow these instructions:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourweb site at http://www.thefoundry.co.uk/:
Ocula_3.0v4_Nuke_<version>-mac-x86-release-64.dmg

2. Double-click on the downloaded dmg file.

3. Double-click on the pkg file that is created.

4. Follow the on-screen instructions to install the plug-ins.

5. Proceed to Licensing Ocula on page 12.

Installing Ocula silently from the command line

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourweb site at http://www.thefoundry.co.uk/:
Ocula_3.0v4_Nuke_<version>-mac-x86-release-64.dmg

2. Launch a Terminal window.

3. To mount the dmg installation file, use thehdiutil attach command with the directory where you saved the
installation file. For example, if you saved the installation file in Builds/Ocula, use the following command:
hdiutil attach /Builds/Ocula/Ocula_3.0v4_Nuke_<version>-mac-x86-release-64.dmg

4. Enter the following command:
pushd /Volumes/Ocula_3.0v4_Nuke_<version>-mac-x86-release-64/

This stores the directory path inmemory, so it can be returned to later.

1 INTRODUCTION |
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5. To install Ocula, use the following command:
sudo installer -pkg Ocula_3.0v4_Nuke_<version>-mac-x86-release-64.pkg -target "/"

You are prompted for a password.

6. Enter the following command:
popd

This changes to the directory stored by the pushd command.

7. Finally, use the following command to eject themounted disk image:
hdiutil detach /Volumes/Ocula_3.0v4_Nuke_<version>-mac-x86-release-64/

NOTE: By running a silent install of Ocula, you agree to the terms of the End User License Agreement. To
see this agreement, please refer to Appendix D on page 154 or run the installer in standard, non-silent
mode.

Installation on Linux

Ocula is distributed as a software download fromourweb site at http://www.thefoundry.co.uk/. To install Ocula 3.0
on a computer running Linux, follow these instructions:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourweb site at http://www.thefoundry.co.uk/:
Ocula_3.0v4_Nuke_<version>-linux-x86-release-64.tgz

2. Move the downloaded file to the following directory (create the directory if it does not yet exist):
/usr/local/Nuke/

3. In the abovementioned directory, extract the files from the archive using the following command.
tar xvzf Ocula_3.0v4_Nuke_<version>-linux-x86-release-64.tgz

This will create the <version>/plugins/Ocula/3.0 subdirectory (if it doesn’t already exist), and install the plug-
ins in that directory.

4. Proceed to Licensing Ocula on page 12.

TIP: To install Ocula silently, you can simply unzip the installer file. This creates the properly formed Ocula
directory tree in the current directory. By installing Ocula silently, you agree to the terms of the End User
License Agreement. To see this agreement, please refer to Appendix D on page 154 or run the installer in
standard, non-silent mode.

Installing Ocula remotely from the command line

If you need to install Ocula on rendermachines using the command line, do the following:

1 INTRODUCTION |
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NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourweb site at http://www.thefoundry.co.uk/:
Ocula_3.0v4_Nuke_<version>-linux-x86-release-64.tgz

2. Extract the installer from the tgz archivewith the following terminal command:
tar xvzf Ocula_3.0v4_Nuke_<version>-linux-x86-release-64.tgz

This gives you an installer file.

3. Use the following terminal command to log in to your rendermachine as root:
ssh root@render_machine

Replace render_machine with the name of your render node.

4. Make a directory to install Ocula to:
mkdir /usr/local/Ocula3.0v4

5. Copy the installer file from themachine that you downloaded it on to your rendermachinewith a command like:
scp root@download_machine:/tmp/Ocula_3.0v4_Nuke_<version>-linux-x86-release-64-
installer root@render_machine:/usr/local/Ocula3.0v4/

Replace download_machine with the name of themachine you downloaded the installer file to, and render_
machine with the name of your render node.

6. Unzip the installer file to unpack its contents into your Ocula directory:
cd /usr/local/Ocula3.0v4

unzip Ocula_3.0v4_Nuke_<version>-linux-x86-release-64-installer

7. Repeat steps 3-6 for each rendermachine.

Licensing Ocula

About Licences

If you simply want to try out Ocula, you can obtain a trial licence, which allows you to run Ocula for free for 15 days.

To useOcula after this trial period, you need either a valid license key or a floating license and server running the
Foundry Licensing Tools (FLT):

• Licence Keys—These can be used to install and activatenode locked (also known as uncounted) licences. Node
locked licences allow you to useOcula on a singlemachine. This licencewill not work on a different machine and if
you need it to, you’ll have to transfer your licence. Node locked licences do not require additional licensing software
to be installed. See Licensing Ocula on a SingleMachine formore information.

• Floating Licences—also known as counted licences, enableOcula to work on any networked client machine. The
floating licence should be put on the server and is locked to a unique number on that server. Floating licences on a
server require additional software to be installed. This softwaremanages those licences on the server, giving

1 INTRODUCTION | LICENSING OCULA
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licences out to client stations that want them. The software you need to manage these licenses is called the
Foundry License Tools (FLT) and it can be freely downloaded fromourweb site. Floating licences often declare a
port number on the server line and a port number on the vendor line. See Licensing Ocula over a Network formore
information.

The instructions below run through both licensingmethods, and you can find amore detailed description in the
Foundry Licensing Tools User Guide available on our website: http://www.thefoundry.co.uk/support/licensing/

Licensing Ocula on a Single Machine

Obtaining a Licence Key

You can purchase licence keys by:

• going to our web site at http://www.thefoundry.co.uk/,

• e-mailing us at sales@thefoundry.co.uk,

• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.

To generate a licence key, we need to know your System ID. The System ID (sometimes called Host ID or rlmhostid)
returns a unique number for your computer. We lock our licence keys to the System ID.

To display your System ID, do the following:

• OnWindows andMac

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. The Sys-
tem ID is displayed at the bottomof thewindow.

• On Linux

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it from the
command line:
<download location>/FoundryLicenseUtility -i

NOTE: The <download location> refers to the location where you saved the Foundry Licensing Utility.

Just so you knowwhat a System ID number looks like, here’s an example: 000ea641d7a1.

Installing the Licence

Once a license has been generated for you, we e-mail you the license key and instructions on how to obtain the cor-
rect version of the Foundry LicenseUtility (FLU). Gunzip or untar the file and save the FLU and your license key to a
folder of your choice. The instructions below tell you what to do with these.

1 INTRODUCTION | LICENSING OCULA ON A SINGLEMACHINE
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OnWindows andMac

Just drop the licence key on the Foundry LicenseUtility (FLU) application to install it. This checks the licence key and
copies it to the correct directory.

On Linux
1. Navigate to the location of the FLU_[version]_linux-x86-release-64.tgz file.

2. Type the following commands to extract and install the FLU. Note that you need to replace [version]with the
version of FLU you are using and [my licence]with the location of your licence key.
tar xvzf FLU_[version]_linux-x86-release-64.tgz

cd FLU_[version]_linux-x86-release-64

./FoundryLicenseUtility -l [my license]

For example, if you saved your licence key to /tmp/Foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/foundry.lic

This checks the licence key and copies it to the correct directory.

Licensing Ocula over a Network

Obtaining Floating Licences

You can purchase a floating licence key by:

• going to our web site at http://www.thefoundry.co.uk/,

• e-mailing us at sales@thefoundry.co.uk,

• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.

To generate you a licence key, we need to know the System ID of themachine that will act as the server. The System
ID (sometimes called Host ID or rlmhostid) returns a unique number for the computer. We lock our licence keys to
the System ID. See Installing Floating Licences.

To display your System ID, do the following:

• OnWindows andMac

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. The Sys-
tem ID is displayed at the bottomof thewindow.

• On Linux

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it from the
command line:
<download location>/FoundryLicenseUtility -i

1 INTRODUCTION | LICENSING OCULA OVER A NETWORK
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NOTE: The <download location> refers to the location where you saved the Foundry Licensing Utility.

NOTE: The System ID needs to be from themachine that will act as the server and not one of the client
machines.

Just so you knowwhat a System ID number looks like, here’s an example: 000ea641d7a1.

Installing Floating Licences

Once a floating licence has been created for you, we e-mail you a tgz file containing the license key and instructions
on how to obtain the correct version of the Foundry LicenseUtility (FLU). Gunzip or untar the file and save the FLU
and your license key to a folder of your choice.

Having installed a floating licence key, you need to install some additional software (FLT) to manage the licences on
your network. Then you need to tell the client machines where to find the licences.

OnWindows andMac
1. Just drop the licence key on the Foundry LicenseUtility (FLU) application to install it. This checks the licence key

and copies it to the correct directory.

The licence server address is displayed on screen:

<number>@<licence server name>

You shouldmake a note of the address as you’ll need it to activate the client machines.

2. In order for the floating licence to work, you need to install the Foundry Licensing Tools (FLT) on the licence
servermachine (not the client machines). Formore information on how to install floating licences, refer to the
FLT user guide, which you can download fromourweb site:
http://www.thefoundry.co.uk/support/licensing/tools/.

3. Once your licence server is up and running, you need to direct your client machines to the server in order to
obtain a licence. See Telling the Client MachinesWhere to Find the Licences on page 16.

On Linux
1. Navigate to the location of the FLU_[version]_linux-x86-release-64.tgz file.

2. Type the following commands to extract and install the FLU. Note that you need to replace [version]with the
version of FLU you are using and [my licence]with the location of your licence key.
tar xvzf FLU_[version]_linux-x86-release-64.tgz

cd FLU_[version]_linux-x86-release-64

./FoundryLicenseUtility -l [my license]

For example, if you saved your licence key to /tmp/Foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/Foundry.lic

1 INTRODUCTION | LICENSING OCULA OVER A NETWORK
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This checks the licence key and copies it to the correct directory.

The licence server address is displayed on screen:

<number>@<licence server name>

You shouldmake a note of the address as you’ll need it to activate the client machines.

3. In order for the floating licence to work, you need to install the Foundry Licensing Tools (FLT) on the licence
servermachine (not the client machines). Formore information on how to install floating licences, refer to the
FLT user guide, which you can download fromourweb site:
http://www.thefoundry.co.uk/support/licensing/tools/.

4. Once your licence server is up and running, you need to direct your client machines to the server in order to
obtain a licence. See Telling the Client MachinesWhere to Find the Licences on page 16.

Telling the Client Machines Where to Find the Licences

In order for the client machines to get a licence from the server, they need to be told where to look.

OnWindows andMac
1. Launch the Foundry LicenseUtility (FLU).

2. Make sure you are viewing the License Install tab and copy and paste in an RLM server line:
HOST <server name> any <port>

For example: HOST red any 4101

This creates and installs both a FLEXlm and an RLM client license.

3. Repeat this process for eachmachine you wish to have access to licenses on the server.

On Linux
1. Launch a shell and navigate to the location of the FLU_[version]_linux-x86-release-64.tgz file.

2. Type the following commands, replacing [version]with the version of FLU you are using:
tar xvzf FLU_[version]_linux-x86-release-64.tgz

cd FLU_[version]_linux-x86-release-64

./FoundryLicenseUtility -c <port>@<server name>

For example, the last linemay be:
./FoundryLicenseUtility -c 4101@red

This creates and installs both a FLEXlm and an RLM client license.

3. Repeat this process for eachmachine you wish to have access to licenses on the server.

1 INTRODUCTION | LICENSING OCULA OVER A NETWORK
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Further Reading

Formore information on licensing Ocula, displaying the System ID number, setting up a floating licence server,
adding new licence keys, andmanaging licence usage across a network, you should read the Foundry Licensing Tools
User Guide available on our web site:

http://www.thefoundry.co.uk/support/licensing/tools/

Other Foundry Products
The Foundry is a leading developer of visual effects and image processing technologies for film and video post pro-
duction. Its stand-alone products includeNuke, Modo, Mari, Hiero, Katana, and Flix. The Foundry also supplies a
suite of plug-ins, including Ocula, CameraTracker, Keylight, Kronos, and Furnace and FurnaceCore for a variety of com-
positing platforms, including Adobe® After Effects®, Autodesk® Flame®, Avid® DS™, and Apple’s Final Cut Pro®.
For the full list of products and supported platforms, visit our website at http://www.thefoundry.co.uk.

Nuke is an Academy Award®winning compositor. It has been used to create extraordinary images on scores of fea-
ture films, including Avatar, District 9, TheDark Knight, IronMan, Quantumof Solace, The Curious Case of Benjamin
Button, Transformers, and Pirates of the Caribbean: At World’s End.

Modo brings you the next generation of 3D modeling, animation, sculpting, effects and rendering in a powerful integ-
rated package.

Mari is a creative texture-painting tool that can handle extremely complex or texture-heavy projects. It was
developed at Weta Digital and has been used on films, such as District 9, TheDay the Earth Stood Still, The Lovely
Bones, and Avatar.

Hiero is a collaborative, scriptable timeline tool that conforms edit decision lists and parcels out VFX shots to artists,
allowing progress to be viewed in context, and liberating your finishing systems and artists formore creative tasks.

Katana is a look development and lighting tool, replacing the conventional CG pipelinewith a flexible recipe-based
asset workflow. Its node-based approach allows rapid turnaround of high-complexity shots, while keeping artists in
control and reducing in-house development overheads. Extensive APIsmean it integrates with a variety of renderers
and your pre-existing shader libraries and workflow tools.

Flix is a collaborative, visual story-development tool. It allows directors, editors, cinematographers, storyboard
artists, and pre-visualization artists to explore ideas quickly, saving valuable time, and to easily collaborate on the
visual story development of a film.

Ocula is a collection of tools that solve common problemswith stereoscopic imagery, improve productivity in post
production, and ultimately help to deliver amore rewarding 3D-stereo viewing experience.

1 INTRODUCTION | OTHER FOUNDRY PRODUCTS
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CameraTracker is an After Effects plug-in allowing you to pull 3D motion tracks andmatchmoves without having to
leave After Effects. It analyses the source sequence and extracts the original camera's lens andmotion parameters,
allowing you to composite 2D or 3D elements correctly with reference to the camera used to film the shot.

Keylight is an industry-proven blue/green screen keyer, giving results that look photographed, not composited. The
Keylight algorithmwas developed by the Computer Film Company who were honoured with a technical achievement
award for digital compositing from the Academy of Motion Picture Arts and Sciences.

Kronos is a plug-in that retimes footage usingmotion vectors to generate additional images between frames. Util-
ising NVIDIA’s CUDA technology, Kronos optimises your workflow by using both the CPU and GPU.

Furnace and FurnaceCore are collections of film tools. Many of the algorithms utilisemotion estimation technology
to speed up common compositing tasks. Plug-ins includewire removal, rig removal, steadiness, deflicker, degrain and
regrain, retiming, and texture tools.

1 INTRODUCTION | OTHER FOUNDRY PRODUCTS



2 Solver

Introduction
TheO_Solver plug-in defines the geometric relationship between the two views in the input images (that is, the cam-
era relationship or solve). This is necessary if you want to useDisparityGenerator, VectorGenerator, or VerticalAligner
down the tree.

To define the camera relationship, O_Solver detects a number of features in one view and locates the corresponding
features in the other (see the image below). The featurematches and analysis data are not available until you have
set at least one keyframe on O_Solver. Any frames set as keyframes show up on the Viewer timeline and can be visu-
alised in the Curve Editor and Dope Sheet.

O_Solver detects features in each view and tries to match them.

O_Solver only calculates the solve at the keyframes. The solves for all other frames are created by interpolating
between the results on the keyframes on either side. Interpolating between keyframes ensures that the calculated
solve varies smoothly across the sequence.

The output of theO_Solver node consists of:

• the unaltered input images, and

• the results of the feature detection and analysis, which are passed down the node tree as hiddenmetadata.
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Because the results of the analysis are available downstream, you can usemultiple Ocula nodes in the treewithout
having to re-analyse the camera relationship. However, if a node generates ormodifies views, the current metadata
becomes invalid and is removed from the tree from that point forward.

Note that the camera relationship is the same for any images filmed using a particular camera setup. When you have
found an imagewith features that O_Solver is able to match well, you can re-use the analysis of that image on other
images shot with the same camera setup.

To get the best possible results, you can identify features to ignore in the analysis. This can be done either by delet-
ing features displayed in a Viewer overlay, or by supplying amask in the Ignore input.

You can also add your own featurematches to the automatically detected ones. O_Solver considers any feature
matches you’ve added yourself superior to the ones it detects automatically and pays themmore attention. This can
also influencewhich of the automatically detected features are included in the final solve. To force the feature
matches to be recalculated based on themanual featurematches, use theRe-analyse Frame button.

If you have a pretracked camera that describes the camera setup used to shoot the images, you can also supply this
in theCamera input. If you connect the Camera node before adding a keyframe, the automatically-detected feature
matches are validated against the input camera. Alternatively, you can add the Camera node after the analysis and
use theRe-analyse Frame button to recalculatematches based on the input camera. Formore information, see
Inputs below.

TIP: When shooting bluescreen or greenscreen footage, youmay be able to improveO_Solver's feature
matching by addingmarkers to the shot. If you want to do so, make sure themarkers are as unreflective
as possible and stagger themover depth. Then, add usermatches on themarkers to correct the calculated
alignment.

Inputs
O_Solver has three inputs:

• Source - A stereo pair of images. These can either be the images you want to work on, or another pair of images
shot with the same camera setup.

• Ignore - Amask that specifies areas to ignore during the feature detection and analysis. This can be useful if an
area in the Source image is producing incorrectly matched features. This input is optional.

• Camera - A pretracked Nuke stereo camera that describes the camera setup used to shoot the Source image. This
can be a camera you have tracked with the CameraTracker node or imported to Nuke from a third-party camera
tracking application. This input is optional.
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TIP: In Nuke, a stereo camera can be either:
- a single Camera node in which some or all of the controls are split, or

- two Camera nodes (one for each view) followed by a JoinViews node (Views > JoinViews). The JoinViews
node combines the two cameras into a single output.

NOTE: To seewhat data each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To define the geometrical relationship between the two views, do the following:

1. Connect theO_Solver node. See Connecting theO_Solver Node.

2. Calculate the camera relationship. See Calculating the Camera Relationship.

3. Visualise and edit the results. See Reviewing and Editing the Results.

4. Feed the results to O_DisparityGenerator, O_VerticalAligner, or O_VectorGenerator. See Feeding the Results to
Other Ocula Nodes.

Connecting the O_Solver Node
1. Start Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set

up views for ste-reo button.

2. From the Toolbar, select Image > Read to load your stereo clip into Nuke. This can either be the clip you want to
work on, or another clip shot with the same camera setup. If you don’t have both views in the same file, select
Views > JoinViews to combine them, or use a variable in the Read node’s file field to replace the name of the
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view (use the variable%V to replace an entire view name, such as left or right, and%v to replace an initial letter,
such as l or r). Formore information, refer to theNukeUser Guide.

3. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node after either the stereo clip or the JoinViews
node (if you inserted one in the previous step).

4. Connect a Viewer to theO_Solver node.

The node treewith O_Solver.

5. Proceed to Calculating the Camera Relationship below.

Calculating the Camera Relationship
1. Open theO_Solver controls. UnderViews to Use, you can see all the views that exist in your project settings.

Select the two views you want to use for the left and right eyewhen calculating the camera relationship.

The two views you selected aremapped for the left and right eye.

2. If you have a pretracked Nuke stereo camera that describes the camera setup used to shoot the Source image,
connect that to O_Solver’s Camera input. O_Solver uses the camera information to calculate the relationship
between the two views.

3. Set at least one keyframe for O_Solver to analyse. Use the Viewer timeline to scrub to a frame that is easy to
match between views - ideally, a framewith enough picture detail, but nomotion blur, occluding fog, or dust.
Then, click Add Key. Repeat as necessary:

• If the camera rig doesn't change, you can set keyframes only on one frame or far apart (for example, on the
first and last frames). If you do set a few keyframes, you can also check Single Solve from All Keys in theO_
Solver controls. This tells O_Solver to calculate a single solve using all keyframes, which can improve the results.

• If you know there is a zoomor change in the camera setup on certain frames, you need to addmore keyframes
in between. Leave Single Solve from All Keys unchecked to use a separate solve for each keyframe, and
place keyframeswhere the camera alignment changes.

O_Solver analyses the keyframes you added and, if it findsmore than one keyframe, it interpolates the results
between them. Interpolating between keyframes ensures that the calculated camera relationship varies
smoothly across the sequence.

To visualise the keyframed analysis in the Curve Editor or Dope Sheet, right-click on theAnalysis Key field and
select Curve editor orDope sheet. Note, however, that you cannot edit the curve in either.

4. Proceed to Reviewing and Editing the Results below.
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NOTE: OnceO_Solver has automatically detected featurematches, they are fixed and do not update in
response to changes in the node tree. You can edit themmanually, however, or click Re-analyse Frame
to forceO_Solver to recalculate the current frame. The automatically detected featurematches are also
updated if you adjust any O_Solver controls that affect the analysis.

Reviewing and Editing the Results
1. Set Display to Keyframe Matches (or pressM on the Viewer) andmake sure you are viewing a keyframe.

The features andmatches used to calculate the camera relationship are shown in a Viewer overlay. The views set
up in the project settings dictate the colour of the features in the overlay. If you used Set up views for stereo
to create the views, red indicates a feature in the left view and green a feature in the right view.

Note that the detected features should be spread around the image. If this is not the case, adjust the Features
controls or edit the featurematchesmanually as described below.

A bad selection of features. A better selection of features.

2. Zoom in on some individual featurematches and switch between the two views to see if thematches are accur-
ate. If you can seematches that are clearly not accurate, delete themby right-clicking on them and selecting
delete selected. Note that you can only select the feature on the view your currently on. So if you're on the left
view, you can only select red features.

If an entire area of the image is producing poormatches, drag to select multiplematches before clicking delete
selected. You can also press Shift while dragging to select (or deselect) multiple areas and Backspace to
remove them.

Alternatively, you can specify areas to ignore using amask in either the Ignore input or the alpha of the Source
image. In theO_Solver controls, setMask to the component you want to use as themask.

Note that features generated on reflections often produce bad featurematches. However, you only need to
delete such features if O_Solver is producing poor results.

3. To preview howwell the detected features describe the alignment of the stereo camera, set Display to Preview
Alignment (or press P on the Viewer).

Preview Alignment shows the alignedmatches at keyframes, but also calculatesmatches at non-keyframes.
This allows you to review howwell the interpolated solveworks and whether additional keyframes are required.
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Display set to Preview Alignment.

4. Use theAlignment Methodmenu to change how the views are aligned and see how this impacts the feature
matches.

5. Ideally, most lines in the overlay should be horizontal. Any matches that aren’t horizontal and have a vertical
error greater than Error Threshold are pre-selected and displayed in yellow. These are considered poor
matches. If you scrub through the timeline and find frameswith a lot of yellowmatches, addmore keyframes
for O_Solver to analyse.

6. Once you are happy with the keyframes, make sure you are viewing one of them. If you still see some yellow
matches, right-click on them and select delete selected to remove them (or press backspace).

7. Increase theMatch Offset value to artificially increase the disparity, so you can better see how horizontal the
featurematches are. Again, if you can see lines that aren’t horizontal, right-click on them and select delete selec-
ted.

You can also adjustMatch Offset by pressing < or > on the Viewer.

8. Next, adjustMatch Offset to converge on different points in the image. Accurate featurematches should sit on
top of each other when you converge on them. If you can see a vertical offset between any featurematches,
you can delete thosematches.
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When converged on, accurate feature
matches sit on top of each other (left),
whereas poormatches are vertically

offset (right).

9. It’s important that there is a good number of featurematches spread around the entire image. If at this point
you are left with only a few accurate featurematches, you should addmorematchesmanually. O_Solver con-
siders thesemanually addedmatches superior to the ones detected automatically and pays themmore atten-
tion when calculating the final results.

You should also addmore featurematchesmanually if the automatic feature detection didn’t produce enough
matches in some parts of the image. In cases like this, it’s a good idea to add at least four usermatches (one in
each corner of the image), but themore (accurate) matches you have, the better!

To add a featurematch, make sure you are viewing a keyframe. Then, right-click in the Viewer and select add fea-
ture (see the images below). Switch to the other view and drag the feature you just added to its correct location
in that view. As you can see, the feature for the left view is represented by a different colour than the feature for
the right view.

Adding a feature to the left
view.

The new feature is represented
by a large crosshair.

Dragging the feature to its
correct location in the right view.

Youmay also notice that there are now two kinds of featurematches in the Viewer overlay:

This is a feature you’ve addedmanually.

2 SOLVER | QUICK START



26

This is a featureO_Solver has detected automatically.

10. If you’re not happy with the results, try using O_Solver on another sequence shot with the same camera setup.
Then, connect theO_Solver node to the Solver input of O_DisparityGenerator, O_VerticalAligner, or O_Vect-
orGenerator.

NOTE: When you calculate a camera relationship for a different sequence and attach it to the Solver input
of O_DisparityGenerator, O_VerticalAligner, or O_VectorGenerator, the camera relationship is still accessed
at the current time frame. For example, if the Solver clip has frames 1-10 and the Source clip has frames
1-100, the camera relationship from frame 10 of the Solver clip is used for frames 10-100. You can
resolve this by getting O_Solver to just give a single result that is always used. If this is not the case, the
sequencesmay need to be retimed so that the calculated camera relationship is consistent with the
sequence that is being analysed.

11. Once you are happy with the results of O_Solver, proceed to Feeding the Results to Other Ocula Nodes below.

Feeding the Results to Other Ocula Nodes
1. Do one of the following:

• Select Ocula > Ocula 3.0 > O_DisparityGenerator to insert an O_DisparityGenerator node after O_Solver.
This is necessary if you want to useO_InteraxialShifter, O_ColourMatcher (in 3D LUT and Local Matching
modes), O_VerticalAligner (in Local Alignmentmode), O_NewView, O_DisparityToDepth, O_VectorGenerator
(if disparity channels don’t exist in the input clip), O_OcclusionDetector, or O_FocusMatcher down the tree.

O_Solver followed by O_DisparityGenerator.

• Select Ocula > Ocula 3.0 > O_VerticalAligner to insert an O_VerticalAligner node after O_Solver. This node
can be used to correct the vertical alignment of either O_Solver’s input clip or another clip shot with the same
camera setup. In theGlobal Alignmentmode, O_VerticalAligner does not need disparity vectors, so you do
not need to useO_DisparityGenerator before this node.

O_Solver followed by O_VerticalAligner.
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• Select Ocula > Ocula 3.0 > O_VectorGenerator to insert an O_VectorGenerator node after O_Solver. This
node can be used to generatemotion vector fields for each view in either O_Solver’s input clip or another clip
shot with the same camera setup. Note that if the input clip doesn’t include disparity channels, you also need
an O_DisparityGenerator node beforeO_VectorGenerator.

O_Solver followed by O_VectorGenerator.

You can use the sameO_Solver for O_DisparityGenerator, O_VerticalAligner, and O_VectorGenerator. This way,
you don't have to calculate the camera relationship several times.

2. To learnmore about O_DisparityGenerator, O_VerticalAligner, and O_VectorGenerator, review the chapters on
DisparityGenerator, VerticalAligner, and VectorGenerator.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to calculate
the features and the camera relationship. These viewswill bemapped for the left and right eye.

Analysis

Analysis Key - Once you have set some keyframes, they are highlighted here and O_Solver does the featurematch-
ing and analysis only on those frames. The solves for all other frames are created by interpolating between the res-
ults on the keyframes on either side. This field is for display only. To edit the keyframes, useAdd Key andDelete
Key.

TIP: Keyframe interpolation helps to ensure smooth changes in the calculated camera relationship
between views. Oneway to define the keyframes is to set keys at the start and end of the sequence, then
add intermediate keys where the camera geometry changes. You can visualise howwell the interpolated
geometry matches the real images by settingDisplay to Preview Alignment in theO_Solver controls. If
you see a lot of yellowmatches (matches that have a vertical error greater than Error Threshold), you
may need to addmore keyframes.

NOTE: Alternatively, you can quality check the interpolated geometry by using O_VerticalAligner followed
by an Anaglyph node. SetWarp Mode in O_VerticalAligner to Global Alignment andGlobal Method to
Camera Rotation to interpolate the calculated camera relationship and check whether there is any ver-
tical displacement between the aligned views in the anaglyph view. See Example for an example of how to
useO_Solver, O_VerticalAligner, and Anaglyph.

Add Key - Set an analysis key at the current frame.
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Delete Key - Delete an analysis key at the current frame.

Delete All - Delete all analysis keys.

Single Solve from All Keys - When enabled, O_Solver calculates a single solve using all the keyframes you have set.
Use this for rigs that don’t change over time to get more accurate results than when using a single keyframe.

Do not use this if there is jitter in the alignment or there is a change in separation, convergence, or zoom. Instead,
use a separate solve for each keyframe and place keys where the alignment changes.

Features

Mask - If an area in the Source clip is producing poor featurematches, you can use this control to select areas of the
image to ignore during the feature detection and analysis.

•None - Use the entire image area.

• Source Alpha - Use the alpha channel of the Source clip as an ignoremask.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip as an ignoremask.

•Mask Luminance - Use the luminance of the Ignore input as an ignoremask.

•Mask Inverted Luminance - Use the inverted luminance of the Ignore input as an ignoremask.

•Mask Alpha - Use the alpha channel of the Ignore input as an ignoremask.

•Mask Inverted Alpha - Use the inverted alpha channel of the Ignore input as an ignoremask.

Number - Set the number of features to detect in each image andmatch between views.

Threshold - Set the threshold to select features in an image. Use a high value to select prominent points. Use a low
value to spread features out across the image.

Separation - Set a required feature separation to force detected features to cover the image. It is important that the
features do not cluster together. If you set Display to KeyframeMatches and see that this is the case, try increasing
this value.

Display

Display - Change the display mode.

•Nothing - Only show the Source image.

• Keyframe Matches - Show the features andmatches for the camera relationship calculation in a Viewer overlay.
An example of what thismode does is shown below.
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Showing the features andmatches for the camera relationship cal-
culation in a Viewer overlay.

You can use thismode to seewhereO_Solver has found features andmatches, and evaluate how accurate they
are. You can also edit the featurematchesmanually. To delete a poormatch, right-click on it and select delete
selected. To addmatchesmanually, right-click on a feature and select add feature. Then, switch to the other
view, and line up the correspondingmatch in that view.

Featurematches are only calculated for the keyframes.

You can also activate thismode by pressingM on the Viewer, or by selecting display matches from the Viewer’s
right-click menu.

• Preview Alignment - Preview howwell the calculated featurematches describe the alignment of the stereo cam-
era. This shows the alignedmatches at keyframes, but also calculatesmatches at non-keyframes, allowing you to
review howwell the interpolated solveworks and whether additional keyframes are required. If the lines between
featurematches are horizontal, they describe the alignment of the camera rig well. If any lines are skewed (and dis-
played in yellow), youmay want to delete the featurematches in question. If necessary, you can also addmanual
featurematches to replace them and preview the effect of themanualmatches in the overlay. An example of what
thismode does is shown below.
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Visualising the alignment of the calculated
featurematches.

You can also activate thismode by pressing P on the Viewer, or by selecting preview alignment from the Viewer’s
right-click menu.

Alignment Method - The alignment method to use to align the viewswhenDisplay is set to Alignment.

• Vertical Skew - Align the features along the y axis using a skew. This does not move the features along the x axis.

• Perspective Warp - Do a four-corner warp on the images to align themon the y axis. Thismay move the features
slightly along the x axis.

• Rotation - Align the features vertically by rotating the entire image around a point. The centre of the rotation is
determined by the algorithm.

• Scale - Align the features vertically by scaling the image.

• Simple Shift - Align the features vertically by moving the entire image up or down.

• Scale Rotate - Align the features vertically by simultaneously scaling and rotating the entire image around a point.
The centre of the rotation is determined by the algorithm.

• Camera Rotation - Align the features by first performing a 3D rotation of both cameras so that they have exactly
the same orientation and a parallel viewing axis, and then reconverging the views to provide the original con-
vergence. For best results, use theCamera input to provide the information for the shooting cameras.

Match Offset - The offset (in pixels) applied to the aligned featurematches. You can:

• increase this value to artificially increase the disparity, so it’s easier to see how horizontal the featurematches are.
Any matches that aren’t horizontal can be considered poormatches and deletedmanually.

• decrease this value to set the disparity of particularmatches to zero and examine the vertical offset at each feature.
Thematches should sit on top of each other. If they are vertically offset, you know they’re poor and can delete
themmanually.

Accurate featurematches sit on top of each
other (left), whereas poormatches are

vertically offset (right).
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TheMatch Offset control is only available whenDisplay is set to PreviewAlignment. You can also adjust it by
pressing < or > on the Viewer, or by selecting decrease offset or increase offset from the Viewer’s right-click
menu.

Error Threshold - Threshold on the vertical alignment error in pixels. When Display is set to Preview Alignment, any
matches with a vertical error greater than the threshold are selected in the Viewer. This allows you to easily delete
poormatches with large errors when previewing alignment at keyframes.

Current Frame

Re-analyse Frame - Clear the automatic featurematches from the current frame and recalculate them. This can be
useful if there have been changes in the node tree upstream fromO_Solver, you have deleted toomany automatic
featurematches, or you want to calculate the automaticmatches based on any usermatches you have created.

Delete User Matches - Delete all featurematches you havemanually added to the current frame.

Example
See Example on page 39 for an example of how to useO_Solver and O_DisparityGenerator to calculate a disparity
field for a stereo image.
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3 DisparityGenerator

Description
TheO_DisparityGenerator plug-in is used to create disparity fields for stereo images. A disparity fieldmaps the loc-
ation of a pixel in one view to the location of its corresponding pixel in the other view. It includes two sets of dis-
parity vectors: onemaps the left view to the right, and the othermaps the right view to the left.

The following Ocula plug-ins rely on disparity fields to produce their output:

• O_OcclusionDetector

• O_ColourMatcher (in 3D LUT and Local Matchingmodes)

• O_FocusMatcher

• O_VerticalAligner (in Local Alignmentmode)

• O_NewView

• O_InteraxialShifter

• O_VectorGenerator

• O_DisparityToDepth, and

• O_DisparityViewer.

If you havemore than one of these plug-ins in your node treewith one ormore of the same inputs, they might well
require identical disparity field calculations. O_DisparityGenerator is a utility plug-in designed to save processing time
by allowing you to create the disparity fields separately, so that the results can then be reused by other Ocula plug-
ins.

O_DisparityGenerator always requires an O_Solver node as one of its inputs to provide the alignment data for dis-
parity matching. You can, however, control howmuch the disparity vectors respect O_Solver’s geometric alignment
by using theAlignment slider in theO_DisparityGenerator controls.

The final disparity vectors are stored in disparity channels, so youmight not see any image data appear when you
first calculate the disparity field. To see the output insideNuke, select a disparity channel from the channel set and
channel controls in the top left corner of the Viewer. An example of what a disparity channelmight look like is shown
below.
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A disparity field.

In general, once you have generated a disparity field that describes the relation between the views of a particular clip
well, it will be suitable for use inmost of theOcula plug-ins. We recommend that you insert aWrite node after O_Dis-
parityGenerator to render the original images and the disparity channels as a stereo .exr file (sometimes referred to
as .sxr). This format allows for the storage of an imagewithmultiple views and channel sets embedded in it. Later,
whenever you use the same image sequence, the disparity field will be loaded into Nuke together with the sequence
and is readily available for theOcula plug-ins. For information on how to generate a disparity field and render it as an
.exr file, seeQuick Start below.

TIP: O_DisparityGenerator operates on luminance images. If you, for example, have a bluescreen image
where the background and foreground luminance are not that different, youmay be able to improve the
results by keying out the background before using O_DisparityGenerator.

If you have a CG scenewith camera information and z-depthmap available, you can also create disparity fields using
theO_DepthToDisparity node. Formore information, see DepthToDisparity on page 105.

Inputs
O_DisparityGenerator has four inputs:

• Source - A stereo pair of images. The images should be followed by an O_Solver node, unless you’re using the
Solver input.

• Solver - If the Source sequence doesn’t contain features that O_Solver is able to match well, you can useO_Solver
on another sequence shot with the same camera setup. If you do so, connect O_Solver to this input.

• Ignore - An optionalmask that specifies areas to exclude from the disparity calculation. You can use this input to
prevent distortions at occlusions or to calculate disparity for a background layer by ignoring all foreground ele-
ments. Note that masks should exist in both views, and O_DisparityGenerator expects alpha values of either 0 (for
regions to use) or 1 (for regions to ignore).
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The left view. An ignoremask for the left
view.

This ignores the foreground
elements to calculate disparity

for the background.

• Fg - An optionalmask that specifies the area to calculate disparity. You can use this to create a disparity layer for a
foreground element. To create layers for different elements, use several O_DisparityGenerator nodes. If necessary,
you can also use the Ignoremask to exclude elements in the foreground region. Note that masks should exist in
both views, and O_DisparityGenerator expects alpha values of either 0 (for background) or 1 (for foreground).

The left view. A foregroundmask for the
left view.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Quick Start
To generate a disparity field for a stereo clip, do the following:

1. Start Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set
up views for stereo button.

2. From the Toolbar, select Image > Read to load your stereo clip into Nuke. If you don’t have both views in the
same file, select Views > JoinViews to combine them, or use a variable in the Read node’s file field to replace the
name of the view (use the variable%V to replace an entire view name, such as left or right, and%v to replace
an initial letter, such as l or r). Formore information, refer to theNuke user guide.

3. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node after either the stereo clip or the JoinViews
node (if you inserted one in the previous step). This plug-in calculates the geometrical relationship between the
two views in the input clip. Set at least one keyframe.

Formore instructions on how to useO_Solver, see Solver on page 19.

4. Select Ocula > Ocula 3.0 > O_DisparityGenerator to insert an O_DisparityGenerator node after O_Solver. In
most cases, theO_Solver node should be connected to the Source input of O_DisparityGenerator (see the
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image on the left). However, if you want to calculate the disparity field for one clip by using theO_Solver node of
another, connect theO_Solver node to the Solver input of O_DisparityGenerator (see the image on the right).

Getting the camera rela-
tionship

from the Source clip.

Getting the camera rela-
tionship

from the Solver clip.

5. Open theO_DisparityGenerator controls. From theViews to Usemenu or buttons, select which views you
want to use for the left and right eyewhen creating the disparity field.

6. If there are areas in the image that you want to ignorewhen generating the disparity field, supply amask either
in the Ignore input or the alpha of the Source input. In theO_DisparityGenerator controls, set Ignore Mask to
the component you want to use as themask.

You can also provide a foregroundmask in the Fg input or the alpha of the Source input. This restricts the dis-
parity calculation to themasked areas, allowing you to create a disparity layer for a foreground element. In the
O_DisparityGenerator controls, set Foreground Mask to the component you want to use as themask.

Using both an Ignore and an Fgmask, you can restrict the disparity calculation to a foreground region but
exclude any problematic areas from that region.

7. Attach a Viewer to theO_DisparityGenerator node, and display one of the disparity channels in the Viewer.

O_DisparityGenerator calculates the disparity field and stores it in the disparity channels.

A disparity field.

8. If necessary, adjust the Sharpness control, which defines how distinct object boundaries should be in the cal-
culated disparity field.

If you want to use the calculated disparity to rebuild images (using O_NewView, O_InteraxialShifter, O_
FocusMatcher, or O_Retimer), set Sharpness to 0. This improves picture building.
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If you want to use the calculated disparity to pick out layers in the scene, increase Sharpness to produce distinct
object boundaries.

9. If you find that the disparity field is noisy in low-contrast image regions, try increasing theNoise value. This sets
the amount of noiseO_DisparityGenerator should ignore in the input footagewhen calculating the disparity
field. The higher the value, the smoother the disparity field.

10. If necessary, you can use the Parallax Limits controls to cut off any spurious disparity vectors that are likely to
be incorrect. To do so, look for features in the image that appear in front of the screen plane, switch between the
two views, and locate the pixels that move themost (that is, have the largest disparity). Hover over those pixels
in the Viewer and note their values on the x axis (in the figure on the left, the value is 1560). Display the other
view and do the same (in the image on the right, the value is 1423). The difference between these values (1423-
1560) is themaximumnegative parallax (-137). We can assume that any disparities that clearly exceed thismax-
imum value are incorrect. If you enter the value in theNegative field and enable Enforce parallax limits, O_
DisparityGenerator cuts off any disparities that exceed the limit.

A pixel in the left view. The same pixel in the
right view. The negative

parallax here is:
1423-1560 = -137.

Set themaximumpositive parallax in the samemanner. Look for features behind the screen plane, find themax-
imumpositive parallax value, and use that in the Positive field with Enforce parallax limits enabled.

You can also use the Parallax Histogram display in O_DisparityViewer to review the disparity range. Formore
details, see DisparityViewer on page 117.

The disparities highlighted here are likely
to be incorrect. In this case, you can remove
themby settingNegative to -6 and enabling

Enforce parallax limits.
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11. Select Image >Write to insert aWrite node after O_DisparityGenerator. In theWrite node controls, select all
from the channels pulldownmenu. Choose exr as the file type. Enter a name for the clip in the file field (for
example,my_clip.####.exr), and click Render.

The newly created disparity channels are saved in the channels of your stereo clip. When you need to manipulate
the same clip again later, the disparity vectors are loaded into Nuke together with the clip.

Rendering the output to combine the clip and the disparity
channels for future use.

12. If the calculated disparity field does not produce the results you’re after (and you have already checked the qual-
ity of the solve as described on Reviewing and Editing the Results), use theO_DisparityGenerator controls to
adjust theway the disparity field is calculated. The available controls are described below.

TIP: You can use a RotoPaint (Draw > RotoPaint) node to edit the generated disparity channels. For
example, if a specific region in the image is producing incorrect disparity vectors and you know that those
vectors shouldmatch the vectors in the surrounding areas, you can use the Clone tool to clone out the
problematic area.

TIP: To check the quality of the generated disparity field, you can:
- use an OcclusionDetector node after O_DisparityGenerator.
- set Sharpness to 0 and use an O_NewView node after O_DisparityGenerator. In theO_NewView con-
trols, if you set Inputs to Right and Interpolate Position to 0, the node uses pixels from the right view
to build a new view on top of the left. You can then compare this new left viewwith the original left view in
the Viewer. Where the viewsmatch, the generated disparity field is accurate. Where they differ, O_Dis-
parityGeneratormay be struggling to produce good results. Formore information, see Example on page
84 and NewView on page 81.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to create the
disparity field. These viewswill bemapped for the left and right eye.

Ignore Mask - An optionalmask that specifies areas to exclude from the disparity calculation. You can use this input
to prevent distortions at occlusions or to calculate disparity for a background layer by ignoring all foreground ele-
ments. Note that masks should exist in both views, and O_DisparityGenerator expects alpha values of either 0 (for
regions to use) or 1 (for regions to ignore).

•None - Do not use an ignoremask.

• Source Alpha - Use the alpha channel of the Source clip as an ignoremask.
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• Source Inverted Alpha - Use the inverted alpha channel of the Source clip as an ignoremask.

•Mask Luminance - Use the luminance of the Ignore input as an ignoremask.

•Mask Inverted Luminance - Use the inverted luminance of the Ignore input as an ignoremask.

•Mask Alpha - Use the alpha channel of the Ignore input as an ignoremask.

•Mask Inverted Alpha - Use the inverted alpha channel of the Ignore input as an ignoremask.

ForegroundMask - An optionalmask that specifies the area to calculate disparity. You can use this to create a dis-
parity layer for a foreground element. To create layers for different elements, use several O_DisparityGenerator
nodes. If necessary, you can also use the Ignoremask to exclude elements in the foreground region. Note that
masks should exist in both views, and O_DisparityGenerator expects alpha values of either 0 (for background) or 1
(for foreground).

•None - Do not use a foregroundmask.

• Source Alpha - Use the alpha channel of the Source clip as a foregroundmask.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip as a foregroundmask.

•Mask Luminance - Use the luminance of the Fg input as a foregroundmask.

•Mask Inverted Luminance - Use the inverted luminance of the Fg input as a foregroundmask.

•Mask Alpha - Use the alpha channel of the Fg input as a foregroundmask.

•Mask Inverted Alpha - Use the inverted alpha channel of the Fg input as a foregroundmask.

Noise - This sets the amount of noiseO_DisparityGenerator should ignore in the input footagewhen calculating the
disparity field. The higher the value, the smoother the disparity field. Youmay want to increase this value if you find
that the disparity field is noisy in low-contrast image regions.

Strength - Sets the strength inmatching pixels between the left and right views. Higher values allow you to accur-
ately match similar pixels in one image to another, concentrating on detail matching even if the resulting disparity
field is jagged. Lower valuesmay miss local detail, but are less likely to provide you with the odd spurious vector, pro-
ducing smoother results. Often, it is necessary to trade one of these qualities off against the other. Youmay want to
increase this value to force the views to match, for example, where fine details aremissed, or decrease it to smooth
out the disparity field.

Consistency - This constrains the left and right disparities to be consistent. Increase the value to encourage the left
and right disparity vectors to match.

Alignment - Sets howmuch to constrain the disparities to match the horizontal alignment defined by an upstream
O_Solver node. A value of 0 calculates the disparity using unconstrainedmotion estimation. Increasing the value
forces the disparities to be aligned. In most cases, you want this set to 0 or the default value of 0.1.

Sharpness - Sets how distinct object boundaries should be in the calculated disparity field. Increase this value to pro-
duce distinct borders and separate objects. Decrease the value to blur disparity layers together andminimise occlu-
sions. For better picture building with O_NewView, O_InteraxialShifter, O_FocusMatcher, and O_Retimer, you can set
this value to 0.
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Sharpness set to 0. Sharpness set to 1.

Smoothness - Applies extra smoothing to the disparity field as a post process after imagematching. The higher the
value, the smoother the result. You can use this in conjunction with the Sharpness parameter to smooth out the dis-
parity field separately for distinct objects in the shot.

Parallax Limits

Enforce parallax limits - When enabled, O_DisparityGenerator limits the disparity to the values defined below to remove

incorrect disparity vectors. You can review the disparity range using the Parallax Histogram display in O_DisparityViewer.

The Parallax Histogram display in
O_DisparityViewer.

Negative - Themaximumnegative parallax in pixels. With negative parallax, pixels in the left image are to the right
of pixels in the right and objects appear in front of the screen plane. Negative parallax is defined by themaximumdis-
parityL.x andminimumdisparityR.x values for the aligned images.

Positive - Themaximumpositive parallax in pixels. With positive parallax, pixels in the left image are to the left of
pixels in the right and objects appear behind the screen plane. Positive parallax is defined by theminimumdis-
parityL.x andmaximumdisparityR.x values for the aligned images.

Example
In this example, we read in a stereo image, useO_Solver and O_DisparityGenerator to calculate its disparity field, and
render the result as a single .exr file that contains the left and the right view and the newly created disparity chan-
nels. Later, whenever you use the same image, the disparity field will be loaded into Nuke together with the image.
Thismakes the disparity field readily available for the other Ocula plug-ins, many of which need it to produce their
output.
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The stereo image used here can be downloaded fromourweb site. Formore information, please see Example
Images on page 8.

Step by Step

Calculating the Camera Relationship
1. Start Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set

up views for stereo button.

2. Select Image > Read to import graveyard_left.tif. In the Read node controls, locate the file field. Then, replace
theword left in the file namewith the variable%V. This way, Nuke reads in both the left and the right view using
the same Read node.

3. Select the Read node and chooseOcula > Ocula 3.0 > O_Solver from the Toolbar.

This inserts an O_Solver node after the stereo image. The purpose of this node is to define the geometrical rela-
tionship between the two views in the input image (that is, the camera relationship or solve). That information
can then be fed to O_DisparityGenerator, which creates the final disparity field.

For now, we’ll concentrate on creating an accurate solve using O_Solver.

4. Attach a Viewer to theO_Solver node.

5. In theO_Solver controls, click Add Key to set a keyframe for O_Solver to analyse.

Our example here consists of just one frame, but if you were using a sequence, you should set keyframes
wherever the camera setup changes. If the setup doesn’t change, you can get away with using just one key-
frame. Remember that this should be a frame that is easy to match between views - ideally, a framewith enough
picture detail, but nomotion blur, occluding fog, or dust.

Every time you add a keyframe, O_Solver analyses the footage and calculates the solve.

6. Set Display to KeyframeMatches (or pressM on the Viewer) andmake sure you are viewing the keyframe.

The calculated featurematches are displayed in a Viewer overlay, and you can switch between views to compare
them.

The viewswe set up in the project settings dictate the colour of the features in the overlay. Becausewe used the
default settings in step 1, red indicates a feature in the left view and green a feature in the right view.

Display set to Keyframe Matches.
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7. Now, set Display to Preview Alignment (or press P on the Viewer). This allows you to check the quality of your
solve by previewing the alignment of the calculated featurematches in the Viewer. Ideally, the lines should all be
horizontal. If they have a vertical error greater than Error Threshold, they are considered poormatches and dis-
played in yellow. At themoment, we have no poormatches.

8. We are going to be very picky here, so set Error Threshold to 3.

A fewmatches turn yellow, whichmeans they are pre-selected in the Viewer.

9. Right-click on the Viewer and select delete selected (or simply press backspace) to delete all thematches dis-
played in yellow.

Deleting poormatches.

10. Press < (in other words, Shift+,) on the Viewer to decrease theMatch Offset value gradually until somematches
have no horizontal offset. This sets the disparity of thosematches to zero, whichmeans accurate featurematches
should sit on top of each other. Youmay need to zoom in to see if they do.

Accuratematches sit directly
on top of each other.

Poormatches have a vertical
offset.

Thematches in our example seem fine. However, if you could see a vertical offset between any featurematches,
you would want to delete themby selecting them in the Viewer and pressing backspace.

Note that you can only select features on the view you’re currently on. So if you're on the left view, you can't
select green features.

11. To help guide the solve, we can also add featurematchesmanually. It’s a good idea to do this if you have a par-
ticularly tricky part of a shot where the automatic featurematching isn’t producing enough accuratematches. In
this case, we have quite a good spread of matches around the entire image. However, there is an area between
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the tree and the tombstone on the left that has nomatches. Zoom in on it. Then, right-click on a point you can
easily locate in both views and select add feature. A crosshair appears to represent the feature in the current
view. Use the Viewer controls to switch to the other view and drag the feature you just added to its correct loc-
ation in that view.

Adding a feature to the left
view.

Locating the same feature in
the right view.

You can add asmany manual featurematches as you like, so if you see any other areas that might benefit from
them, feel free to addmore.

O_Solver considers any featurematches you’ve added yourself superior to the ones it detects automatically and
pays themmore attention. This can also influence the automaticmatches displayed in the Preview Alignment
mode. If you see any automaticmatches that don't agreewith the alignment defined by thematches you added,
delete them as described earlier.

12. Once you’re happy with the solve, set Display back toNothing and proceed to Generating theDisparity Field
below.

Generating the Disparity Field
1. Select Ocula > Ocula 3.0 > O_DisparityGenerator to insert an O_DisparityGenerator node after O_Solver.

The node treewith O_DisparityGenerator.

2. Use the Sharpness slider to set how distinct object boundaries should be in the calculated disparity field:

• If you want to use the generated disparity field to rebuild images (using O_NewView, O_InteraxialShifter, O_
FocusMatcher, or O_Retimer), set Sharpness to 0. This improves picture building.

• If you want to pick out distinct disparity layers in the scene, increase Sharpness to 1.

For the purposes of this example, leave Sharpness set to 0.

3. Display one of the disparity channels by selecting it from the channel set and channelmenus in the upper left
corner of the Viewer.
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O_DisparityGenerator calculates the disparity field. You will probably see something colourful and seemingly
unreadable, much like the image below. Don’t worry - that’s what the disparity channels are supposed to look
like.

The calculated disparity field.

4. You now have a disparity field, but it can be hard to tell if it’s accurate just by looking at it. This is where theO_
NewView node can help. Select Ocula > Ocula 3.0 > O_NewView to add it after O_DisparityGenerator.

This node uses the disparity field to produce its results. If the results seem accurate, we can assume that the dis-
parity field is accurate too.

5. In theO_NewView controls, set Inputs to Right and InterpolatePosition to 0.

This tells the node to use pixels from the right view to build a new view on top of the left. You can then compare
this new left viewwith the original left view.

6. In the Viewer controls, select rgba to display the colour channels again.

7. Select the Read node and press 2 to connect it to the Viewer. Your node tree should now look like this:

The Viewer here has two inputs: 1) theO_NewView node
with the newly generated left view and 2) the Read nodewith the

original left view.

8. Hover over the Viewer and press 1 and 2 to switch between the newly generated left view and the original left
view. Where the viewsmatch, the generated disparity field is accurate. Where they differ, O_DisparityGenerator
may be struggling to produce good results.

In this case, O_DisparityGenerator has done a pretty good job. There’s a black strip on the left and some changes
in the areas around the tree and some of the gravestones, but these are caused by occlusions in the scene rather
than a poor disparity field. Building a new view in these occluded regions isn’t possible, so we can be reasonably
happy with the results.
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The original left view. The new left view generated
using the disparity field.

9. Delete theO_NewView node from the script. We no longer need it, as wewere only using it to check the quality
of our disparity field. You can also disconnect the Read node from the Viewer.

10. Select Image >Write to insert aWrite node between theO_DisparityGenerator and the Viewer. Your node tree
should now look like the one below.

The node treewith theWrite node.

11. In theWrite node controls, select all from the channelsmenu to include the disparity channels in the rendered
file.

12. In the file field, enter a file name and location for the new .exr file. Make sure file type is set to exr. Then, click
theRender button to render the image as usual.

Rendering the imagewith both views
and the disparity channels.

13. Import the .exr file you created. Using the Viewer controls, check that it contains the left and the right view and
the disparity channels.

You can now use the .exr file you created together withmany of the other Ocula plug-ins without having to
insert an O_Solver and an O_DisparityGenerator node before them.
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Description
O_OcclusionDetector generates amask for the occluded pixels in each view: that is, pixels visible in one view but not
the other.

The left view of a stereo image. The occlusionmask generated
for the left view (pixels

occluded
in the left view).

An occlusionmask identifies areas that are likely to be incorrect when using disparity to match one view to another.
You can use it to quality check the result of O_DisparityGenerator and to identify at a glance image regions that are
likely to fail when using theOcula nodes that rely on rebuilding one view from the other (after all, if the pixel inform-
ation isn’t there in one view, it cannot be generated for the other). Once you knowwhich areas aren’t suitable for pic-
ture building, you can choose how to handle those areas in order to get a better result.

Youmay want to generate an occlusionmask for each viewwhen using the following nodes:

• FocusMatcher - This node requires an occlusionmask upstream to produce its output if Primary Method is set to
Rebuild.

• ColourMatcher - This node requires an occlusionmask upstream to produce its output ifMode is set to either 3D
LUT or Local Matching.

• DisparityGenerator - This node does NOT require an occlusionmask, but you can use one downstream to quality
check the generated disparity field.

• NewView, InteraxialShifter, and Retimer - These nodes do NOT require an occlusionmask to produce their output,
but if you like, you can use one upstream to previewwhere they may struggle to generate a new view.
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The final occlusionmasks for each view are stored in themask_occlusion channel. You can view them in Nuke by
setting the alpha channelmenu tomask_occlusion.alpha and pressingM on the Viewer. This superimposes the
occlusionmask for the current view as a red overlay on top of the image’s RGB channels as shown below.

An occlusionmask displayed on top of the colour channels.

Once you have generated an occlusionmask, you can use aWrite node to render themask into the channels of your
stereo EXR file along with the colour and disparity channels. Later, whenever you use the same image sequence, the
occlusionmask will be loaded into Nuke together with the sequence.

Likemost other Ocula plug-ins, O_OcclusionDetector needs upstreamdisparity channels to produce its output. For
an in-depth explanation of how to create disparity channels, refer to the Solver and DisparityGenerator chapters.

Inputs
O_OcclusionDetector has one input:

Source - A stereo pair of images. If disparity channels aren’t embedded in the images, you should add an O_Solver
and an O_DisparityGenerator node after the image sequence.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To generate an occlusionmask, do the following:

1. If there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or if disparity vec-
tors exist in the image sequence itself, these are used when generating the occlusionmask. If disparity vectors
don’t yet exist in the script, however, you can use theO_Solver and O_DisparityGenerator plug-ins after your
image sequence to calculate the disparity vectors. See Solver on page 19 and DisparityGenerator on page 32 for
how to do this.
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2. From the toolbar, select Ocula > Ocula 3.0 > O_OcclusionDetector to add an O_OcclusionDetector node
after either theO_DisparityGenerator node (if you added one in the previous step) or the stereo image
sequence.

Your node tree should now look something like this:

The node treewith O_OcclusionDetector.

3. In theO_OcclusionDetector controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to use to calculate the occlusionmask.

The two views you selected aremapped for the left and right eye.

O_OcclusionDetector calculates the occlusionmask and stores it in themask_occlusion.alpha channel.

4. In the Viewer controls, set the alpha channelmenu tomask_occlusion.alpha as shown below.

Set thismenu tomask_occlusion.alpha.

This sets the occlusionmask that O_OcclusionDetector generated as the channel that’s displayed in the alpha
channel.

Next, pressM on the Viewer to superimpose that channel as a red overlay on top of the image’s RGB channels.
Note that this doesn’t work if you have theO_Solver controls open.

The red overlay indicates occluded regions
where picture building operations are likely

to fail.
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5. If necessary, adjust the following controls and observe their effect on the occlusionmask:

• Depth Occlusions sets the threshold formarking occlusions at depth changes (that is, where there is a sharp
change in disparity). Increase this value to flagmore areas as occluded. Try using a value of 0.3 or 0.5 where
there are extreme occlusions in the image.

Depth Occlusions = 0.1. Depth Occlusions = 0.5.

• Colour Threshold sets the threshold formarking occlusions at colour differences between views (that is,
where the image content is different between the views). Decrease this value to flagmore areas as occluded.
Try using a value of 0.02 to pick upmore occlusions if the colour variation in the image is flat. Try increasing
the value to 0.1 if there are a lot of highly textured regions, such as foliage.

Colour Threshold = 0.005. Colour Threshold = 0.02.

•Occlusion Dilate expands the occluded regions by the set number of pixels.

Occlusion Dilate = 1. Occlusion Dilate = 10.

•Occlusion Fill sets the size (in pixels) of holes to fill inside occluded regions. Increase this value to fill larger
holes. Holes can appear and disappear, causing flicker when using O_ColourMatcher or O_FocusMatcher.
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Occlusion Fill = 0. Occlusion Fill = 6.

•Occlusion Blur blurs the occlusion boundaries. Increase this value to smooth out transitions at occluded
regions when using O_ColourMatcher or O_FocusMatcher.

Occlusion Blur = 0. Occlusion Blur = 10.

You can also use theOcclusion Sizemenu to quickly set the above controls to different preset values.

6. If there are areas that you know are occluded but that haven’t been flagged as such in the occlusionmask, you
can add those inmanually. Press P on theNodeGraph to add a RotoPaint node after O_OcclusionDetector.
Open the RotoPaint controls and set output tomask_occlusion. Then, use the paint tools on the left side of
the Viewer to addmore occluded areas to themask.

7. Of course, you can also use RotoPaint to paint out regions that are incorrectly marked as occluded.

8. When you’re happy with the results, pressM on the Viewer again to return to the RGB display.

9. If you like, you can add aWrite node after O_OcclusionDetector and render the colour channels, disparity chan-
nels, and occlusionmask into the channels of a stereo EXR file.

Later, whenever you use the same image sequence, the occlusionmask will be loaded into Nuke together with
the sequence. If necessary, you can use a RotoPaint node to edit the occlusions for usewith O_FocusMatcher or
O_ColourMatcher, or simply replace themusing another O_OcclusionDetector to adjust themask on the fly.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to generate
an occlusionmask. These viewswill bemapped for the left and right eye.

Depth Occlusions - The threshold formarking occlusions at depth changes (that is, where there is a sharp change in
disparity). Increase this value to flagmore areas as occluded. Try using a value of 0.3 or 0.5 where there are extreme
occlusions in the image.

Colour Threshold - The threshold formarking occlusions at colour differences between views (that is, where the
image content is different between the views). Decrease this value to flagmore areas as occluded. Try using a value
of 0.02 to pick upmore occlusions if the colour variation in the image is flat. Try increasing the value to 0.1 if there
are a lot of highly textured regions, such as foliage.

Refinement Options

4OCCLUSIONDETECTOR | CONTROLS



50

Occlusion Size - Presets for different occlusions sizes. Selecting the size of the regions that are visible in one view
but not the other here sets theOcclusion Dilate,Occlusion Fill, andOcclusion Blur controls accordingly. The
default is Small, but if there is a lot of parallax in the images, there can be a lot of image content occluded or
revealed between views so you can switch to Large or Extreme to create larger occlusion regions.

• Small

• Medium

• Large

• Extreme

Occlusion Size = Small. Occlusion Size = Extreme.

Occlusion Dilate - The amount (in pixels) to expand the regions that are considered occluded.

Occlusion Fill - The size (in pixels) of holes to fill inside occluded regions. Increase this value to fill larger holes. Holes
can appear and disappear, causing flicker when using O_ColourMatcher or O_FocusMatcher.

Occlusion Blur - The amount (in pixels) to blur occlusion boundaries. Increase this value to smooth out transitions
at occluded regions when using O_ColourMatcher or O_FocusMatcher.

Example
See Example on page 68 for an example of how to useO_OcclusionDetector with O_FocusMatcher.
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Description
TheO_ColourMatcher plug-in lets youmatch the colours of one viewwith those of another. It has been specifically
designed to deal with the subtle colour differences that are sometimes present between stereo views.

The original left view. The original right view.

The colour corrected right view.

Colour discrepancies between views can be caused by several factors. For example, stereo footagemay have been
shot with cameras which were differently polarised, or theremay have been slight differences between the physical
characteristics of the two camera lenses or image sensors. If the colour differences are not corrected for, viewers of
the footagemay find it difficult to fuse objects in the scene and enjoy the viewing experience.

Correcting for colour differencesmanually in post production tends to be a time-consuming process and requires
considerable skill. Using O_ColourMatcher, however, you can automate the colour grading required.

This plug-in differs frommost of theOcula plug-ins in that it does not always need disparity vectors. This is because
in theBasicmode, O_ColourMatcher does not use any spatial information but tries to match the overall colour dis-
tribution of one view to that of the other. In thismode, you do not need to useO_Solver and O_DisparityGenerator
with O_ColourMatcher.
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In the 3D LUT and Local Matchingmodes, O_ColourMatcher requires not only a disparity field but also an occlu-
sionmask upstream. You can generate a disparity field and an occlusionmask using Solver, DisparityGenerator, and
OcclusionDetector.

Inputs
O_ColourMatcher has two inputs:

• Source - A stereo pair of images.

If disparity channels and occlusionmasks aren’t embedded in the images and you are using the 3D LUT or Local
Matchingmode, you should use an O_Solver, an O_DisparityGenerator, and an OcclusionDetector node after the
image sequence.

•Mask - An optionalmask that determines where to take the colour distribution from. For example, if you have a
clip showing a person in front of a green screen, youmight want to use amask to exclude the green area so the
plug-in concentrates onmatching the person.

In theBasic and 3D LUTmodes, O_ColourMatcher calculates the transform on themasked area of the source
view but applies it to thewhole of the view it's correcting. In the Local Matchingmode, it calculates the transform
on themasked area and applies it to that area only.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
You canmatch the colours of one viewwith those of another using three different algorithms:

• Basic - Thismode takes the colour distribution of one entire view andmodifies that to match the distribution of
the other view. See BasicMode.

• 3D LUT - Thismode generates a global look-up table (LUT) from local matches at unoccluded pixels. You can export
the LUT calculated for the current frame in .vf format. This allows you to apply the LUT separately using Nuke’s
Vectorfield (Color > 3D LUT > Vectorfield) node. See 3D LUTMode.

• Local Matching - Thismode first divides the two images into square blocks according to theBlock Size control.
Then, it matches the colour distributions between corresponding blocks in the two views. This can be useful if there
are local colour differences between the views, such as highlights that are brighter in one view than the other. See
Local MatchingMode.

Basic Mode
1. Select Ocula > Ocula 3.0 > O_ColourMatcher to insert an O_ColourMatcher node after your stereo clip.

2. Connect a Viewer to theO_ColourMatcher node.
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O_ColourMatcher node tree.

3. In theO_ColourMatcher controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to match.

The two views you selected aremapped for the left and right eye.

4. From theMatchmenu, select if you want to adjust the colours of the left view to match themwith those of the
right, or vice versa.

5. If there are areas in the image that you want to ignorewhen calculating the colour transformation, supply a
mask either in theMask input or the alpha of the Source input. In theO_ColourMatcher controls, setMask
Component to the component you want to use as themask.

6. If you are not happy with the results, try one of the othermodes described below.

3D LUT Mode
1. Make sure there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or disparity

vectors exist in the image sequence itself. If disparity vectors don’t yet exist in the script, you can use theO_
Solver and O_DisparityGenerator plug-ins after your image sequence to calculate the disparity vectors. See
Solver on page 19 and DisparityGenerator on page 32 for how to do this.

2. If an occlusionmask doesn’t yet exist in the data streamor the image sequence itself, use an O_Occlu-
sionDetector node to create one. SeeOcclusionDetector on page 45.

You can also replace an existing occlusionmask by inserting a newO_OcclusionDetector beforeO_Col-
ourMatcher. This allows you to modify the occlusions.

3. Select Ocula > Ocula 3.0 > O_ColourMatcher to insert an O_ColourMatcher node after your stereo clip.

4. Connect a Viewer to theO_ColourMatcher node.

O_ColourMatcher node tree.

5. In theO_ColourMatcher controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to match.

The two views you selected aremapped for the left and right eye.

6. From theMatchmenu, select if you want to adjust the colours of the left view to match themwith those of the
right, or vice versa.

7. If there are areas in the image that you want to ignorewhen calculating the colour transformation, supply a
mask either in theMask input or the alpha of the Source input. In theO_ColourMatcher controls, setMask
Component to the component you want to use as themask.
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8. SetMode to 3D LUT.

O_ColourMatcher generates a global look-up table (LUT) for all unoccluded pixel matches and then applies that
to the entire image.

9. Scrub through the sequence and find the framewith the best colourmatch. Then, click Export 3D LUT. In the
dialog that opens, enter a name and location for the LUT and click Save.

This exports the LUT calculated for the current frame in .vf format (Nuke’s native 3D LUT format).

10. If you want to apply the same colour correction without Ocula, you can do so using Nuke’s Vectorfield node
(Color > 3D LUT > Vectorfield). In the Vectorfield controls, use vectorfield file to browse to the .vf file you
saved in the previous step.

Here, O_ColourMatcher and Vectorfield produce the same results.

Local Matching Mode
1. Make sure there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or disparity

vectors exist in the image sequence itself. If disparity vectors don’t yet exist in the script, you can use theO_
Solver and O_DisparityGenerator plug-ins after your image sequence to calculate the disparity vectors. See
Solver on page 19 and DisparityGenerator on page 32 for how to do this.

2. If an occlusionmask doesn’t yet exist in the data streamor the image sequence itself, use an O_Occlu-
sionDetector node to create one. SeeOcclusionDetector on page 45.

You can also replace an existing occlusionmask by inserting a newO_OcclusionDetector beforeO_Col-
ourMatcher. This allows you to modify the occlusions to control the regions whereOcclusion Compensate is
applied.

3. Select Ocula > Ocula 3.0 > O_ColourMatcher to insert an O_ColourMatcher node after your stereo clip.

4. Connect a Viewer to theO_ColourMatcher node.

O_ColourMatcher node tree.

5. In theO_ColourMatcher controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to match.

The two views you selected aremapped for the left and right eye.

6. From theMatchmenu, select if you want to adjust the colours of the left view to match themwith those of the
right, or vice versa.
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7. If there are areas in the image that you want to ignorewhen calculating the colour transformation, supply a
mask either in theMask input or the alpha of the Source input. In theO_ColourMatcher controls, setMask
Component to the component you want to use as themask.

8. SetMode to Local Matching.

In thismode, O_ColourMatcher first divides the two images into square blocks according to theBlock Size con-
trol. Then, it matches the colour distributions between corresponding blocks in the two views.

9. Make sureOcclusion Compensate is enabled.

This allowsO_ColourMatcher to produce better results in the occluded areas defined by the upstreamocclusion
mask. In these areas, O_ColourMatcher cannot correct the colour in one view by using the colour from the other.
Instead, it looks for similar colours in the nearby unoccluded areas that it has already been able to match and
uses the closest colour it finds.

10. Review the results. If you can see areas where the colourmatch is wrong, make sure they are included in the
upstreamocclusionmask. You can add them to themask by:

• adjusting O_OcclusionDetector controls or

• using a RotoPaint node beforeO_ColourMatcher and painting into themask_occlusion channel.

11. If you’re still not happy with the results, try adjusting:

• Block Size - Thewidth and height (in pixels) of the square blocks that the images are divided into when cal-
culating the colourmatch. Decrease this to createmore localised colour updates near colour boundaries to pre-
vent colour bleeding or halo artefacts.

• Colour Sigma - The amount of blurring across edges in the colourmatch at occluded regions. Decrease this to
restrict the colour correction in occluded regions to similar colours. Increase the value to blur the colour cor-
rection.

• Region Size - The size of the region (in pixels) of unoccluded pixels used to calculate the colour correction at an
occluded pixel. WhenOcclusion Compensate is enabled, O_ColourMatcher first finds the closest unoccluded
pixel and then expands that distance by this number of pixels to pick up unoccluded pixels to use.

• Edge Occlusions - The threshold for treating image edges as occlusions to reduce haloing and edge flicker.
The higher the value, themore image edges are considered occlusions even if they aren’t marked as such in the
upstreamocclusionmask.

Controls
Views to Use - From the views that exist in your project settings, select the two viewswhose colours you want to
match. These viewswill bemapped for the left and right eye.

Match - Select how tomatch the colours.

• Left to Right - Adjust the colours of the left view to match with those of the right.

• Right to Left - Adjust the colours of the right view to match with those of the left.

Mode - The algorithm to use for the colourmatching.
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• Basic - Thismode takes the colour distribution of one entire view andmodifies that to match the distribution of
the other view.

• 3D LUT - Thismode generates a global look-up table (LUT) from local matches at unoccluded pixels. Note that this
mode requires that there is a disparity field and an occlusionmask in the input data stream. If these don’t yet exist,
you can create themusing theO_Solver (see Solver), O_DisparityGenerator (see DisparityGenerator), and Occlu-
sionDetector (seeOcclusionDetector) plug-ins.

• Local Matching - Thismode first divides the two images into square blocks according to theBlock Size control.
Then, it matches the colour distributions between corresponding blocks in the two views. This can be useful if there
are local colour differences between the views, such as highlights that are brighter in one view than the other. Note
that thismode requires that there is a disparity field in the input data stream. If there isn’t, you can create one
using theO_Solver (see Solver) and O_DisparityGenerator (see DisparityGenerator) plug-ins.

If Occlusion Compensate is enabled, thismode also requires an occlusionmask upstream. If one doesn’t exist,
you can useO_OcclusionDetector (seeOcclusionDetector) to create one.

Export 3D LUT - Export the colour change calculated for the current frame as a 3D look-up table (LUT) in .vf format.
This allows you to apply the LUT separately using Nuke’s Vectorfield (Color > 3D LUT > Vectorfield) node. This con-
trol is only available in the 3D LUTmode.

Local Matching Options

Block Size - This control is only available in the Local Matchingmode. It defines thewidth and height (in pixels) of
the square blocks that the images are divided into when calculating the colourmatch.

Occlusion Compensate - Where there are occlusions in the image, O_ColourMatcher usually cannot correct the col-
our in one view by using the colour from the other. WhenOcclusion Compensate is enabled, it instead looks for
similar colours in the nearby unoccluded areas that it has already been able to match and uses the closest colour it
finds. This requires an occlusionmask upstream (you can create one using O_OcclusionDetector) and is only avail-
able in the Local Matchingmode.

Edge Occlusions - The threshold for treating image edges as occlusions to reduce haloing and edge flicker. The
higher the value, themore image edges are considered occlusions even if they aren’t marked as such in the upstream
occlusionmask. This control is only available whenOcclusion Compensate is enabled.

Colour Sigma - The amount of blurring across edges in the colourmatch at occluded regions. Decrease this to
restrict the colour correction in occluded regions to similar colours. Increase the value to blur the colour correction.
This control is only available whenOcclusion Compensate is enabled.

Region Size - The size of the region (in pixels) of unoccluded pixels used to calculate the colour correction at an
occluded pixel. WhenOcclusion Compensate is enabled, O_ColourMatcher first finds the closest unoccluded pixel
and then expands that distance by this number of pixels to pick up unoccluded pixels to use.

Multi-scale Options

5 COLOURMATCHER | CONTROLS



57

Number of Samples - The number of samples in the Local Matchingmode. Using a value larger than 1 calculates
the correction formultiple block sizes - between Block Size andMax Block Size - and then blends the results
together. This can help to reduce errors.

Max Block Size - The size (in pixels) of themaximumblock size to go up to when usingmultiple samples in the
Local Matchingmode. This control is only available if you have setMode to Local Matching andNumber of
Samples to a value larger than 1.

Sample Spacing - The type of sampling intervals to usewhen usingmultiple samples in the Local Matchingmode.

•Uniform - The sampling interval remains constant. The samples are spaced evenly.

• Favour Small Block Sizes - The sampling interval increases as the block size increases. This weights the correction
towards smaller block sizes, which preservemore detail, while still including some larger block sizes, which aremore
immune to disparity errors.

Colour Correction Type - In the Local Matchingmode, O_ColourMatcher divides the two views into square blocks
andmatches the colour distributions between corresponding blocks. If you have set Number of Samples to a value
larger than 1, it does this formultiple block sizes and then combines the results for different block sizes together.
TheColour Correction Type control lets you choose how this is done.

•Minimum Correction - Out of the results you have, this picks the smallest correction at each point (that is, closest
to your original image). This option can be useful if you have a very poor disparity map.

• Best Guess - Out of the results you have, this picks the closest correction to the target image at each point. The tar-
get image is created by using the disparity field to warp the other view onto the image you're trying to correct. This
option can be useful if you have a very good disparity map.

• Average Correction - Use themean value of the colour correction at each point. This option is the default.

Mask Options

Mask Component - Select the channel to use as amask when calculating the colour transformation.

•None - Use the entire image area.

• Source Alpha - Use the alpha channel of the Source clip as amask.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip as amask.

•Mask Luminance - Use the luminance of theMask input as amask.

•Mask Inverted Luminance - Use the inverted luminance of theMask input as amask.

•Mask Alpha - Use the alpha channel of theMask input as amask.

•Mask Inverted Alpha - Use the inverted alpha channel of theMask input as amask.

Example
In this example, we have a subtle colour discrepancy between our stereo views and reflections that are present in
one view but not the other. To fix this, wematch the colours of the right viewwith those of the left using Local
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Matching. The stereo image used in the example can be downloaded fromourweb site. Formore information,
please see Example Images on page 8.

Step by Step
1. Start Nuke and open the project settings by pressing S on theNodeGraph. Go to theViews tab and click the

Set up views for stereo button.

2. Import the dance_group.##.exr footage used in theO_Retimer tutorial. This image already includes both the left
and the right view and the necessary disparity channels.

3. Attach a Viewer to the image. Using the Viewer controls, switch between the left and the right view. As you can
see, there is a subtle colour shift between the views.

The original left view. The original right view.

We are going to match the colours of the left viewwith those of the right.

4. Select Ocula > Ocula 3.0 > O_OcclusionDetector to add an O_OcclusionDetector node after the stereo
sequence.

5. Insert an O_ColourMatcher node after O_OcclusionDetector.

The node treewith O_ColourMatcher.

6. In theO_ColourMatcher controls, theMatchmenu is already set to Left to Right, which is what wewant.

7. SetMode to Local Matching.

In thismode, O_ColourMatcher first divides the two images into square blocks according to theBlock Size con-
trol. Then, it matches the colour distributions between corresponding blocks in the two views.

BecauseOcclusion Compensate is enabled by default, O_ColourMatcher can produce better results in the
occluded areas defined by the upstreamocclusionmask. In these areas, O_ColourMatcher cannot correct the col-
our in one view by using the colour from the other. Instead, it looks for similar colours in the nearby unoccluded
areas that it has already been able to match and uses the closest colour it finds.

8. View the result and switch between the two views again. Compare the new left view to the original left view by
displaying the left view in the Viewer, selecting theO_ColourMatcher node, and pressingD a couple of times to
disable and enable the node. You’ll notice that the colours of the left view nowmatch those of the right, but
there are some artefacts in themiddle of the image.
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The colour corrected left view.

9. To fix this, we are going to addmore areas to the occlusionmask. Press P on theNodeGraph to add a RotoPaint
node after O_OcclusionDetector.

The node treewith RotoPaint.

10. In the Viewer controls, set the alpha channelmenu tomask_occlusion.alpha as shown below.

Set thismenu tomask_occlusion.alpha.

This sets the occlusionmask that O_OcclusionDetector generated as the channel that’s displayed in the alpha
channel.

Next, pressM on the Viewer to superimpose that channel as a red overlay on top of the image’s RGB channels.

The occlusionmask in a Viewer overlay.
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11. Open the RotoPaint controls and set output tomask_occlusion. Activate the Brush tool in the Viewer toolbar
and paint over any areas that were producing poor results. If it helps, pressD on theO_ColourMatcher node to
disable it and stop it updating after each paint stroke. PressingD again re-enables the node.

Addingmore areas to the occlusionmask.

12. PressM on the Viewer to hide the occlusionmask overlay.

13. Enable and disabled O_ColourMatcher to compare the original and the colour corrected view. The results should
now bemore accurate. If you still see some problematic areas, add them to the occlusionmask too or adjust
Block Size, Colour Sigma, Region Size, and Edge Occlusions in theO_ColourMatcher controls.

The final left view. The original right view.
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6 FocusMatcher

Description
O_FocusMatcher attempts to correct subtle focus differences that are typically present between the left and right
views of a stereo image. It does this by matching the focus distribution of one view to that of the other, based on the
disparity vectors upstream (for details on how to calculate disparity vectors, see Solver on page 19 and Dis-
parityGenerator on page 32).

The original left view. The original right view. Note
how the focus doesn’t match
the focus in the left view.

The right view produced
by O_FocusMatcher. The
focus now bettermatches

the focus in the original left view.

The focusmatching can be done using twomethods:

• Deblur simply deconvolves one view using a specified deblur kernel. If the blurring in your input images is subtle
and remains constant across the image,Deblurmay produce the results you’re after.
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• Rebuild builds one view from scratch using the pixels from the other. If the blurring in your input images is heavy
or varies across the image, you’re better off using thismethod.

In theRebuildmode, O_FocusMatcher always requires an occlusionmask generated by an upstreamOcclu-
sionDetector node. The purpose of the occlusionmask is to identify areas whereO_FocusMatcher’s picture building
is likely to fail. You can then use theRebuild Method control to choose how to handle these areas: fill themwith the
deblurred image, the original image, or the rebuilt image.

In theDeblurmode (and when you’re using the deblurred image to fill the occluded areas in theRebuildmode), you
have the option of adjusting the size of the kernel the image has been blurred with. To do so, tune theDefocus Size
slider until you get nice deblurring - ideally, sharp edges with no ringing.

By default, the kernel shape is a circular disc. If theway your camera lens renders out-of-focus points of light is not
circular, you can feed a different shape to theKernel input. A good way of doing this is to take an out-of-focus
image shot with the same camera setup, look for blurred points of light ("bokeh"), and use the Roto node to draw a
roto shape around them. If you crop the Roto to the size of the blur shape and connect this image to theKernel
input, O_FocusMatcher then resizes the image to provide the radius defined by Defocus Size.

If you can still see ringing artefacts after adjusting the size and shape of the kernel, you can also use theRemove
Ringing, Ring Range, and Ring Ratio controls to suppress them.

Inputs
O_FocusMatcher has two inputs:

• Source - A stereo pair of images.

If disparity channels aren’t embedded in the images, you should add an O_Solver and an O_DisparityGenerator
node after the image sequence.

If occlusionmasks aren’t embedded in the images, you also need an O_OcclusionDetector node after O_Dis-
parityGenerator.

• Kernel - An optional input that allows you to change the shape of the deblur kernel. By default, the kernel is a cir-
cular disc. If theway your camera lens renders out-of-focus points of light is not circular, you can input another
shape here. O_FocusMatcher then uses the luminance of this RGB image to define the kernel shape.

The size of this image doesn’t matter, as O_FocusMatcher automatically resizes the image to provide the radius
defined by Defocus Size.

This input only has an effect if Primary Method is set toDeblur, orRebuild Method to Rebuild Plus
Deblurred.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.
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Quick Start

The Deblur Method

To correct focus differences by deblurring one view, do the following:

1. If there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or if disparity vec-
tors exist in the image sequence itself, these are used when correcting focus differences. If disparity vectors
don’t yet exist in the script, however, you can use theO_Solver and O_DisparityGenerator plug-ins after your
image sequence to calculate the disparity vectors. See Solver on page 19 and DisparityGenerator on page 32 for
how to do this.

2. From the toolbar, select Ocula > Ocula 3.0 > O_FocusMatcher to insert an O_FocusMatcher node after either
theO_DisparityGenerator node (if you added one in the previous step) or the image sequencewhose focus you
want to adjust.

Errors appear in the Viewer and theNodeGraph because by default O_FocusMatcher is set to rebuild one of the
views. In order to do that, it needs an upstreamocclusionmask.

3. We’re going to deblur rather than rebuild one of the views, so set Primary Method toDeblur in theO_
FocusMatcher controls.

The errors disappear.

4. UnderViews to Use, you can see all the views that exist in your project settings. Select the two viewswhose
focus you want to match.

The two views you selected aremapped for the left and right eye.

5. From theMatchmenu, select:

• Left to Right to deblur the left view to match the focus of the right, or

• Right to Left to deblur the right view to match the focus of the left.

6. By default, O_FocusMatcher assumes the kernel is a circular disc. If theway your camera lens renders out-of-
focus points of light is not circular, connect another shape in theKernel input.

For example, if you have an image shot with the same camera setup that has out-of-focus points of light
("bokeh"), you can use a Roto node (with output set to rgb) to draw a roto shape around one of the highlights.
Then, use a Crop node to crop and reformat the image and connect the result to theKernel input.
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Using a Roto node to create theKernel input.

You don’t need to worry about the size of theKernel image, as O_FocusMatcher automatically resizes the image
to match the radius defined by Defocus Size.

7. Uncheck Remove Ringing.

This tells O_FocusMatcher not to remove any ringing artefacts that the deblurringmay cause, making it easier for
you to seewhich settings produce the best results.

8. Make sure you are looking at the view you want to deblur, and set Defocus Size to the size of the kernel the
image has been blurred with. This value is in pixels, and it’s important to get it right. What you want is nice deblur-
ring with sharp edges but as little ringing as possible, so keep adjusting the slider until you’ve found the optimal
setting.

Ringing artefacts.

9. If you do see ringing artefacts in the deblurred image, check Remove Ringing. Adjust theRing Range value
until it covers thewidth (in pixels) of the artefacts you’re seeing.

10. Next, decreaseRing Ratio until the artefacts disappear - just bear inmind that lowering this value toomuch
may also stop real edges frombeing deblurred.
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11. Connect your Read node to the Viewer’s second input, and press 2 and 1 on the Viewer to switch between the ori-
ginal and the rebuilt view. Also compare the left and the right view. If you’re not happy with the results, go back
to adjusting theO_FocusMatcher controls or try using theRebuildmethod described below.

The Rebuild Method

To correct focus differences by rebuilding one view using the pixels from the other, do the following:

1. If there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or if disparity vec-
tors exist in the image sequence itself, these are used when correcting focus differences. If disparity vectors
don’t yet exist in the script, however, you can use theO_Solver and O_DisparityGenerator plug-ins after your
image sequence to calculate the disparity vectors. See Solver on page 19 and DisparityGenerator on page 32 for
how to do this.

2. From the toolbar, select Ocula > Ocula 3.0 > O_OcclusionDetector to add an O_OcclusionDetector node
after either theO_DisparityGenerator node (if you added one in the previous step) or the image sequence
whose focus you want to adjust.

O_OcclusionDetector generates amask for the occluded pixels in each view. The purpose of themask is to
identify regions where rebuilding a viewwith O_FocusMatcher is likely to fail. This allows you to fix those regions
later in the process. For further details on O_OcclusionDetector, seeOcclusionDetector on page 45.

3. Select Ocula > Ocula 3.0 > O_FocusMatcher to finally add an O_FocusMatcher node to your tree. In the
node’s controls, Primary Method should already be set to Rebuild, whichmeans we’re going to rebuild rather
than deblur one of the views.

Your script should now look something like the following:

4. UnderViews to Use, you can see all the views that exist in your project settings. Select the two viewswhose
focus you want to match.

These views aremapped for the left and right eye.

5. From theMatchmenu, select:

• Left to Right to rebuild the left view to match the focus of the right, or

• Right to Left to rebuild the right view to match the focus of the left.

6. In the Viewer controls, set the alpha channelmenu tomask_occlusion.alpha as shown below. This sets the
occlusionmask that O_OcclusionDetector generated in step 2 as the channel that’s displayed in the alpha chan-
nel.

Next, pressM on the Viewer to superimpose that channel as a red overlay on top of the image’s RGB channels.

6 FOCUSMATCHER | QUICK START



66

The red overlay indicates occluded regions whereO_FocusMatcher’s picture building is likely to fail.

To return to the RGB display, pressM again.

7. From theRebuild Methodmenu, choose how to handle the occluded regions:

• Rebuild Plus Deblurred - Deblur the original image in any occluded regions defined in themask_occlusion
channel. You can use theDeblur Options and theKernel input to adjust the size and shape of the deblur ker-
nel.

• Rebuild Plus Original - Use the original image in any occluded regions defined in themask_occlusion chan-
nel.

• Rebuild Only - Use the rebuilt image in any occluded regions defined in themask_occlusion channel.

8. By default, the rebuilt view has the colour profile of the original view. For example, if you chose to rebuild the
right view, the new right viewmatches the colours of the original right view. If you’d rather have the rebuilt view
match the colours of the view it was built from, uncheckMatch Original Colour.

9. Switch between the two views in the Viewer to examine the results. The focus distribution of the rebuilt view
should nowmore closely match that of the other view.

The original left view. The rebuilt right view.

10. If you see any areas that haven’t been identified in the occlusionmask but where the picture building still fails,
adjust theO_OcclusionDetector controls or simply use the paint tools in Nuke’s RotoPaint node to add those
areas to the occlusionmask.
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Controls
Views to Use - From the views that exist in your project settings, select the two viewswhose focus you want to
match. These viewswill bemapped for the left and right eye.

Match - Which view tomatch to the other’s focus.

• Left to Right - Deblur or rebuild the left view to match the right.

• Right to Left - Deblur or rebuild the right view to match the left.

Primary Method - How tomatch the focus.

• Rebuild - Rebuild one view using the pixels from the other. You can use theRebuild Method control to select how
to handle occluded regions where the picture building fails.

Choose thismethod if your input images are heavily blurred or the blur varies across the image.

• Deblur - Deconvolve one viewwith the specified kernel. You can use theDeblur Options and theKernel input to
adjust the size and shape of the kernel.

Choose thismethod if your input images are only slightly blurred and the blur is constant across the image.

Rebuild Options

Rebuild Method - When Primary Method is set to Rebuild, choose how to handle occluded regions where the pic-
ture building is likely to fail. Note that you need to use an upstreamO_OcclusionDetector node to definewhich
regions are considered occluded. O_OcclusionDetector stores this information in themask_occlusion channel.

• Rebuild Plus Deblurred - Use the deblurred image in any occluded regions defined in themask_occlusion chan-
nel. You can use theDeblur Options and theKernel input to adjust the size and shape of the deblur kernel.

• Rebuild Plus Original - Use the original image in any occluded regions defined in themask_occlusion channel.

• Rebuild Only - Use the rebuilt image in any occluded regions defined in themask_occlusion channel.

Match Original Colour - When enabled, the rebuilt view has the colour profile of the original view (for example, a
rebuilt right viewmatches the colours of the original right view).

When disabled, the rebuilt view has the colour profile of the view it was rebuilt from (a rebuilt right viewmatches the
colours of the left view).

Deblur Options

Iterations - The number of times the deconvolution algorithm is run for. Increasing this valuemay create a sharper
image but potentially at the cost of more artefacts.

Defocus Size - The size of the kernel the image has been blurred with. This value is in pixels. It’s very important to
get it right, so keep adjusting it until you get nice deblurring with sharp edges but no ringing.
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Remove Ringing - When enabled, O_FocusMatcher attempts to reduce ringing artefacts that may appear around
the edges in the image.

Ring Range - The distance from an edge (in pixels) to suppress ringing artefacts.

Ring Ratio - The strength of a strong edge relative to a nearby ringing artefact. Decreasing this value removesmore
ringing artefacts, but may also stop real edges frombeing deblurred.

Example
In this example, we correct the focus distribution in the right view of a stereo image by rebuilding it using the pixels
from the left view.

You can download the stereo image used here fromourweb site - please see Example Images on page 8.

Step by Step
1. Fire up Nuke. Open the project settings (press S on theNodeGraph), go to theViews tab, and click the Set up

views for stereo button.

2. Import lobby.exr. This image already includes both the left and the right view as well as the necessary disparity
channels.

3. Attach a Viewer to the image and zoom in. Switch between the left and the right view. As you can see, the focus
distribution of the right view doesn’t match that of the left.

The left view. The right view.

O_FocusMatcher can fix this by rebuilding the right view using pixels from the left. In order to do so, it needs an
upstreamocclusionmask that identifies occluded pixels in each view. You can generate an occlusionmask using
theO_OcclusionDetector node.

4. From the toolbar, select Ocula > Ocula 3.0 > O_OcclusionDetector to insert an O_OcclusionDetector node
between the image and the Viewer.
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O_OcclusionDetector calculates amask for the occluded pixels in each view and stores it in themask_occlusion
channel. You can adjust themask using theO_OcclusionDetector controls, but for the sake of keeping this
example short, we’re going to go with the default settings.

5. Next, add an O_FocusMatcher node after O_OcclusionDetector.

6. By default, O_FocusMatcher is set to rebuild the left view to match the focus of the right. We need it to do the
opposite, so set theMatchmenu to Right to Left.

O_FocusMatcher now rebuilds the right view using pixels from the left. If the upstreamdisparity field is accurate
and there are no occlusions (pixels visible in one view but not the other), this generally produces good results.
We have already generated an occlusionmask in step 4, so we can use it to check which areas are occluded.

7. To see the occlusionmask for the right view, select the right view from the Viewer controls and set the alpha
channelmenu tomask_occlusion.alpha. Then, pressM on the Viewer.

The occlusionmask is shown in a red overlay on top of the colour channels. Any pixels highlighted in red are only
visible in the right view but not the left.

Because these pixels don’t exist in the left view, they cannot be used to rebuild the right view. In other words, O_
FocusMatcher is likely to produce poor results in these occluded areas. The good news is that as we knowwhere
the picture building is likely to fail, we can take this into account and fix those areas using othermethods. This is
what theRebuild Methodmenu is for.
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8. If you click on theRebuild Methodmenu, you can see three options for handling the problematic areas iden-
tified in the occlusionmask:

• Rebuild Plus Deblurred - In our case, this option fills the occluded areas with a deblurred version of the ori-
ginal right view. Everything else is rebuilt from the left view.

• Rebuild Plus Original - This option fills the occluded areas with the original right view. Everything else is
rebuilt from the left view.

• Rebuild Only - This option rebuilds the entire right image from the left view, even if the picture building fails in
occluded areas.

Wewant to deblur the occluded regions, so set this to Rebuild Plus Deblurred.

9. All that’s left to do now is to make surewe are getting some nice deblurring in the occluded areas. To make this
easier to see, pressM on the Viewer to return to the RGB display and uncheck Remove Ringing in theO_
FocusMatcher controls.

10. Still displaying the right view, zoom in on the image. Youmay notice that a lot of the areas that were out-of-focus
in the original right view now look sharper and bettermatch the focus in the left view. An exception to this are
the areas considered occluded in the occlusionmask (mostly edges around the different objects). This is because
we chose to fill these areas with a deblurred version of the original right view, but asDefocus Size is set to 0 no
deblurring is being done.

11. We need to set Defocus Size to the size of the kernel the original imagewas blurred with. To find the optimal
setting, increase this value gradually until you see sharp edges that match the left view. As you do so, pay atten-
tion to the lights in the ceiling. You should see ringing artefacts appear around the lights as a result of the deblur-
ring. What you want is sharp edges but as little ringing as possible, so set Defocus Size to 1.5. This produces
some ringing, but we can fix that next.
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12. To suppress ringing, re-enableRemove Ringing. Then, increase theRing Range value until it covers thewidth
(in pixels) of the ringing artefacts you saw in the previous step. We are using a value of 10.

13. Finally, decreaseRing Ratio until you see the artefacts disappear. This control defines the strength of a strong
edge relative to a nearby ringing artefact. The lower the value, themore artefacts are removed. However, if you
decrease the value toomuch, real edgesmay stop being deblurred. A value of 2 seems to produce good results
in this case.

14. You now have your final result, so compare the rebuilt right view to both the original right view and the left view
in the Viewer. You should see that the focus distribution of the right view bettermatches that of the left.
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7 VerticalAligner

Description
If the cameras used to shoot stereoscopic images are poorly positioned or converge (point inwards), some features
in the resulting two viewsmay be vertically misaligned. In the case of converging cameras, themisalignment may be
due to keystoning. Unlike converging cameras, parallel cameras do not produce keystoning.

Parallel cameras do
not cause keystoning.

Converging cameras
do cause keystoning.

Converging cameras cause keystoning because the angle created affects the perspective in the two views. As a result,
corresponding points in the two views are vertically misaligned.

The left image. The right image.

Whether the vertical misalignment was caused by poorly positioned or converging cameras, it can lead into an
unpleasant 3D stereo viewing experience. When a vertically misaligned stereo image is viewed with 3D glasses, the
viewer’smind attempts to line up the corresponding points in the images, often causing eye strain and headaches.
To avoid this, stereo images should only contain horizontal disparity, not vertical.
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TheO_VerticalAligner plug-in lets you warp views vertically so that their corresponding features align horizontally.
TheVertical Skew and Local Alignment options allow you to warp the viewswhile keeping the horizontal position
of each pixel the same so that there is no change in convergence. An example is shown below.

BeforeO_VerticalAligner. After O_VerticalAligner.

You can choose between two warpmodes: Global Alignment and Local Alignment. In the Global Alignment
mode, O_VerticalAligner performs a global transform to align the views. In the Local Alignment mode, it rebuilds the
image per-pixel to account for any local distortions in themirror or lens and changes in alignment with depth.

In theGlobal Alignmentmode, you can choose between several alignment methods. All methods concatenate.
Thismeans that if you add a row of O_VerticalAligner nodes to a tree, their functions are combined. Because the
image is only resampled once, there is no loss of image quality and processing time is decreased.

If you have a pretracked Nuke stereo camera that describes the camera setup used to shoot the Source images, you
can also useO_VerticalAligner in theGlobal Alignmentmode to analyse the sequence and output a vertically
aligned camera pair. This works with all globalmethods except Vertical Skew (which can't be represented by a cam-
era transform). Formore information, see Analysing and Using Output Data on page 75.

In the Local Alignmentmode, O_VerticalAligner always requires a disparity field upstream. You can create one
using the Solver and DisparityGenerator nodes.

NOTE: If disparity channels are fed into this plug-in, they are not passed through to the output. This is
because after warping the input images the original disparity field is no longer valid. If you need disparity
channels further down the tree, add an O_DisparityGenerator node after O_VerticalAligner. When using
Local Alignment, you also need to useO_Solver beforeO_DisparityGenerator to recalculate the solve.

Inputs
O_VerticalAligner has two inputs:

• Source - A stereo pair of images.

In theGlobal Alignmentmode, if you’re not using the Solver input, the images should be followed by an O_
Solver node.

In the Local Alignmentmode, you need an O_Solver node and a disparity field in this input. You can create a dis-
parity field using O_DisparityGenerator.
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• Solver - If you’re using theGlobal Alignmentmode and the Source sequence doesn’t contain features that O_
Solver is able to match well, you can useO_Solver on another sequence shot with the same camera setup. If you do
so, connect O_Solver to this input.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To align a stereo pair of images vertically, you can either:

• apply a global image transform to align the featurematches generated by an upstreamO_Solver node. This allows
you to havemultiple O_VerticalAligner nodes that concatenatewith a single filter hit. If you have a pretracked Nuke
stereo camera that describes the camera setup used to shoot the Source images, you can also analyse the
sequence and output a vertically aligned camera pair. See Global Alignment on page 74.

• rebuild the view(s) to remove vertical disparity calculated by an upstreamO_DisparityGenerator. This allows you to
account for any local distortions in themirror or lens and changes in alignment with depth. See Local Alignment on
page 76.

Global Alignment
1. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node after your stereo clip. Formore information on

how to useO_Solver, see Solver on page 19.

2. Select Ocula > Ocula 3.0 > O_VerticalAligner to insert an O_VerticalAligner node after either O_Solver. In
most cases, theO_Solver node should be connected to the Source input of O_VerticalAligner, as shown in the
left hand image below. However, if you want to adjust the vertical alignment of one clip by using theO_Solver
node of another, connect theO_Solver node to the Solver input of O_VerticalAligner, as shown in the right hand
image.

Getting the camera rela-
tionship from the Source clip.

Getting the camera rela-
tionship from the Solver clip.

3. Connect a Viewer to theO_VerticalAligner node.

4. Open theO_VerticalAligner controls. UnderViews to Use, you can see all the views that exist in your project set-
tings. Select the two views you want to use for the left and right eyewhen correcting the alignment.

The two views you selected aremapped for the left and right eye.

7 VERTICALALIGNER | QUICK START
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5. From theAlignmenu, select how tomove the images to align the views:

• Both Views - Move both views half way.

• Left to Right - Move the left view to line up with the right.

• Right to Left - Move the right view to line up with the left.

6. SetWarp Mode to Global Alignment.

In thismode, O_VerticalAligner performs a global transform to align the views.

7. From theGlobal Methodmenu, choose how you want to align the views.

8. To better view the effect of O_VerticalAligner, insert an Anaglyph node between theO_VerticalAligner node and
the Viewer.

9. If you are not happy with the results, adjust the rest of theO_VerticalAligner controls and calculate the shift
again or try the Local Alignment on page 76 mode.

Analysing and Using Output Data

In all globalmethods except Vertical Skew (the default), you can click theAnalyse Sequence button to create out-
put data that you can then use to:

• vertically align a pretracked Nuke stereo camera. This allows you to continue using pretracked cameras once your
footage has been vertically aligned. Note that you can only create a vertically aligned stereo camerawhen a pre-
tracked camera is connected to theCamera input of O_Solver.

• create a Nuke CornerPin2D node that creates the same result as O_VerticalAligner.

The output data is also stored on theOutput tab of the node controls, where you can see the transform rep-
resented as a four-corner pin and a transformmatrix per view.

Do the following:

1. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node after your stereo clip. Formore information on
how to useO_Solver, see Solver on page 19.

2. If you want to vertically align a pretracked Nuke stereo camera that describes the camera setup used to shoot
the Source images (that is, a camera you have tracked with the CameraTracker node or imported to Nuke from a
third-party camera tracking application), connect the camera to theCamera input of O_Solver. If you have two
camera nodes rather than a single nodewith split controls, you can use a JoinViews (Views > JoinViews) node to
combine them first. If you want to create a CornerPin2D node that creates the same result as O_VerticalAligner,
you can skip this step.

3. Select Ocula > Ocula 3.0 > O_VerticalAligner to insert an O_VerticalAligner node after O_Solver. TheO_Solver
node should be connected to the Source input of O_VerticalAligner.

4. Connect a Viewer to theO_VerticalAligner node.
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5. Open theO_VerticalAligner controls. UnderViews to Use, you can see all the views that exist in your project set-
tings. Select the two views you want to use for the left and right eyewhen correcting the alignment.

The two views you selected aremapped for the left and right eye.

6. From theAlignmenu, select how tomove the images to align the views:

• Both Views - Move both views half way.

• Left to Right - Move the left view to line up with the right.

• Right to Left - Move the right view to line up with the left.

7. Set Global Method to any method except Vertical Skew.

If you attached cameras to theCamera input in step 2, the camera data is used per frame in theCamera Rota-
tionmethod. In all othermethods, the alignment is calculated at keyframes and interpolated between the key-
frames.

8. Make sureWarp Mode is set to Global Alignment.

9. Click Analyse Sequence. When prompted, enter a frame range to analyse. O_VerticalAligner analyses the
sequence. If you go to theOutput tab in the node controls, you can see the transform represented as a four-
corner pin and amatrix per view (in all modes except Vertical Skew).

10. You can now use the output data in the following ways:

• To output a vertically aligned camera pair, click either Create Camera or Create Rig. Create Camera pro-
duces a single Camera nodewith split controls to hold the left and right view parameters. Create Rig produces
two Camera nodes and a JoinViews node that combines them.

• To create a Nuke CornerPin2D node that represents the result of O_VerticalAligner, click Create Corner Pin. A
CornerPin2D node that creates the same result as O_VerticalAligner appears in theNodeGraph.

NOTE: You can usemultiple concatenated O_VerticalAligner nodes to produce the desired alignment. If
you do so, you should Analyse Sequence on the last node to create the concatenated output.

Local Alignment
1. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node after your stereo clip. Formore information on

how to useO_Solver, see Solver on page 19.

2. Insert an O_DisparityGenerator node after O_Solver. SeeDisparityGenerator on page 32.

3. Add an O_VerticalAligner node after O_DisparityGenerator.

4. Connect a Viewer to theO_VerticalAligner node.
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5. Open theO_VerticalAligner controls. UnderViews to Use, you can see all the views that exist in your project set-
tings. Select the two views you want to use for the left and right eyewhen correcting the alignment.

The two views you selected aremapped for the left and right eye.

6. From theAlignmenu, select how tomove the images to align the views:

• Both Views - Move both views half way.

• Left to Right - Move the left view to line up with the right.

• Right to Left - Move the right view to line up with the left.

7. SetWarp Mode to Local Alignment.

In thismode, O_VerticalAligner rebuilds the view(s) to remove vertical disparity calculated by the upstreamO_Dis-
parityGenerator node. This can be useful if there are local distortions in themirror or lens or changes in align-
ment with depth (for example, if an actor in the foreground is aligned but the background is not).

8. To better view the effect of O_VerticalAligner, insert an Anaglyph node (Views > Stereo > Anaglyph) between
theO_VerticalAligner node and the Viewer.

9. If you are not happy with the results, try the Global Alignment mode.

Controls

O_VerticalAligner tab

Views to Use - From the views that exist in your project settings, select the two views you want to align. These views
will bemapped for the left and right eye.

Align - Select how tomove the views to align the images.

• Both Views - Move both views half way.

• Left to Right - Move the left view to line up with the right.

• Right to Left - Move the right view to line up with the left.

Warp Mode - Themode to use for vertical alignment.

• Global Alignment - Applies a global image transform to align the featurematches generated by an upstreamO_
Solver node. You can use theGlobal Methodmenu to choose how this is done. With all methods, multiple O_Ver-
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ticalAligner nodes concatenatewith a single filter hit. You can also analyse to create Corner Pin and Camera inform-
ation in all methods except Vertical Skew.

• Local Alignment - Rebuilds the view(s) to remove vertical disparity calculated by an upstreamO_Dis-
parityGenerator. Use thismode to create a per-pixel correction if there are any local distortions in themirror or
lens and changes in alignment with depth.

Global Method - Select themethod you want to use to align the images whenWarp Mode is set to Global Align-
ment.

• Vertical Skew - Align the features along the y axis using a skew. This does not move the features along the x axis.

• Perspective Warp - Do a four-corner warp on the images to align themon the y axis. Thismay move the features
slightly along the x axis.

• Rotation - Align the features vertically by rotating the entire image around a point. The centre of the rotation is
determined by the algorithm.

• Scale - Align the features vertically by scaling the image.

• Simple Shift - Align the features vertically by moving the entire image up or down.

• Scale Rotate - Align the features vertically by simultaneously scaling and rotating the entire image around a point.
The centre of the rotation is determined by the algorithm.

• Camera Rotation - Align the features by first performing a 3D rotation of both cameras so that they have exactly
the same orientation and a parallel viewing axis, and then reconverging the views to provide the original con-
vergence. Thismethod requires the camera geometry provided by an upstreamO_Solver node. For best results,
use theO_Solver Camera input to provide the information for the shooting cameras. If a Camera input is con-
nected, the camera data is used per frame (rather than only taken from keyframes).

Filter - Select the filtering algorithm to usewhen remapping pixels from their original positions to new positions. This
allows you to avoid problemswith image quality, particularly in high contrast areas of the frame (where highly
aliased, or jaggy, edgesmay appear if pixels are not filtered and retain their original values). This control is only avail-
able if you have setWarp Mode to Global Alignment.

• Impulse - Remapped pixels carry their original values.

• Cubic - Remapped pixels receive some smoothing.

• Keys - Remapped pixels receive some smoothing, plusminor sharpening.

• Simon - Remapped pixels receive some smoothing, plusmedium sharpening.

• Rifman - Remapped pixels receive some smoothing, plus significant sharpening.

•Mitchell - Remapped pixels receive some smoothing, plus blurring to hide pixelation.

• Parzen - Remapped pixels receive the greatest smoothing of all filters.

•Notch - Remapped pixels receive flat smoothing (which tends to hideMoiré patterns).

Analyse Sequence - Analyse the sequence to create a corner pin or aligned camera output. UseAnalyse
Sequence to create the output data in all globalmethods except Vertical Skew (the default). Then, useCreate
Corner Pin, Create Camera, or Create Rig.
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Create Corner Pin - Click this to create a corner pin representing the result of O_VerticalAligner once you have
clicked Analyse Sequence. You can usemultiple O_VerticalAligner nodes to produce the desired alignment. Then,
analyse on the final node to create a single corner pin to represent the concatenated transform. This works in all
globalmethods except Vertical Skew (the default).

Create Camera - If you have a pretracked Nuke stereo camera connected to theCamera input of theO_Solver up
the tree and you have clicked Analyse Sequence, you can click this to create a vertically aligned camera from the
analysis. This gives you a single Camera nodewith split controls to hold the left and right view parameters. This
works in all globalmethods except Vertical Skew (the default).

Create Rig - If you have a pretracked Nuke stereo camera connected to theCamera input of theO_Solver up the
tree and you have clicked Analyse Sequence, you can click this to create a vertically aligned camera rig from the ana-
lysis. This gives you two Camera nodes and a JoinViews node that combines them. This works in all globalmethods
except Vertical Skew (the default).

Output tab

Four Corner Pin - This represents the 2D corner pin that can be applied to the input image to create the same result
as O_VerticalAligner (in all globalmethods except Vertical Skew). This allows you to do the analysis in Nuke, but
take thematrix to a third-party application, such as Baselight, and align the image or camera there.

Transform Matrix - This provides the concatenated 2D transform for the vertical alignment. Thematrix is filled
when you click Analyse Sequence on theO_VerticalAligner tab. There is onematrix for each view in the source.

Example
In this example, we correct the vertical alignment of a stereo image using theGlobal Alignmentmode. The image
used here can be downloaded fromourweb site. Formore information, please see Example Images on page 8.

Step by Step
1. Fire up Nuke. Open the project settings (press S on theNodeGraph), go to theViews tab, and click the Set up

views for stereo button.

2. Import the steep_hill.exr image and connect it to a Viewer. The image includes both the left and the right view.

3. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node after the stereo clip. Formore information on
how to useO_Solver, see Solver on page 19.

4. Click Add Key to set at least one keyframe.

5. Insert an O_VerticalAligner (Ocula > Ocula 3.0 > O_VerticalAligner) and an Anaglyph node (Views > Stereo >
Anaglyph) after O_Solver.

6. In theO_VerticalAligner controls, make sureWarp Mode is set to Global Alignment.
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O_VerticalAligner applies a global image transform to align the featurematches generated by the upstreamO_
Solver node.

In thismode, O_VerticalAligner does not need disparity vectors upstream.

7. To better see the effect, select theO_VerticalAligner node and pressD repeatedly to disable and enable the
node. With the node disabled, the views remain vertically misaligned, as shown below.

The zoomed in imagewith theO_VerticalAligner
node disabled.

However, when you enable theO_VerticalAligner node, the views align nicely. This is shown below.

The zoomed in imagewith O_VerticalAligner enabled.
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8 NewView

Description
Using theO_NewView plug-in, you can create a single view from a stereo pair of images. You can create this new view
at any position between the original views. The new view replaces both of the existing views.

You can choose to construct the new view using one or both of the original views. Using just one view can be useful if
you want to manipulate it with a gizmo, a plug-in, or a graphics editor, for example, and copy your changes into the
other view. You canmake your changes to one view, and use theO_NewView plug-in to generate the other viewwith
these changes reproduced in the correct position.

If there are no occlusions (features visible in one view but not the other), O_NewView generally produces good res-
ults. When there are occlusions, the resultsmay require further editing but can often save you time over not using
the plug-in at all.

To generate the new view, theO_NewView plug-in needs disparity vectors that relate the two views. You can use the
O_Solver and O_DisparityGenerator plug-ins to calculate these vectors. See Solver on page 19 and Dis-
parityGenerator on page 32 for how to do this.

If you useO_NewView to reproduce changesmade to one view in the other view, youmay want to create the dis-
parity vectors using either themodified view and its corresponding view, or the original views with no changes
applied. Which you choose depends on which you think will produce better disparity vectors. The formermethod
may be preferable, if you are correcting an unwanted colour shift between views, for example. The lattermethod usu-
ally works best if your changes in one view produce an occlusion in the images, for example, when using a texture
replacement plug-in or painting something on one view in another application.

NOTE: To reproduce changes you’vemade using Nuke’s Roto node, RotoPaint node, or any node or gizmo
that has controls for x and y coordinates, see the Stereoscopic Projects chapter in theNukeUser Guide.

TIP: O_NewView is often used as a troubleshooting tool, to judge the quality of a particular disparity field.
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Inputs
O_NewView has two inputs:

• Source - A stereo pair of images. If disparity channels aren’t embedded in the images, you should add an O_Solver
and an O_DisparityGenerator node after the image sequence.

• Fg - An optionalmask that delineates foreground regions frombackground. Themask ensures that disparities are
constrained to remain within each delineated region. Note that masks should exist in both views, and O_NewView
expects alpha values of either 0 (for background) or 1 (for foreground).

Note that the Fg input only has an effect when Inputs is set to Both and Interpolate Position is greater than 0
and less than 1.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To create a new view:

1. If there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or if disparity vec-
tors exist in the image sequence itself, these are used when generating the new view. If disparity vectors don’t
yet exist in the script, however, you can use a combination of theO_Solver and O_DisparityGenerator plug-ins to
calculate the disparity vectors. Select Ocula > Ocula 3.0 > O_Solver andOcula > Ocula 3.0 > O_Dis-
parityGenerator to insert these in an appropriate place in your script.

2. Select Ocula > Ocula 3.0 > O_NewView to insert an O_NewView node after either theO_DisparityGenerator
node or the stereo image sequence.

3. Using theViews to Use controls, select the views you want to map for the left and right eye.

4. From the Inputs dropdownmenu, select which input(s) you want to use to create the new view:

• Left - Only use the imagemapped for the left eye to create the new view.

• Right - Only use the imagemapped for the right eye to create the new view.

• Both - Use both images to create the new view.

5. Adjust the Interpolate Position slider to definewhere to build the new view. The values are expressed as a frac-
tion of the distance between the two views.

6. Attach a Viewer to theO_NewView node.
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A node treewith O_NewView. TheO_Solver and
O_DisparityGenerator nodes are not needed in this tree if

the necessary disparity channels are included in the Read node.

7. If you are not happy with the results, try adjusting the rest of theO_NewView controls. They are described
below.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to create the
new view. These viewswill bemapped for the left and right eye.

Inputs - Select which inputs to use to generate the new view.

• Left - Only use the input mapped for the left eye to create the new view.

• Right - Only use the input mapped for the right eye to create the new view.

• Both - Use both inputs to create the new view.

Interpolate Position - Select the position between the existing viewswhere you want to generate the new view.
The position is expressed as a fraction of the distance between the views.

Filtering - Set the quality of filtering.

• Extreme - Uses a sinc interpolation filter to give a sharper picture but takes a lot longer to render.

•Normal - Uses bilinear interpolation which gives good results and is a lot quicker than extreme.

Warp Mode - Select amethod to use to generate the new view.

• Simple - This is the quickest option, but may produce less than optimal results around image edges and objects
that are visible in one view but not the other.

•Normal - This is the standard option, withmore optimal treatment of image edges and occlusions.

•Occlusions - This is an advanced option that may improve the results.

• Sharp Occlusions - This option is similar to Occlusions, but produces fewer artifacts where the disparity fields are
generated from 3D CG sources.

Foreground Component - Select the channel to use to delineate foreground regions frombackground. Themask
ensures that disparities are constrained to remain within each delineated region.

•None - Use the entire image area.

• Source Alpha - Use the alpha channel of the Source clip.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip.

•Mask Luminance - Use the luminance of the Fg input.

•Mask Inverted Luminance - Use the inverted luminance of the Fg input.

•Mask Alpha - Use the alpha channel of the Fg input.

•Mask Inverted Alpha - Use the inverted alpha channel of the Fg input.
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Example
In this example, we have a stereo image of a cathedral. In the left view, one of the cathedral windows has been
removed using F_BlockTexture - a texture replacement tool included in The Foundry’s Furnace plug-ins. Our aim is to
reproduce this change in the right view using theO_NewView plug-in. We construct a new right view from the left
view, with the changes in the correct position.

The stereo image used in the example can be downloaded fromourweb site. Formore information, please see
Example Images on page 8.

The necessary disparity channels have been embedded in the download image, so you don’t need to use theO_
Solver and O_DisparityGenerator plug-ins in this example. However, you should note that the disparity channels
were calculated using the original left and right views (with thewindow still in place in both views). This is because
removing thewindow fromone view but not the other produces an occlusion, and theO_NewView plug-in works bet-
ter when there are no occlusions.

Step by Step
1. Start Nuke and open the project settings (press S on theNodeGraph). Go to theViews tab and click the Set up

views for stereo button.

2. Import cathedral1.exr and attach a Viewer to the image. Switch between the left and the right view. Notice how
in the left view, the cathedral has onewindow less than in the right view. This is highlighted below.

The left view. The right view.

Wewant to reproduce this changemade to the left view in the right view using theO_NewView plug-in.

3. Select Ocula > Ocula 3.0 > O_NewView to insert an O_NewView node between the stereo image and the
Viewer.

4. In theO_NewView controls, select Left from the Inputsmenu to generate the new view from the left view.
Enter 1 as the Interpolate Position to create the new view in the same position as the original right view.

As you can see from the image below, thewindow disappears from the right view, but theO_NewView plug-in cre-
ates some unwanted changes around the edges of the new view.
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The new view generated with O_NewView.

To prevent this, we can take the area around thewindow from the new view, and composite that over the ori-
ginal right view.

5. Select theO_NewView node andDraw > Roto from the Toolbar (or pressO on theNodeGraph).

This inserts a Roto node after O_NewView.

6. In the Roto controls, change the output to alpha, and premultiply to rgba.

The Viewer goes black. Attach it to the Read node (rather than the Roto node) and display the right view.

7. Using the Roto Bezier tool, draw a shape around thewindow that was removed from the left view. The image
below shows a quickly drawn example of what your shapemight now look like.

Drawing a Bezier around thewindow.

8. Attach the Viewer to the Roto node now, and zoomout if necessary. You should only see the area you defined
with the Roto node. This is what we are going to composite over the original right view.

9. To extract the original right view from the original Read node, click on an empty space in theNodeGraph and
select Views > OneView from the Toolbar. Connect theOneView node into the Read node.
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10. In theOneView controls, select right from the viewmenu. If you now view the output of OneView, you should
see the original right viewwith thewindow still in place.

11. To composite the output from the Roto node on top of the original right view, click on an empty spot in the
NodeGraph and selectMerge >Merge (or pressM).

12. Connect theA input of the resulting over node into the Roto and theB input into theOneView node. Attach a
Viewer to theMerge node. Your node tree should now look like the one shown below.

13. View the output of theMerge node. This is your final right view. Notice that the covered window has been
copied from the left view into the correct position in the right view, but the rest of the right view hasn’t changed.

Now, we only need to combine the new right viewwith the original left view from the Read node.

1. Click on an empty spot in theNodeGraph and select Views > JoinViews.

2. Connect the left input from the JoinViews node into the Read node, and the right input into theMerge node.

3. Attach a Viewer to the JoinViews node. Your node tree should look like the one shown below.
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4. Using the Viewer controls, switch between the left and the right views. The changesmade to the left view have
been copied into the right view, in the correct position, as shown.

The left view. The new right view.

TIP: To better seewhat the new view looks like, close the Roto node controls or pressO on the Viewer to
toggle the overlay off.
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9 InteraxialShifter

Description
TheO_InteraxialShifter plug-in lets you reduce the interaxial distance of stereo images; that is, the distance between
the two cameras. Using this plug-in, you can generate two new views at specified positions between the original
images.

Changing interaxial distance... ...is the equivalent
of moving the cameras closer
together or further apart.

Reducing interaxial distance affects the perceived depth of the images when they are viewed with 3D glasses. It
reduces the depth between elements of the image so they appear closer together. This is illustrated below, where the
grey rectangles represent elements depicted in a stereo image.

Reducing interaxial distance... ...changes the
perceived depth of the images.
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Youmay want to reduce interaxial distance during post production for a variety of reasons. For example, it can be
useful when trying to match the depths between scenes in order to make transitionsmore comfortable for the
viewer, or simply because the desired depth of a shot has been reconsidered as the final film evolves. It might also
help in the process known as depth grading, where the depth of field is adjusted in order to make sure the stereo
effect can be comfortably viewed on the screen size for which the finished film is intended. The apparent depth of
the scenewill depend upon a combination of the screen size and the distance from the screen to the viewer.

If there are no occlusions (features visible in one view but not the other), O_InteraxialShifter generally produces good
results. When there are occlusions, the resultsmay require further editing but can often save you time over not
using the plug-in at all, or the cost of a reshoot.

To generate the new view, theO_InteraxialShifter plug-in needs upstreamdisparity vectors that relate the two views.
You can use theO_Solver and O_DisparityGenerator plug-ins to calculate these vectors. SeeNewView on page 81
and DisparityGenerator on page 32 for how to do this.

NOTE: This plug-in does not pass through any disparity channels fed into it. This is because after warping
the input images the original disparity field is no longer valid. If you need disparity channels further down
the tree, add another O_DisparityGenerator after O_InteraxialShifter.

NOTE: Changing interaxial distance is different to changing convergence (the inward rotation of the cam-
eras). You can change convergence using Nuke’s ReConverge node. This way, you can have any selected
point in the image appear at screen depth when viewed with 3D glasses.

Inputs
O_InteraxialShifter has two inputs:

• Source - A stereo pair of images. If disparity channels aren’t embedded in the images, you should add an O_Solver
and an O_DisparityGenerator node after the image sequence.

• Fg - An optionalmask that delineates foreground regions frombackground. Themask ensures that disparities are
constrained to remain within each delineated region. Note that masks should exist in both views, and O_Inter-
axialShifter expects alpha values of either 0 (for background) or 1 (for foreground).

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To reduce interaxial distance, do the following:

1. If there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or if disparity vec-
tors exist in the image sequence itself, these are used when generating the two new views. If disparity vectors
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don’t yet exist in the script, however, you can use theO_Solver and O_DisparityGenerator plug-ins after your
image sequence to calculate the disparity vectors. See Solver on page 19 and DisparityGenerator on page 32 for
how to do this.

2. From the toolbar, select Ocula > Ocula 3.0 > O_InteraxialShifter to insert an O_InteraxialShifter node after
either theO_DisparityGenerator node (if you added one in the previous step) or the image sequencewhose inter-
axial distance you want to adjust.

3. UnderViews to Use, select the views you want to use to create new views.

4. Use the Interpolate Left Position and Interpolate Right Position sliders to indicatewhere you want to build
the new left and right views. The values are expressed as a fraction of the distance between the two views.

5. Attach a Viewer to theO_InteraxialShifter node.

A node treewith O_InteraxialShifter. O_Solver and O_Dis-
parityGenerator are not needed in this tree if the necessary

disparity channels are included in the Read node.

6. If the results are not what you’re after, adjust the rest of theO_InteraxialShifter controls. All the controls are
described below.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to create the
new views. These viewswill bemapped for the left and right eye.

Interpolate Left Position - Select a position between the viewswhere you want to generate the left view. The pos-
ition is expressed as a fraction of the distance between the views.

Interpolate Right Position - Select a position between the viewswhere you want to generate the right view. The
position is expressed as a fraction of the distance between the views.

Filtering - Set the quality of filtering.

• Extreme - Uses a sinc interpolation filter to give a sharper picture but takes a lot longer to render.

•Normal - Uses bilinear interpolation which gives good results and is a lot quicker than extreme.

Warp Mode - Select amethod to use to create the new views.

• Simple - This is the quickest option, but may produce less than optimal results around image edges and objects
that are visible in one view but not the other.

•Normal - This is the standard option, withmore optimal treatment of image edges and occlusions.

•Occlusions - This is an advanced option that may improve the results.
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• Sharp Occlusions - This option is similar toOcclusions, but produces fewer artifacts where the disparity fields are
generated from 3D CG sources.

Foreground Component - Select the channel to use as to delineate foreground regions frombackground. The
mask ensures that disparities are constrained to remain within each delineated region.

•None - Use the entire image area.

• Source Alpha - Use the alpha channel of the Source clip.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip.

•Mask Luminance - Use the luminance of the Fg input.

•Mask Inverted Luminance - Use the inverted luminance of the Fg input.

•Mask Alpha - Use the alpha channel of the Fg input.
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Description
O_VectorGenerator generatesmotion vector fields for each view in a stereo image. Amotion vector field maps the
location of a pixel on one frame to the location of the corresponding pixel in a neighbouring frame. It has the same
dimensions as the image, but contains an (x,y) offset per pixel. These offsets show how to warp a neighbouring
image onto the current image.

Clearly, asmost of the images in a sequence have two neighbours, each can have two vector fields. These are called
the ’forwardmotion vectors’ where they represent thewarp of the image in front of the current one, and ’backward
motion vectors’ where they represent thewarp of the image behind the current one.

It’s important to note that O_VectorGenerator calculates itsmotion vectors in away that maintains the alignment
between views and avoids breaking the stereo effect. In order to do so, it needs an upstreamO_Solver node and a
disparity field that ties themotion in each view together (for details on how to generate a disparity field, see Solver
on page 19 and DisparityGenerator on page 32).

While disparity vectorsmap pixels between views, motion vectorsmap them
between frames.

O_VectorGenerator stores themotion vectors in the backward and forwardmotion channels. To view these in Nuke,
selectmotion, forward, or backward from the channel set menu in the top left corner of the Viewer.
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Cathedral sequence. Forward and backwardmotion
vectors for the cathedral

sequence.

Forwardmotion vectors. Backwardmotion vectors.

If you want to use pre-calculatedmotion vectors rather than generate vector fields on the fly each time you need
them, you can use aWrite node to render them into the channels of your stereo EXR file along with the colour and
disparity channels. Later, whenever you use the same image sequence, themotion vectors will be loaded into Nuke
together with the sequence.

Ocula’s Retimer plug-in relies onmotion vectors to produce its output, but youmay also want to useO_Vect-
orGenerator for other purposes (for example, for generatingmotion blur).

Inputs
O_VectorGenerator has two inputs:

• Source - A stereo pair of images. Unless you are using the Solver input, the images should be followed by an O_
Solver node. If disparity channels aren’t embedded in the images, you should also have an O_DisparityGenerator
node in this input.

• Solver - If the Source sequence doesn’t contain features that O_Solver is able to match well, you can useO_Solver
on another sequence shot with the same camera setup. If you do, connect O_Solver to this input.

• Ignore - An optionalmask that specifies areas to exclude from themotion calculation. You can use this input to pre-
vent distortions at occlusions or to calculatemotion for a background layer by ignoring all foreground elements.
Note that masks should exist in both views, and O_VectorGenerator expects alpha values of either 0 (for regions to
use) or 1 (for regions to ignore).
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The left view. An ignoremask for the left
view. This ignores the fore-
ground elements to calculate
motion for the background.

• Fg - An optionalmask that specifies the only areas to include in themotion calculation. You can use this to create a
motion layer for a foreground element. To create layers for different elements, use several O_VectorGenerator
nodes. If necessary, you can also use the Ignoremask to exclude elements in the foreground region. Note that
masks should exist in both views, and O_VectorGenerator expects alpha values of either 0 (for background) or 1
(for foreground).

The left view. A foregroundmask for the left
view.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To generatemotion vectors for a stereo pair of images, do the following:

1. O_VectorGenerator always requires an upstream Solver node, so select Ocula > Ocula 3.0 > O_Solver from the
toolbar to insert an O_Solver node after your image sequence.

2. If there are disparity vectors in the data stream from an earlier DisparityGenerator node, or if disparity vectors
exist in the image sequence itself, these are used when generating themotion vectors. If disparity vectors don’t
yet exist in the script, however, add an O_DisparityGenerator plug-in after O_Solver to calculate the disparity vec-
tors.

3. Select Ocula > Ocula 3.0 > O_VectorGenerator to add an O_VectorGenerator node after either O_Solver or
O_DisparityGenerator (if you added one in the previous step).

4. Make sure you are viewing the output fromO_VectorGenerator.
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5. In theO_VectorGenerator controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to use to calculate themotion vectors.

The two views you selected aremapped for the left and right eye.

6. If there are areas in the image that you want to ignorewhen generating themotion vector field, supply amask
either in the Ignore input or the alpha of the Source input. In theO_VectorGenerator controls, set Ignore
Mask to the component you want to use as themask.

You can also provide a foregroundmask in the Fg input or the alpha of the Source input. This restricts the
motion calculation to themasked areas, allowing you to create amotion layer for a foreground element. In the
O_VectorGenerator controls, set Foreground Mask to the component you want to use as themask.

Using both an Ignore and an Fgmask, you can restrict themotion calculation to a foreground region but
exclude any problematic areas from that region.

7. Use theAlignment control to set howmuch to constrain themotion vectors to match the horizontal alignment
defined by the upstreamO_Solver node. A value of 0 calculates themotion vectors using unconstrainedmotion
estimation. Increasing the value forces the vectors to be aligned. In most cases, you want this set to 0 or the
default value of 0.1.

8. Set the Viewer’s channel set menu tomotion, forward, or backward.

O_VectorGenerator calculates themotion vectors, which are then displayed in the Viewer.

9. If necessary, adjust Noise, Strength, Sharpness, and Smoothness and view their effect on themotion vector
field. Formore information on these parameters, see Controls below.

10. You can also use the Fg input to separate foreground and background layers to handle severe occlusions. In the
O_VectorGenerator controls, set Foreground Mask to the component you want to use as themask.

11. If you want to save the newly createdmotion vectors in the channels of your stereo clip, select Image >Write
to insert aWrite node after O_VectorGenerator. In theWrite node controls, select all from the channels pull-
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downmenu. Choose exr as the file type. Enter a name for the clip in the file field (for example,my_
clip.####.exr), and click Render.

When you need to manipulate the same clip again later, themotion vectors are loaded into Nuke together with
the clip.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to calculate
themotion vectors. These viewswill bemapped for the left and right eye.

Ignore Mask - An optionalmask that specifies areas to exclude from themotion calculation. You can use this input
to prevent distortions at occlusions or to calculatemotion for a background layer by ignoring all foreground ele-
ments. Note that masks should exist in both views, and O_VectorGenerator expects alpha values of either 0 (for
regions to use) or 1 (for regions to ignore).

•None - Do not use an ignoremask.

• Source Alpha - Use the alpha channel of the Source clip as an ignoremask.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip as an ignoremask.

•Mask Luminance - Use the luminance of the Ignore input as an ignoremask.

•Mask Inverted Luminance - Use the inverted luminance of the Ignore input as an ignoremask.

•Mask Alpha - Use the alpha channel of the Ignore input as an ignoremask.

•Mask Inverted Alpha - Use the inverted alpha channel of the Ignore input as an ignoremask.

ForegroundMask - An optionalmask that specifies the only areas to include in themotion calculation. You can use
this to create amotion layer for a foreground element. To create layers for different elements, use several O_Vect-
orGenerator nodes. If necessary, you can also use the Ignoremask to exclude elements in the foreground region.
Note that masks should exist in both views, and O_VectorGenerator expects alpha values of either 0 (for back-
ground) or 1 (for foreground).

•None - Do not use a foregroundmask.

• Source Alpha - Use the alpha channel of the Source clip as a foregroundmask.

• Source Inverted Alpha - Use the inverted alpha channel of the Source clip as a foregroundmask.

•Mask Luminance - Use the luminance of the Fg input as a foregroundmask.

•Mask Inverted Luminance - Use the inverted luminance of the Fg input as a foregroundmask.

•Mask Alpha - Use the alpha channel of the Fg input as a foregroundmask.

•Mask Inverted Alpha - Use the inverted alpha channel of the Fg input as a foregroundmask.

Noise - This sets the amount of noiseO_VectorGenerator should ignore in the input footagewhen calculating the
motion vectors. The higher the value, the smoother themotion vector field. Youmay want to increase this value if
you find that themotion vector field is noisy in low-contrast image regions.
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Strength - Sets the strength inmatching pixels between frames. Higher values allow you to accurately match similar
pixels in one image to another, concentrating on detail matching even if the resultingmotion field is jagged. Lower
valuesmay miss local detail, but are less likely to provide you with the odd spurious vector, producing smoother res-
ults. Often, it is necessary to trade one of these qualities off against the other. Youmay want to increase this value to
force the images to match, for example, where fine details aremissed, or decrease it to smooth out themotion vec-
tors.

Alignment - Sets howmuch to constrain themotion vectors to match the horizontal alignment defined by an
upstreamO_Solver node. A value of 0 calculates themotion vectors using unconstrainedmotion estimation. Increas-
ing the value forces the vectors to be aligned. In most cases, you want this set to 0 or the default value of 0.1.

Sharpness - Sets how distinct object boundaries should be in the calculatedmotion vector field. Increase this value
to produce distinct borders and separate objects. Decrease the value to blurmotion layers together andminimise
occlusions. For better picture building with O_Retimer, you can set this value to 0.

Sharpness set to 0. Sharpness set to 1.

Smoothness - Applies extra smoothing to themotion vector field as a post process after imagematching. The
higher the value, the smoother the result. You can use this in conjunction with the Sharpness parameter to smooth
out themotion vector field separately for distinct objects in the shot.

Example
See Example on page 101 for an example of how to useO_VectorGenerator and O_Retimer to calculate amotion vec-
tor field for a stereo image and use it to retime the sequence.
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Description
O_Retimer is designed to slow down or speed up stereo footage using upstreammotion vectors generated by the
VectorGenerator node. Thesemotion vectors describe how each pixel moves from frame to frame. With accurate
motion vectors, it is possible to generate an output image at any point in time throughout the sequence by inter-
polating along the direction of themotion.

Simplemix of two frames to
achieve an inbetween frame.

O_Retimer vector interpolation
of the same two frames.

When calculatingmotion vectors, O_VectorGenerator uses an upstreamdisparity field to tie themotion in each view
together. Thismaintains the alignment between views, whichmeans O_Retimer is able to retime the input footage
without breaking the stereo effect.

By default, O_Retimer is set to perform a half speed slow down. This is achieved by generating a new frame at pos-
ition 0.25 and 0.75 between the original frames at 0 and 1. Frames are created at a quarter and three quarters
instead of zero (an original frame) and a half so as not to include any original frames in the re-timed sequence. This
avoids the pulsing that would otherwise be seen on every other frame on a half speed slowdown.

NOTE: O_Retimer also retimes the incoming disparity vectors. This allows you to retime one view and then
rebuild the other view using NewView and the retimed disparity. This ensures the retimed viewsmatch
exactly.
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Inputs
O_Retimer has two inputs:

• Source - A stereo pair of images. If motion vectors aren’t embedded in the images, you should use a Vect-
orGenerator node to calculate them.

•Motion - If a stereo image and a VectorGenerator node are supplied here, motion vectors will be calculated from
this sequence and applied to the input sequence. This can be useful if, for example, your input sequence is very
noisy, as toomuch noise interferes with themotion estimation. In that case, you should supply a smoothed ver-
sion of the sequence and an O_VectorGenerator node here.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To slow down or speed up stereo footage, do the following:

1. If there aremotion vectors in the data stream from an earlier O_VectorGenerator node, or if motion vectors
exist in the image sequence itself, these are used when retiming the sequence. If motion vectors don’t yet exist
in the script, however, you can use theO_VectorGenerator plug-in to calculate them. See VectorGenerator on
page 92 for information on how to do this.

2. Select Ocula > Ocula 3.0 > O_Retimer to apply O_Retimer after either theO_VectorGenerator node (if you
added one in the previous step) or the stereo image sequence.

3. In theO_Retimer controls, you can see all the views that exist in your project settings underViews to Use.
Select the two views you want to use to retime the sequence.

The two views you selected aremapped for the left and right eye.

4. View the output.

By default, the Speed control is set to perform a half speed slow down.

5. To adjust the slow down or to speed the sequence up, enter a new value for the Speed control. Values below 1
slow down the clip. Values above 1 speed it up. The default value, 0.5, created the half speed slow down.
Quarter speed would be 0.25.

Alternatively, you can describe the retiming in terms of ‘at frame 100 in the output clip, I want to see frame 50 of
the source clip‘. To do so, set Timing to Source Frame. Go to a frame in the timeline, and set Frame to the
input frame you want to appear at that output position. You’ll need to set at least two key frames for this to
retime the clip. For example, to slow down a 50 frame clip by half, you can set Frame to 1 at frame 1, and to 50
at frame 100.
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6. To create an arbitrarily changing speed for the sequence, see Varying the Speed on page 100.

7. Review the results. If you see any tearing or other problemswith the stereo effect, you can try rebuilding one of
the views using O_NewView and the retimed disparity. This ensures the retimed viewsmatch exactly. See Rebuild-
ing a Retimed View on page 100.

Varying the Speed

To vary the speed in your sequence, do the following:

1. In theO_Retimer controls, choose Source Frame as the Timing method.

This allows you to describe the retiming in terms of ‘at frame 100 in the output clip, I want to see frame 50 of the
source clip‘.

2. Animate the Frame parameter. Select an output frame from the timeline and set Frame to the input frame you
want to appear at that output position. From the animationmenu next to the Frame parameter, select Set key.

3. Move to another frame on the timeline and set Frame to the input frame you want to appear at that position. A
key frame is set automatically. For example, to do a four times slow down,move to frame 1 and set Frame to 1,
select Set key from the animationmenu, move to frame 19, and set Frame to 5.

You should now have a linear time curve, which you can see if you select Curve editor orDope sheet from the
animationmenu next to Frame. By using the Curve Editor or Dope Sheet to adjust this curve, you can create an
arbitrarily changing speed for the sequence.

Instead of animating the Frame parameter, you can also switch Timing to Speed, and animate the Speed para-
meter.

Rebuilding a Retimed View

If you have retimed both views as described above and are not happy with the results, do the following:

1. Use any Nuke or Ocula nodes required to fix the retimed result in one view.

2. ChooseOcula > Ocula 3.0 > O_NewView from the Toolbar.

This inserts an O_NewView node in your node tree.

3. In theO_NewView controls, set Inputs to the view you fixed in step 1.

4. Then, set Interpolate Position to the other view: either 0 for the left view or 1 for the right.

O_NewView uses the retimed disparity field and the view you fixed to rebuild the other view.

5. Select Views > JoinViews to create a JoinViews node. Connect its inputs to the view you fixed in step 1 and the
O_NewView node that generates the other view.

JoinViews combines these into a stereo output.
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6. Connect a Viewer to the JoinViews node to view the result.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to retime the
clip. These viewswill bemapped for the left and right eye.

Timing - Sets how to control the new timing of the clip.

• Speed - select this if you wish to describe the retiming in terms of overall duration: double speed will halve the dur-
ation of the clip or half speed will double the duration of the clip.

• Source Frame - select this if you wish to describe the retiming in terms of ‘at frame 100 in the output clip, I want to
see frame 50 of the source clip‘. You’ll need to set at least two keyframes for this to retime the clip.

Speed - Values below 1 slow down the clip. Values above 1 speed upmovement. For example, to slow down the clip
by a factor of two (half speed), set this value to 0.5. Quarter speed would be 0.25. This parameter is only active if
Timing is set to Speed.

Frame - Use this to specify the source frame at the current frame in the timeline. For example, to slow down a 50
frame clip by half set the Source Frame to 1 at frame 1 and the Source Frame to 50 at frame 100. The default
expression will result in a half-speed retime. This parameter is active only if Timing is set to Source Frame.

Warp Mode - Select amethod to use to generate the retimed views.

• Simple - Thismodewarps and blends the images.

•Normal - Thismodewarps and blends the images where they are consistent.

•Occlusions - Thismodemay improve the results with largemotion vectors.

• Sharp Occlusions - Thismode is designed to reduce artefacts with a CG sourcewhere boundaries are distinct.

Example
In this example, we generatemotion vectors using O_VectorGenerator and feed them to O_Retimer in order to slow
down and then speed up a stereo sequence.

You can download the image used here fromourweb site. Formore information, please see Example Images on
page 8.
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Step by Step

Generating Motion Vectors
1. Start Nuke and open the project settings by pressing S on theNodeGraph. Go to theViews tab and click the

Set up views for stereo button.

2. Import dance_group.##.exr. This image already includes both the left and the right view and the necessary dis-
parity channels.

3. Add a Viewer to the image.

4. Select Ocula > Ocula 3.0 > O_Solver to insert an O_Solver node between the image and the Viewer.

In order to calculatemotion vectors, you always need an O_Solver node in the data stream, even if you have dis-
parity channels embedded in the input image likewe do here. If the disparity channels didn’t yet exist, you’d also
need an O_DisparityGenerator node.

5. Scrub to frame 1 on the timeline and click Add Key in theO_Solver controls.

O_Solver calculates the camera relationship between the two views.

6. Insert an O_VectorGenerator node after O_Solver.

The purpose of O_VectorGenerator is to calculate themotion vectors required later for retiming the sequence.
Becausewe have disparity vectors in the data stream, O_VectorGenerator can do this in a way that maintains the
alignment between views and avoids breaking the stereo effect.

7. In the Viewer, set the channel set menu tomotion.

The calculated forward and backwardmotion vectors are displayed in the Viewer.

11 RETIMER | EXAMPLE



103

8. Select Image >Write to insert aWrite node after O_VectorGenerator. In theWrite node controls, select all from
the channels pulldownmenu. Choose exr as the file type. Select a location for the clip in the file field and
enter dance_group_motion.##.exr as the name. Click Render.

The newly createdmotion vectors are saved in the channels of the clip.

9. Retime the sequence using themotion vectors as described below.

Retiming the Sequence
1. Import the dance_group_motion.##.exr clip you rendered in the previous step and connect a Viewer to it.

2. Play through the clip in the Viewer to get a sense of themotion.

3. Add an O_Retimer node after the clip.

By default, this node is set to perform a half speed slow down. However, what wewant to do is to speed the
sequence up.

4. Instead of changing the clip’s playback speed in terms of overall duration, we are going to describe the retiming
by identifying which source frame plays at which time. In order to do this, set Timing to Source Frame in the
O_Retimer controls.

Notice that the Speed field is grayed-out and the Frame field is activated. The default Frame setting is 1, which
sets the first frame on the timeline to frame 1 of the input image.

In order to retime a clip using Source Frame retiming, you need to set at least two keyframes.
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5. Click the animationmenu next to Frame and select Set key in order to set a keyframe at the first frame on the
timeline.

The Frame field turns blue to indicate a keyframe has been set.

6. Move the playhead to frame 8 and set the Frame value to 4. A keyframe is set automatically.

O_Retimer sets frame 8 on the timeline to frame 4 of the input image, effectively reducing the playback speed by
half leading up to frame 8.

7. Move the playhead to frame 15 and set the Frame value to 15.

O_Retimer sets frame 15 on the timeline to the last frame of the input clip, effectively returning the playback
speed to normal at frame 15.

8. Press Play in the Viewer to process and review the results.

Once the process has completed, you should be able to see the result of the retime. In reality, the length of the
clip is a little too short to see it clearly.

9. Return to the beginning of the clip and play through each framewith theNext Frame arrow in the Viewer. You
should notice that the Frame value changes over time - slowly up to frame 8 andmore quickly towards the final
frame.
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Description
Many Ocula plug-ins rely on disparity fields to produce their output. Usually, disparity fields are created using a com-
bination of theO_Solver (see Solver on page 19) and O_DisparityGenerator (see DisparityGenerator on page 32)
nodes.

However, if you have a CG scenewith stereo camera information and z-depthmap available, you can also use theO_
DepthToDisparity plug-in to generate the disparity field. Provided that the camera information and z-depthmap are
correct, this is both faster andmore accurate than using theO_Solver and O_DisparityGenerator nodes.

Generating a Disparity Field
Using one of the camera transforms and the corresponding depthmap, O_DepthToDisparity does a back projection
fromone view to find the position of each image point in 3D space. It then projects this point with the other camera
transform to find the position of the point in the other view. The difference between the two positions gives the dis-
parity in one direction.

As with theO_DisparityGenerator plug-in, the final disparity vectors are stored in disparity channels, so youmight
not see any image data appear when you first calculate the disparity field. To see the output insideNuke, select the
disparity channels from the channel set and channel controls in the top left corner of the Viewer. An example of
what a disparity channelmight look like is shown below.
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Once you have generated a disparity field that describes the relation between the views of a particular clip well, it will
be suitable for use inmost of theOcula plug-ins. We recommend that you insert aWrite node after O_DepthToDis-
parity to render the original images and the disparity channels as a stereo .exr file. This format allows for the storage
of an imagewithmultiple views and channel sets embedded in it. Later, whenever you use the same image sequence,
the disparity field will be loaded into Nuke together with the sequence and is readily available for theOcula plug-ins.
For information on how to generate a disparity field using O_DepthToDisparity and render it as an .exr file, see
Quick Start on page 107.

NOTE: To useO_DepthToDisparity, you do need the positions of the stereo camera rig for the two views.

Inputs
O_DepthToDisparity has got two inputs:

• Depth - This is a stereo pair of images (usually, a scene you’ve rendered from a 3D application). In the depth chan-
nel, there should be a z-depthmap for each view.

If this input is an .exr file, the z-depthmapmay already be embedded in the clip.

If you’re using another file format and have saved the depthmap as a separate image, you can use aNuke Shuffle
node (Channel > Shuffle) to get the z-depthmap in the depth channel of theDepth image. For information on
how to do this, see theNuke user guide.

• Camera - A Nuke stereo Camera node. This is the camera the scenewas rendered with. In most cases, you would
import this into Nuke from a third-party 3D application. For information on how to do this, see theNuke user
guide.

In Nuke, a stereo camera can be either:

• a single Camera node in which some or all of the controls are split, or

• two Camera nodes (one for each view) followed by a JoinViews node (Views > JoinViews). The JoinViews node com-
bines the two cameras into a single output.
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A single Camera nodewith split
controls.

Two cameras combined using
Nuke’s JoinViews node.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To generate a disparity field for a stereo clip, do the following:

1. Start Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set
up views for stereo button.

2. From the Toolbar, select Image > Read to load your stereo clip (usually, a rendered 3D scene) into Nuke. If you
don’t have both views in the same file, select Views > JoinViews to combine them, or use a variable in the Read
node’s file field to replace the name of the view (use the variable%V to replace an entire view name, such as left
or right, and%v to replace an initial letter, such as l or r). Formore information, refer to theNuke user guide.

Make sure the stereo clip contains a z-depthmap for each view in the depth channels. If this is not the case and
you have saved the depthmaps as separate images, you can use aNuke Shuffle node (Channel > Shuffle) to
shuffle them into the depth channels.

3. Select Ocula > Ocula 3.0 > O_DepthToDisparity to insert an O_DepthToDisparity node after either the stereo
clip or the JoinViews node (if you inserted one in the previous step).

4. Connect the camera that the scenewas rendered with to theCamera input of O_DepthToDisparity. It is import-
ant the camera information is correct for the scene.

5. Open theO_DepthToDisparity controls. From theViews to Usemenu or buttons, select which views you want
to use for the left and right eyewhen creating the disparity field.

6. Attach a Viewer to theO_DepthToDisparity node, and display one of the disparity channels in the Viewer.

O_DepthToDisparity calculates the disparity field and stores it in the disparity channels.

7. Select Image >Write to insert aWrite node after O_DepthToDisparity. In theWrite node controls, select all
from the channels pulldownmenu. Choose exr as the file type. Render the clip.

The newly created disparity channels will be saved in the channels of your stereo clip. When you need to manip-
ulate the same clip again later, the disparity vectors will be loaded into Nuke together with the clip.
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Rendering the output to combine the clip and the disparity
channels for future use.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to create the
disparity field. These viewswill bemapped for the left and right eye.

Example
This example shows you how to calculate a disparity field for a stereo pair of images using O_DepthToDisparity.

You can download the script used here fromourweb site. Formore information, please see Example Images on page
8.

Step by Step
1. Start Nuke and select File > Open to import the gherkin.nk script.

2. This script has the left and the right view set up in the Project Settings. In theNodeGraph, there is a stereo cam-
era node.

3. Select Image > Read to import gherkin.exr and attach a Viewer to the image.

The image is a render of a 3D scene. It already includes the left and the right view, and a depth channel for both
views.

4. Select Ocula > Ocula 3.0 > O_DepthToDisparity to insert an O_DepthToDisparity node between the Read
node and the Viewer. Make sure the Read node is connected to theDepth input of O_DepthToDisparity.

5. Connect the Camera node to theCamera input of O_DepthToDisparity. This node is the camera the 3D scene
was rendered with. Your node tree should now look something like the one shown below.
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6. Use the channelmenus in the top left corner of the Viewer to display one of the disparity channels.

O_DepthToDisparity calculates the disparity field and stores it in the disparity channels.

Youmay need to temporarily decrease the gain value in the Viewer to better be able to see detail in the disparity
channels.

Switch back to viewing the rgba channels.

7. To evaluate the quality of the disparity field, select Ocula > Ocula 3.0 > O_NewView to insert an O_NewView
node between O_DepthToDisparity and the Viewer. By default, this node uses the generated disparity field to
create a new view half way between the left and the right view. If the disparity field is not accurate, O_NewView
will produce poor results.

Using O_NewView to test the generated disparity field.

8. In theO_NewView controls, setWarp Mode to Sharp Occlusions. This gives the best results when the disparity
fields are generated fromCG depth.

Warp Mode set toNormal. Warp Mode set to Sharp
Occlusions.

As you can see, O_NewView has used the disparity field fromO_DepthToDisparity to produce a reasonably accur-
ate new view. However, there seems to be a thin "halo" around some object outlines. This is a result of anti-ali-
asing on object boundaries. Because anti-aliasingmixes the colours of the background and foreground, O_
NewView doesn't knowwhich is the correct colour to use in these regions, and the resultsmay need further edit-
ing.
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It is worth noting, however, that the results achieved with O_DepthToDisparity are usually better than those
achieved with O_Solver and O_DisparityGenerator. The difference is particularly clear when there are several
occluded areas in the images due to wide camera separation.
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13 DisparityToDepth

Description
TheO_DisparityToDepth plug-in produces a z-depthmap for each view of a stereo clip based on the clip’s disparity
field and stereo camera setup.

A z-depthmap is an image that uses the brightness of each pixel to specify the distance between the 3D scene point
and the virtual camera used to capture the scene. Youmay need a z-depthmap, for example, if you want to intro-
duce fog and depth-of-field effects into a shot. In Nuke, the ZBlur node (Filter > ZBlur) requires a depthmap in its
input.

O_DisparityToDepth stores the final z-depthmap in the depth channels, so youmight not see any image data appear
when you first calculate the depthmap. To see the output insideNuke, select the depth channels from the channel
controls in the top left corner of the Viewer. An example of what a depth channelmight look like is shown below.

An example depthmap.

Inputs
O_DisparityToDepth has two inputs:
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• Source - This is a stereo pair of images. There should be a disparity field in the disparity channels. For information
on how to embed a disparity field in an image this way, see DisparityGenerator on page 32.

• Camera - A pretracked Nuke stereo camera that describes the camera setup used to shoot the Source images. This
can be a camera you have tracked with the CameraTracker node or imported to Nuke from a third-party camera
tracking application.

In Nuke, a stereo camera can be either:

• a single Camera node in which some or all of the controls are split, or

• two Camera nodes (one for each view) followed by a JoinViews node (Views > JoinViews). The JoinViews node com-
bines the two cameras into a single output.

A single Camera nodewith split
controls.

Two cameras combined using
Nuke’s JoinViews node.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.

Quick Start
To generate a z-depthmap for a stereo clip, do the following:

1. If there are disparity vectors in the data stream from an earlier O_DisparityGenerator node, or if disparity vec-
tors exist in the image sequence itself, these are used when generating the z-depthmap. If disparity vectors
don’t yet exist in the script, however, you can use theO_Solver and O_DisparityGenerator plug-ins after your
image sequence to calculate the disparity vectors. SeeDisparityToDepth on page 111 and DisparityGenerator
on page 32 for how to do this.

2. Select Ocula > Ocula 3.0 > O_DisparityToDepth to insert an O_DisparityToDepth node after either theO_Dis-
parityGenerator node (if you added one in the previous step) or the image sequence.

3. Connect a pretracked Nuke stereo camera to theCamera input of O_DisparityToDepth.

4. Open theO_DisparityToDepth controls. From theViews to Usemenu or buttons, select which views you want
to use for the left and right eyewhen creating the z-depthmap.

5. Attach a Viewer to theO_DisparityToDepth node, and display one of the depth channels in the Viewer.

6. Select Image >Write to insert aWrite node after O_DisparityToDepth. In theWrite node controls, select all
from the channels pulldownmenu. Choose exr as the file type. Render the clip.
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The newly created depth channels will be saved in the channels of your stereo clip. When you need to manip-
ulate the same clip again later, the z-depthmapswill be loaded into Nuke together with the clip.

Rendering the output to combine the clip and the depth
channels for future use.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to use to generate
the z-depthmap. These viewswill bemapped for the left and right eye.

Example
In this example, we first generate a depthmap for a stereo pair of images using O_DisparityToDepth. Then, we blur
the image according to the depthmap.

Step by Step
1. Start Nuke and select File > Open to import the depth.nk script.

This script has the left and the right view set up in the Project Settings. In theNodeGraph, there is a stereo cam-
era node.

2. Select Image > Read to import SteepHill.exr and attach a Viewer to the image.

The image already includes both the left and the right view as well as the necessary disparity channels.

3. Select Ocula > Ocula 3.0 > O_DisparityToDepth to insert an O_DisparityToDepth node after the Read node.
Make sure the Read node is connected to theDisparity input of O_DisparityToDepth.

4. Connect the Camera node to theCamera input of O_DisparityToDepth. Your node tree should now look some-
thing like this.
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5. Use the channel controls in the top left corner of the Viewer to display one of the depth channels.

The depth channel for the left view.

6. As you can see, the depth channel looksmostly white. To better be able to evaluate the results, hold down Shift
and select Color >Math >Multiply to add aMultiply node in a new branch after O_DisparityToDepth. In the
Multiply controls, set channels to depth and value to 0.7.

Similarly, add a Gammanode (Color >Math > Gamma) after theMultiply node. In theGamma controls, set
channels to depth and value to 0.43.

Finally, select the Gammanode and press 2 to view its output.

Using theMultiply and Gammanodes to evaluate the depthmap.
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Make sure the Viewer’s channel controls are set to display one of the depth channels. It should look a lot like the
image below and allow you to better see the boundaries of the objects in the image.

7. To test the accuracy of the depth channels in practice, select Filter > ZBlur to add a ZBlur node between O_Dis-
parityToDepth and the Viewer. This node blurs the image according to the depth channels we’ve just created.

8. In the ZBlur controls, set:

• channels to rgba,

•math to far=0,

• focus plane (C) to 2,

• size to 8.

9. View the output. To better see the effect of the ZBlur node, select it in theNodeGraph and pressD repeatedly
to disable and enable it. As you can see, the areas further back in the scene receivemore blur than the areas
close to the camera.
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10. If you are happy with the depth channels, you can save them in the channels of the input clip for later use. Select
Image >Write to insert aWrite node between O_DisparityToDepth and ZBlur. In theWrite node controls, select
all from the channels pulldownmenu. Use the file control to give the file a location and a new name. Choose
exr as the file type and click Render to render the image.
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14 DisparityViewer

Description
TheO_DisparityViewer plug-in lets you visualise the disparity vectors in your node tree, display a histogramdetailing
positive and negative parallax, or overlay the Viewer with parallax violations.

NOTE: All threeO_DisparityViewermodes are baked into your render if the node is enabled when you
write your sequence out. This allows you to render the output alongside disparity for review.

You can add O_DisparityViewer after any node in theNodeGraph. As long as there is a disparity channel at that
point in the tree, O_DisparityViewer produces a Viewer overlay with arrows showing the disparity vectors at regular
intervals, a histogram, or parallax violations depending on theDisplay control.

You can choose to display the vectors either for the current view only or for both views,

Vectors for the current view. Vectors for both views.

A parallax histogram for both views,



118

Parallax histogram.

Or a parallax violation overlay for the current view.

Parallax violation overlay.

You can also change the colour of the vectors, histogram, or overlays. Thismay be useful if you wish to compare dis-
parity methods and havemore than oneO_DisparityViewer overlay displayed at once or if the background colour is
similar to one of the default colours.

Inputs
O_DisparityViewer has one input:

Source - This is any node in the node treewith a disparity field in the disparity channels.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B on page 147.
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Quick Start
You can choose to display:

• Disparity Vectors,

• Parallax Histograms, or

• Parallax Violation Overlays.

Disparity Vectors

To visualise the disparity vectors at any given point of your node tree, do the following:

1. Select a node at any point in the node treewhere there is a disparity channel.

If you don’t have a disparity channel in the data stream, you can add one using theO_Solver and O_Dis-
parityGenerator nodes. See Solver on page 19 and DisparityGenerator on page 32.

2. ChooseOcula > Ocula 3.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node in your node tree.

3. UnderViews to Use, select the views you want to use to visualise the disparity vectors. These views are
mapped for the left and right eye.

4. Using theDisplaymenu, select Disparity Vectors.

5. If you want to display the vectors for both views rather than just the current view, check Show Both
Directions.

Vectors for the current view. Vectors for both views.

6. Zoom in to better see the disparity vectors in the overlay.

7. If the Viewer seems too cluttered or the arrows overlap, increase theVector Spacing value.
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Vector Spacing set to 30. Vector Spacing set to 70.

8. If necessary, use thedisparityR and disparityL parameters to change the colour of the arrows. Youmay want
to do this, for example, if the default colour is very close to the colours in your input image, or if you want to
compare disparity methods and havemore than oneO_DisparityViewer overlay displayed at once.

NOTE: Disparity vectors are baked into your render if the node is enabled when you write your sequence
out.

Parallax Histograms

To view a parallax histogram for any given point of your node tree, do the following:

1. Select a node at any point in the node treewhere there is a disparity channel.

If you don’t have a disparity channel in the data stream, you can add one using theO_Solver and O_Dis-
parityGenerator nodes. See Solver on page 19 and DisparityGenerator on page 32.

2. ChooseOcula > Ocula 3.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node in your node tree.

3. UnderViews to Use, select the views you want to use to visualise as a histogram. These views aremapped for
the left and right eye.

4. Using theDisplay dropdownmenu, select Parallax Histogram.
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Parallax histogram.

The Viewer displays a histogram showing Parallax (in pixels) on the x axis, the number of image pixels on the y
axis, and the negative and positive parallax violation areas in red and green, respectively.

The screen is placed at zero on the x axis, so negative parallax refers to parts of the image that are in front of the
screen and positive parallax to the parts that are behind the screen.

5. Use theHistogram controls to define your histogram as necessary.

NOTE: Histograms are baked into your render if the node is enabled when you write your sequence out.

Parallax Violation Overlays

To view a parallax violation overlay for any given point of your node tree, do the following:

1. Select a node at any point in the node treewhere there is a disparity channel.

If you don’t have a disparity channel in the data stream, you can add one using theO_Solver and O_Dis-
parityGenerator nodes. See Solver on page 19 and DisparityGenerator on page 32.

2. ChooseOcula > Ocula 3.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node in your node tree.

3. UnderViews to Use, select the views you want to use to visualise parallax violation. These views aremapped
for the left and right eye.

4. Using theDisplay dropdownmenu, select Parallax Violation.
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Parallax violation overlay.

The parallax violation overlay appears in the Viewer, highlighting the areas of negative and positive parallax viol-
ation - that is, areas outside the limits specified in theNegative Violation and Positive Violation controls.

5. Use the Parallax controls to define your overlay parameters as necessary.

NOTE: Parallax violation overlays are baked into your render if the node is enabled when you write your
sequence out.

Controls
Views to Use - From the views that exist in your project settings, select the two views you want to usewhen visu-
alising the disparity vectors. These viewswill bemapped for the left and right eye.

Display - Select the display mode from the dropdownmenu:

• Disparity Vectors - overlays the disparity vectors for the current view.

• Parallax Histogram - displays a parallax by pixel histogram.

• Parallax Violation - overlays negative and positive parallax areas.

Vectors

disparityR - Colour of the arrows used for displaying left-to-right disparity. Youmay want to change this, for
example, if the colour of the arrows is very close to the colours in your input image, or if you want to compare the
vectors frommultiple O_DisparityViewers in the same Viewer.

disparityL - Colour of the arrows used for displaying right-to-left disparity. Youmay want to change this, for
example, if the colour of the arrows is very close to the colours in your input image, or if you want to compare the
vectors frommultiple O_DisparityViewers in the same Viewer.
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Show Both Directions - Check this to show the disparity vectors for both views rather than just the current view.

Vector Spacing - How often a disparity vector will be drawn. If necessary, you can increase this value to make the
display less cluttered. Youmay want to do so, for example, if the disparities are large and you don’t want neigh-
bouring vectors to overlap one another.

Histogram

Histogram Range - Use thismenu to select the histogram range:

• Automatic - the range is scaled to fit the range of disparity.

•User Defined - the range is defined using theHistogram Min andMax controls as a percentage of screen width.

Histogram Min/Max - Controls the lower and upper limits of the histogram as a percentage of screen width, that is,
the left-most and right-most points on the x axis.

NOTE: These controls are only activewhenHistogram Range is set toUserDefined.

Parallax

Negative Limit - Sets the amount of negative parallax allowed as a percentage of screen width. Areas outside this
negative limit aremarked by the overlay in the colour specified in theNegative Violation control.

Pixels - Displays the number of pixels allowed by negative parallax. After adjusting theNegative Limit, you can
use this corresponding value in theO_DisparityGenerator Parallax Limits > Negative control.

Positive Limit - Sets the amount of positive parallax allowed as a percentage of screen width. Areas outside this pos-
itive limit aremarked by the overlay in the colour specified in the Positive Violation control.

Pixels - Displays the number of pixels allowed by positive parallax. After adjusting the Positive Limit, you can use
this corresponding value in theO_DisparityGenerator Parallax Limits > Positive control.

Negative Violation - Sets the overlay colour for pixels outside the specifiedNegative Limit value.

Positive Violation - Sets the overlay colour for pixels outside the specified Positive Limit value.

Example
In this example, we useO_DisparityViewer to evaluate the disparity field produced by O_DisparityGenerator. For
information on where to get the sample footage, please see Example Images on page 8.
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Step by Step
1. Start Nuke and press S on theNodeGraph to open the ProjectSettings. Go to theViews tab and click the Set

up views for stereo button.

2. Select Image > Read and browse to where you saved the tutorial files. Go to theO_VerticalAligner directory,
select steep_hill.exr, and clickOpen.

A Read node appears in theNodeGraph.

3. Connect the Viewer to the Read node so we can seewhat’s happening.

4. Select the Read node and chooseOcula > Ocula 3.0 > O_Solver from the Toolbar.

This inserts an O_Solver node after the stereo image.

5. In theO_Solver controls, click Add Key to set a keyframe for O_Solver to analyse.

Our example here consists of just one frame, but if you were using a sequence, you should set keyframes
wherever the camera setup changes. If the setup doesn’t change, you can get away with using just one key-
frame. Remember that this should be a frame that is easy to match between views - ideally, a framewith enough
picture detail, but nomotion blur, occluding fog, or dust.

NOTE: Every time you add a keyframe, O_Solver analyses the footage and calculates the solve.

6. Select theO_Solver node and chooseOcula > Ocula 3.0 > O_DisparityGenerator from the Toolbar.

This inserts an O_DisparityGenerator node.

7. Select theO_DisparityGenerator node and chooseOcula > Ocula 3.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node and forces Ocula to calculate the disparity channel.

Your node tree should look similar to the image shown.

8. Using the default O_DisparityViewer settings, the Viewer is a little crowded. Tomake the display less cluttered,
set Vector Spacing to 80.

9. To display vectors for both views, check Show Both Directions in theO_DisparityViewer controls. The vectors
for the left-to-right disparity are shown in red, and the vectors for the right-to-left disparity in green.
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This sample footage does not produce good disparity vectors.

The purpose of this tutorial is to show you how to use the Parallax Histogram and Parallax Violation display
modes.

10. In theO_DisparityViewer controls, click on theDisplay dropdownmenu and select Parallax Histogram.

The Viewer displays a histogram showing Parallax (in pixels) on the x axis, the number of image pixels on the y
axis, and the negative and positive parallax violation areas in red and green, respectively.

NOTE: The screen is placed at zero on the x axis, so negative parallax refers to parts of the image that are
in front of the screen and positive parallax to the parts that are behind the screen.

HistogramRange defaults toUserDefined, so the graph producedmay not contain all the pixels in the image.

11. Click theHistogram Rangemenu and select Automatic.

The histogram is re-rendered to automatically fit the range of disparities in the image.
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As you can see in this extreme example, a large proportion of the image exceeds the positive violation threshold
(green) and none of the image exceeds the negative threshold (red).

12. In theO_DisparityViewer controls, click on theDisplaymenu and select ParallaxViolation.

The parallax violation shown in the histogram is overlaid on the Viewer highlighting, in this case, the areas of pos-
itive parallax violation.

13. If you adjust the Positive Limit slider down to 0.4 and up to 4.5, you can see the changing extent of the pos-
itive violation limit.

Low Positive Limit. High Positive Limit.

14. You can adjust theNegative Limit in the sameway, though in this case you’ll need to input a figure greater
than 0 to see any violation.
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15. Once you’ve set your Limits, you can read off the negative and positive Pixels values for Parallax Limits and
force apply them to the image by opening up theO_DisparityGenerator and enabling Enforceparallax limits.

See DisparityGenerator on page 32 formore information.
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Release Notes
This section describes the requirements, new features, improvements, fixed bugs, known bugs, and workarounds for
each release of Ocula.

Ocula 3.0v4
This release adds support for Nuke 8.0 and includes a bug fix.

Release Date

January 2014

MinimumSystemRequirements
• A version of Nuke 7.0 on:

• Windows XP Professional x64 Edition orWindows 7 HomePremium x64

• Mac OS X 10.6 “Snow Leopard”, 10.7 “Lion”, or 10.8 “Mountain Lion“

• Linux CentOS/RHEL 5 or CentOS/RHEL 6

• A version of Nuke 8.0 on:

• Windows 7 64-bit orWindows 8 64-bit

• Mac OS X 10.7 “Lion“, 10.8 “Mountain Lion“, or 10.9 “Mavericks“

NOTE: Nuke is expected to function correctly underMac OS X Mavericks (10.9), but we are seeing UI per-
formance degradation compared to previous OS X versions. We areworking on resolving these issues.

• Linux CentOS/RHEL 5 or CentOS/RHEL 6

• Foundry Licensing Tools (FLT 7.0v2 or later) for floating licenses.
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New Features
• Ocula is now supported on Nuke 8.0 for all platforms.

• The End User Licensing Agreement (EULA) that accompanies all The Foundry products has been amended. Please
see theUser Guide Appendices formore information.

Improvements

There are no improvements in this release.

Fixed Bugs

BUG ID 39980 - O_Retimer: SettingWarp Mode > Simple when rebuilding views in Ocula caused Nuke to crash if
the input had an expanded bounding box that forced the bottom left of the image away from (0,0).

Known Bugs andWorkarounds

BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.

Ocula 3.0v3
This release adds support for Nuke 7.0 and contains two improvements.

Release Date

December 2012

MinimumSystemRequirements
• A version of Nuke 6.3 or 7.0 on:

• Windows XP Professional x64 Edition orWindows 7 HomePremium x64

• Mac OS X 10.5 “Leopard” (Nuke 6.3 only), 10.6 “Snow Leopard”, or 10.7 “Lion” (Nuke 7.0 only), 64-bit

• Linux RHEL 5.4 for Intel64 or AMD64

• Foundry Licensing Tools (FLT 7.0v2 or later) for floating licenses.

New Features

There are no new features in this release.
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Improvements
• BUG ID 22779 - Output from all Ocula nodes is now cached to prevent recalculation, improving the usability of
Ocula node trees considerably.

• BUG ID 32272 - O_DisparityGenerator and O_VectorGenerator now have aNoise parameter. This sets the amount
of noise these nodes should ignore in the input footagewhen calculating their results. The higher the value, the
smoother the results. Youmay want to increase this value if you find that your disparity ormotion vector field is
noisy in low-contrast image regions.

Fixed Bugs
• BUG ID 24486 - O_DisparityGenerator: Connecting inputs with different bounding boxes caused Nuke to crash.

• BUG ID 26425 - Thedisparity channel was cropped to the bounding box even when rgba data existed outside the
bounds.

• BUG ID 29273 - O_DisparityViewer: Displaying the Parallax Histogram for images with a larger bounding box
than the format caused Nuke to crash.

• BUG ID 33006 - Ocula output was cropped when the bounding box was larger than the format.

• BUG ID 33022 - O_NewView: The view generated was incorrect when the inputs contained vertically offset bound-
ing boxes.

Known Bugs andWorkarounds

BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.

Ocula 3.0v2
This release changes the licensing systemused by Ocula.

Release Date

January 2012

Requirements
• a version of Nuke 6.3 on

• Windows XP 64-bit orWindows 7 64-bit

• Mac OS X 10.5 “Leopard” or 10.6 “Snow Leopard”, 64-bit

• Linux RHEL 5.4 64-bit
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• Foundry Licensing Tools (FLT) for floating licenses.

New Features

The licensing systemused by Ocula has changed. Ocula now uses RLM licensing instead of FLEXlm. Formore inform-
ation, see Licensing Ocula on page 12.

Improvements

There are no improvements to existing features in this release.

Fixed Bugs

There are no fixed bugs in this release.

Known Bugs andWorkarounds

BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.

Ocula 3.0v1
This is amajor new release of Ocula. The plug-ins have been rewritten to increase the stability and accuracy as well as
the ease of use in setting up and quality checking. This release also introduces four new plug-ins and one new gizmo.

Release Date

November 2011

Requirements
• a version of Nuke 6.3 on

• Windows XP 64-bit orWindows 7 64-bit

• Mac OS X 10.5 “Leopard” or 10.6 "Snow Leopard", 64-bit

• Linux RHEL 5.4 64-bit

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.
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New Features

Ocula 3.0 introduces four new plug-ins:

• O_OcclusionDetector

This plug-in outputs an occlusionmask for the left and right view to definewhere picture building with disparity is
incorrect.

The occlusionmask is required by O_ColourMatcher and the newO_FocusMatcher node to identify image regions
where local matching will fail. The occlusion layer can be edited to change how these plug-ins operate.

Formore information, seeOcclusionDetector on page 45.

• O_FocusMatcher

This is a new plug-in that lets you rebuild one view from the other to match focus. Matching is based on a com-
bination of image rebuilding and deblurring.

You can also use this node to sharpen out-of-focus images.

There is an optionalKernel input to define the shape of the aperture causing the image blur.

Formore information, see FocusMatcher on page 61.

• O_VectorGenerator

This plug-in calculates consistent left and right motion vectors for retiming. Themotion estimation algorithm is
based on the new disparity engine in O_DisparityGenerator and delivers vectors that maintain stereo alignment.

Formore information, see VectorGenerator on page 92.

• O_Retimer

This plug-in lets you speed up or slow down a stereo clip based on the left and right motion vectors calculated by
O_VectorGenerator. You can control the new timing of the clip using either the Speed or the Frame control. Both
controls are animatable.

Formore information, see Retimer on page 98.

• StereoReviewGizmo

This gizmo lets you compare left and right views in various ways. For example, you can use it for testing vertical
alignment and colourmatches ormeasuring parallax. You can also convert it to a group to copy and edit the intern-
als. The gizmo is undocumented, but there are tool tips for all the controls.

Improvements

Ocula 3.0 includes key improvements to the quality and accuracy of existing plug-ins:

• All Ocula nodes

• BUG ID 22303 - Ocula nodes now cache results to disk to prevent recalculations and to reducememory over-
head.

• O_Solver

• O_Solver has been rewritten to increase the accuracy and the ease of use.
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• The controls have been simplified.

• The node now uses a new, improved featurematching algorithm. This deliversmore accurate alignment data to
downstreamOcula nodes.

• The Feature Matches display option has been renamed to Keyframe Matches. As before, this shows
matches at keyframes only.

• There’s a new Preview Alignment display option that lets you preview the alignment of featurematches at
both keyframes and non-keyframes. This allows you to review howwell the interpolated solveworks and
whether additional keyframes are required. It also makes it simpler to delete badmatches and preview the
effect of usermatches.

• In the Preview Alignment mode, there’s a newMatch Offset control that allows you to set the offset (in
pixels) applied to the aligned featurematches. You can also interactively control the offset using the < and >
keys on the Viewer. Increase the offset to view thematches with large disparities and spot badmatches.
Decrease the offset to set the disparity of matches to zero to examine the vertical offset at each feature.
Increase and decrease the offset interactively to viewwhichmatches do not move horizontally and are bad
matches.

• There is now an Error Threshold control that lets you select matches with a vertical error greater than the
threshold whenDisplay is set to PreviewAlignment. This allows you to delete badmatches with large errors
at keyframes and recalculate the alignment.

• The influence of usermatches has been increased and can now be previewed directly in the PreviewAlign-
ment display.

• The right-click menu in the Viewer has been changed to provide access to theDisplay options and theMatch
Offset value. Shortcut keys have also been added.

Formore information, see Solver on page 19.

• O_DisparityGenerator

• O_DisparityGenerator has been rewritten to deliver cleaner andmore accurate disparity vectors. This leads to
improved results in picture building operations, such as O_ColourMatcher, O_NewView, and O_Inter-
axialShifter.

• The controls have been simplified.

• Disparity vectors now have a user-controlled weighting to match the alignment data from an upstreamO_
Solver.

• BUG ID 21787 & 22331 - Added new Parallax Limits withNegative and Positive controls. Negative sets
themaximumnegative parallax in pixels. Positive sets themaximumpositive parallax. There is also an
Enforce Disparity Limits control, which is off by default. Theworkflow is to review the disparities (you can
useO_DisparityViewer histograms). If there are some incorrect disparities that are too large, switch on Enforce
Disparity Limits and set the limits in terms of pixels.

• BUG ID 22430 - This node now has Fg and Ignoremask inputs. Use the foregroundmask to calculate vectors
for a specific foreground element and the ignoremask to exclude regions from the vector calculations.

Formore information, see DisparityGenerator on page 32.

• O_ColourMatcher
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• There’s a new 3D LUT algorithm to calculate local colour updates in occluded regions defined by the newO_
OcclusionDetector plug-in.

• There is a new Export 3D LUT button. When you useO_ColourMatcher in 3D LUTmode, this allows you to
output the colour correction to a .vf file that you can use in Nuke’s Vectorfield node.

• In the Local Matchingmode, there is a newOcclusion Compensate checkbox that allows you to correct the
colour in occluded regions using the valid colourmatch fromunoccluded pixels. You can use the Edge Occlu-
sions, Colour Sigma, and Region Size controls to define how this is done. Occlusion Compensate replaces
theHalo Correct option in Ocula 2.

• The Pre-blur Disparity control has been removed.

Formore information, see ColourMatcher on page 51.

• VerticalAligner

• If cameras are attached to O_Solver, the camera data is used per frame in theCamera Rotationmethod in O_
VerticalAligner. Previously, it was only taken from keyframes.

• O_VerticalAligner has a newWarp Modemenu. Local Alignment can be used to rebuild a per-pixel vertical
alignment to remove the vertical disparity calculated by an upstreamO_DisparityGenerator.

Formore information, see VerticalAligner on page 72.

• O_DisparityViewer

• BUG ID 21784 - Instead of displaying disparity information in a Viewer overlay, O_DisparityViewer now renders
it to the image.

• BUG ID 21786 - O_DisparityViewer has a newDisplay control, which you can set to showDisparity Vectors,
Parallax Histogram, or Parallax Violations. Parallax Histogram and Parallax Violations also have asso-
ciatedHistogram and Parallax controls. The limits and ranges are all defined as a percentage of screen width,
that is:

horizontal disparity (in pixels) * 100 / format width (in pixels).

Formore information, see DisparityViewer on page 117.

• Correlate

The option to Correlate with Ocula has been removed. Curves can be correlated fromone view to another using
Correlate points or Correlate average based on the improved disparity delivered by O_DisparityGenerator.

Fixed Bugs
• BUG ID 21147 - O_DisparityGenerator didn’t work with cropped images.

• BUG ID 21770 - O_Solver: The influence of usermatches has been increased.

Known Bugs andWorkarounds
• BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.
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Ocula 2.2v2
This release adds support for Nuke 6.3 and fixes four bugs.

Release Date

July 2011

Requirements
• a version of Nuke 6.2 or 6.3 on

• Windows XP 64-bit orWindows 7 64-bit

• Mac OS X 10.5 “Leopard” or 10.6 "Snow Leopard", 32-bit (Nuke 6.2 only) or 64-bit

• Linux CentOS 4.5 64-bit

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features

There are no new features in this release.

Improvements

There are no improvements to existing features in this release.

Fixed Bugs
• BUG ID 14883 - O_ColourMatcher crashed Nukewhen halo correct andmask alphawere used together.

• BUG ID 17707 - O_ColourMatcher didn’t work correctly when thereweremore than two views.

• BUG ID 19219 - Using amask input with O_InteraxialShifter or O_NewView crashed Nuke.

• BUG ID 19223 - Attempting to set Vector Spacing to zero in DisparityViewer crashed Nuke.

Known Bugs andWorkarounds

There are no known bugs in this release.
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Ocula 2.2v1
This release contains improvements to O_Solver and O_VerticalAligner.

Release Date

February 2011

Requirements
• a version of Nuke 6.1 or 6.2 on

• Windows XP SP2, XP64, or (Nuke 6.2 only) Windows 7

• Mac OS X 10.5 “Leopard” or 10.6 "Snow Leopard", 32- or 64-bit

• Linux CentOS 4.5, 32-bit (Nuke 6.1 only) or 64-bit

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features

There are no new features in this release.

Improvements
• O_Solver

• TheAnalysis Type control that let you choosewhether to Analyse Every Frame or Interpolate Key-
frames has been removed. Now, O_Solver always interpolates between keyframes and you need to add at
least one keyframe in order to use it.

• Feature detection has been changed so that onceO_Solver has automatically detected featurematches, they
are fixed and do not update in response to changes in the node tree. You can edit themmanually, however, or
click the new Re-analyse Frame button to forceO_Solver to recalculate the current frame. As before, the
automatically detected featurematches are also updated if you adjust any O_Solver controls that affect the
analysis.

• The featurematch display has been changed so that the features are shown in different colours for the dif-
ferent views: red for the left view, and green for the right view.

• O_VerticalAligner

• The following new filtering options have been added for allAlignment Methods other than Vertical Skew:
Impulse, Cubic, Keys, Simon, Rifman, Mitchell, Parzen, and Notch.

• In addition to the Transform Matrix, theOutput tab now includes a Four Corner Pin section. This rep-
resents the 2D corner pin that can be applied to the input image to create the same result as O_VerticalAligner.
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• After clickingAnalyse Sequence, you can now click Create Corner Pin to create a Nuke CornerPin2D node
that creates the same result as O_VerticalAligner. You can usemultiple O_VerticalAligner nodes to produce the
desired alignment, and then analyse on the final node to create a single corner pin that represents the con-
catenated transform. This works in all alignment methods except Vertical Skew (the default).

Fixed Bugs
• BUG ID 13725 - O_Solver node reset featurematching when anything changes upstream.

Theworkflow for O_Solver has changed. Featurematching and analysis is now performed when keyframes are
added. The featurematches are then fixed unless keyframes are deleted and re-inserted orRe-analyse Frame is
used.

• BUG ID 15308 - Deleted featurematches reappeared when new ones were added.

Known Bugs andWorkarounds

There are no known bugs in this release.

Ocula 2.1v2
This release fixes a bug that only affected Ocula on Nuke 6.1. There are no other changes, so if you are running Ocula
on Nuke 6.0 you should keep using Ocula 2.1v1.

Release Date

November 2010

Requirements
• a version of Nuke 6.1 on

• Windows XP SP2, XP64

• Mac OS X 10.5 “Leopard” and 10.6 "Snow Leopard" (32- or 64-bit)

• Linux CentOS 4.5 (32- and 64-bit)

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features

There are no new features in this release.
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Improvements

There are no improvements to existing features in this release.

Fixed Bugs

BUG ID 14534 - O_VerticalAligner crashed Nukewhen trying to analyse a sequence. This bug was introduced by an
NDK change in Nuke 6.1 and only affected Nuke 6.1v1 and above. The bug has now been fixed.

Known Bugs andWorkarounds

There are no known bugs in this release.

Ocula 2.1v1
This is amajor new release of Ocula with one new plug-in andmany improvements and bug fixes.

Release Date

October 2010

Requirements
• Nuke 6.0v7 or a version of Nuke 6.1 on

• Windows XP SP2, XP64

• Mac OS X 10.5 “Leopard” and 10.6 "Snow Leopard" (32- or 64-bit)

• Linux CentOS 4.5 (32- and 64-bit)

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features
• There is a newO_DisparityViewer plug-in, which lets you visualise the disparity vectors in your node tree. You can
add it after any node in theNodeGraph. As long as there is a disparity channel at that point in the tree, O_Dis-
parityViewer produces a Viewer overlay with arrows showing the disparity vectors at regular intervals. Formore
information, see DisparityViewer on page 117.

• Ocula now has aMacOS X 64-bit version.
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Improvements
• O_Solver

• You can now add your own featurematches to the automatically detected ones by right-clicking on the image
and selecting add feature. This allows you to get a good solvewhen there aren't many good automatically
detectedmatches. Formore information, see Solver on page 19.

• There is a new Luminance Correct control, under Features. Thismatches the luminance between the two
views before searching for featurematches. Where there are large differences in in luminance between the two
views, this can increase the number and quality of featurematches found.

• O_DisparityGenerator

• You can now sample overmultiple disparity field detail levels (different resolutions of the images). This can help
to reduce errors in the calculated disparity field. There are controls for the number of samples (Number of
Samples), theminimumdisparity field detail to go down to (Minimum Detail Level), and the sample spacing
(Sample Spacing).

• There is a new Image Alignmentmenuwith the following options:

Rectification - This is the default alignment method. The two images are resampled so that all matching pixels
are on the same horizontal scanline in the second image as they are in the first.

Vertical Alignment - The two images are aligned along the y axis using a skew, but not moved along the x
axis.

None - If the disparity between your stereo views is horizontal only (corresponding pixels lie on the same scan-
line in both images), you can select this option for faster processing. This is the same asHorizontal Shift
Only in previous versions of Ocula.

• TheOcclusionsmenu has been renamedDisparity Method. A thirdmethod,Unconstrained Motion, has
been added to themenu. This calculates the disparity using unconstrained local motion estimation.

• There is a newMedian Filter Size control. Increasing this value should reduce the noise on the disparity field.
This control is only available whenDisparity Method has been set toNormal Occlusions.

Formore information on the new controls, see Controls on page 37.

• O_ColourMatcher

• There is a new Pre-blur Disparity control, which allows you to blur the incoming disparity map before using it.
If the disparity map is imperfect, this can help to reduce artefacts in the colour correction.

• In the Block-basedMatchingMode, you can now calculate the colour correction formultiple block sizes and
then blend the results together. This can help to reduce errors andmake the resultsmore temporally con-
sistent. There are controls for the number of samples (Number of Samples), themaximumblock size to go
up to (Max Block Size), the sample spacing (Sample Spacing), and themethod of combining the samples
(Colour Correction Type).

• There is a new control,Halo Correct, aimed at reducing the halo effect you can get around high-contrast edges
in the Block-basedMatchingmode. Note that where occlusions occur this correction can introduce artefacts
around edges. Another new control,Occlusion Compensate, is designed to correct these and probably
needs to be tuned to your particular footage.

Formore information on the new controls, see Controls on page 55.
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• O_VerticalAligner

• If you have a pretracked Nuke stereo camera that describes the camera setup used to shoot the Source
images, you can now useO_VerticalAligner to analyse the sequence and output a vertically aligned camera pair.
This allows you to continue using pretracked cameras once your footage has been vertically aligned. This works
in all vertical alignment modes except Vertical Skew (which can't be represented by a camera transform).

OnceO_VerticalAligner has analysed the sequence, you can see the analysis data in a Transform Matrix on
theOutput tab of the node controls. This represents a 2D corner pin that can be applied to the input image to
create the same result as O_VerticalAligner. If necessary, you can take thematrix to a third-party application,
such as Baselight, and align the image or camera there. There is onematrix for each view in the source.

Fixed Bugs
• BUG ID 9188 - O_ColourMatcher: In block-basedmatchingmode, colour fringing sometimes occurred where there
were high-contrast regions in the input images. You can now reduce this by usingHalo Correct,Occlusion Com-
pensate, and the sampling controls.

• BUG ID 12485 - OnMacOS X 10.6 (Snow Leopard), matching versions of Ocula for different versions of Nukewere
being identified as the same package and overwrote one another.

This has always been the case for Ocula 2 (so the bug affectsmatching 5.1, 5.2 and 6.0 Ocula installs as well) but
was only a problemwhen the plug-ins were installed onMacOS X 10.6 (Snow Leopard).

Known Bugs andWorkarounds
• BUG ID 2349 - Add a standard plug-in path for Nuke plug-ins.

Nuke 6.1 and later versions pick up theOcula plug-ins automatically. If you’re using Ocula 2.1 on Nuke 6.0, how-
ever, you need to set your NUKE_PATH environment variable to:

On Windows:

• C:\Program Files\Common Files\Nuke\6.0\plugins\Ocula\2.0

• C:\Program Files (x86)\Common Files\Nuke\6.0\plugins\Ocula\2.0 (only if you’re using 32-bit Ocula on 64-bit Win-
dows)

On Mac OS X:

• /Library/Application Support/Nuke/6.0/plugins-32/Ocula/2.1

On Linux:

• /usr/local/Nuke/6.0/plugins-32/Ocula/2.1 (if you’re using 32-bit Ocula)

• /usr/local/Nuke/6.0/plugins/Ocula/2.1 (if you’re using 64-bit Ocula)

Ocula 2.0v2
This is amaintenance release of Ocula.
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Release Date

April 2010

Requirements
• Nuke 5.2v2 or higher on

• Windows XP SP2, XP64

• Mac OS X 10.5 “Leopard” and 10.6 "Snow Leopard" (32-bit and x86 only)

• Linux CentOS 4.5 (32- and 64-bit)

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features

There are no new features in this release.

Improvements

There are no improvements to existing features in this release.

Fixed Bugs
• BUG ID 8222 - Ocula didn't obey requests to force the use of interactive licenses in rendermode, that is, when
Nuke is run with "-xi".

• BUG ID 9122 - Disparity channel was corrupt showing vertical striping.

• BUG ID 9165 - Disparity maps could look different onWindows XP compared to other platforms.

• BUG ID 9170 - Disparity channel was corrupt on the first frame.

• BUG ID 9960 - Ocula licenses (ocula_nuke_i) were not returned until theNuke session was closed.

• BUG ID 10230 - O_Solver was very unstable.

• BUG ID 10565 - Therewas an intermittently inconsistent result fromO_Solver, related to viewer framing.

Known Bugs andWorkarounds
• BUG ID 2349 - Add a standard plug-in path for Nuke plug-ins.

Later releases of Nukewill pick up theOcula plug-ins automatically. In themeantime, you will need to set your
NUKE_PATH environment variable to (replace x.x with the version of Nuke you're using, for example 5.2 or 6.0):

• OnWindows: C:\Program Files\Common Files\Nuke\x.x\plugins\Ocula\2.0

• OnMacOS X: /Library/Application Support/Nuke/x.x/plugins/Ocula/2.0

• On Linux: /usr/local/Nuke/x.x/plugins/Ocula/2.0
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• BUG ID 9188 - O_ColourMatcher: In block-basedmatchingmode, colour fringing can occur where there are high-
contrast regions in the input images.

Ocula 2.0v1
This is amajor new release of Ocula withmany new features, improvements, and bug fixes.

Release Date

8 October 2009

Requirements
• Nuke 5.1v3 or higher on

• Windows XP SP2, XP64

• Mac OS X 10.5 “Leopard” (32-bit and x86 only)

• Linux CentOS 4.5 (32- and 64-bit)

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features

Ocula 2.0 includes three new plug-ins:

• O_Solver – Some of the functionality fromO_DisparityGenerator has been separated out into this plug-in, to allow
amore flexible workflow. O_Solver determines the geometrical relationship between a stereo pair of views by
detecting featurematches. If you havemore than one sequence that were filmed with the same camera rig, it is
only necessary to do this calculation on one of them; the sameO_Solver can then be reused for the other
sequences. It also offers the following advantages over the old DisparityGenerator:

• An Ignore input so you can tell it which regions to ignorewhen detecting features.

• The ability to calculate the camera relationship over a temporal window, for greater robustness.

• The ability to calculate the camera relationship at intervals and interpolate smoothly between them for better
temporal stability.

• A Camera input, allowing you to use pre-tracked cameras.

• Interactive editing of featurematches in the viewport.

• The features and camera relationship are stored asmetadata, so they can be saved and reused further down-
stream.

• O_DepthToDisparity – a new plug-in to generate a disparity field from a stereo pair of depthmaps plus a stereo
camera set-up. This is intended for usewith CG scenes.

• O_DisparityToDepth – a new plug-in to generate depthmaps from a disparity field, given the stereo camera set-up.
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There are also improvements to some of the existing plug-ins:

• O_DisparityGenerator:

• New, improved disparity generation algorithm.

• A Solver input to allow the camera solve from another sequence shot with the same rig to be reused.

• A foreground (Fg) input to delineate foreground regions frombackground. This helps to ensure that disparities
are constrained to remain within each delineated region.

• O_InteraxialShifter:

• A foreground (Fg) input to delineate foreground regions frombackground. This helps to ensure that disparities
are constrained to remain within each delineated region.

• O_NewView:

• A foreground (Fg) input to delineate foreground regions frombackground. This helps to ensure that disparities
are constrained to remain within each delineated region.

• O_VerticalAligner:

• A Solver input to allow featurematches to be reused.

• Support for transform concatenation formultiple O_VerticalAligner nodes (except when Alignment Method
is set to Vertical Skew).

• Four new alignment methods: Scale, Simple Shift, Scale Rotate, and Camera Rotation.

• O_ColourMatcher (formerly O_ColourMatch):

• AMask input to allow you to specify a region of interest for the colour transform.

• A new, block-basedmatchingmode for dealing with local colour differences.

NOTE: O_InterocularShifter has been renamed to O_InteraxialShifter to remove ambiguity.

Improvements

Ocula 2.0 has been redesigned to allow amore flexible workflow. For details of the improvements to individual plug-
ins, see theNew Features section above. It also features a completely new disparity generation algorithm for greater
accuracy and speed.

Bug Fixes

BUG ID 7387 - O_ColourMatch: super black material (negative) was wrapped / clipped back from 1.0.

Known Bugs andWorkarounds
• BUG ID 2349 - Add a standard plug-in path for Nuke plug-ins.

Later releases of Nukewill pick up theOcula plug-ins automatically. In themeantime, you will need to set your
NUKE_PATH environment variable to (replace 5.x with 5.1 or 5.2 according to the version of Nuke you're using):

• OnWindows: C:\Program Files\Common Files\Nuke\5.x\plugins\Ocula\2.0
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• OnMacOS X: /Library/Application Support/Nuke/5.x/plugins/Ocula/2.0

• On Linux: /usr/local/Nuke/5.x/plugins/Ocula/2.0

• BUG ID 8222 (Ocula) and BUG ID 8229 (Nuke) - Ocula doesn't obey requests to force the use of interactive licenses
in rendermode, i.e., when Nuke is run with "-xi". Instead, it will always request a render license in thismode. This is
becauseOcula 2.0 uses theNukeNDK and there is currently no way for NDK plug-ins to tell the difference between
this and the normal rendermode. When amechanism is provided in a later Nuke release, wewill update theOcula
licensing to fix the problem.

Ocula 1.0v2
This is amaintenance release of Ocula.

Release Date

November 2008

Requirements
• Nuke 5.1 onWindows, Mac OS X, or Linux.

• Foundry FLEXlm Tools (FFT 4.0v1 or later) for floating licenses.

New Features

There are no new features in this release.

Improvements

There are no improvements in this release.

Bug Fixes

Fixed instability in plug-ins caused by OS incompatibility with FLEXlm 10.8 licensingmodule. Upgraded FLEXlm to
10.8.6 for improvedMacOS X 10.5 (Leopard) compatibility, and to 10.8.7 for improved 64-bit Linux compatibility.

Known Bugs andWorkarounds
• BUG ID 5482 - Progress bar does not indicatewhat is being processed further up a treewhen "Correlate using dis-
parity" or "Correlate with Ocula" options are used. This will be fixed in a subsequent Nuke release.
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• BUG ID 5904 - There is no progress bar when "Correlate with Ocula" option is used. This will be fixed in a sub-
sequent Nuke release.

• BUG ID 5979 - Running out of memory with complicated stereo scripts on 32-bit Windows. This will be fixed in a
subsequent Nuke release.

• BUG ID 6075- Slow processing when "Correlate with Ocula" option is used if source image is an EXR. This will be
fixed in a subsequent Nuke release.

• BUG ID 6428 - ReConverge node: "UseOcula if available" option causes a crash when reloading a script. This will be
fixed in Nuke 5.1v3.

Ocula 1.0v1
This is the first release of Ocula 1.0 for Nuke.

Release Date

October 2008

Requirements
• Nuke 5.1 onWindows, Mac OS X, or Linux.

• Foundry FLEXlm Tools (FFT 4.0v1 or later) for floating licenses.

New Features

In this release, there are five plug-ins and a collection of tools that add extra functionality to existing Nuke features.

Improvements

This section will describe improvements to existing features in later versions.

Bug Fixes

This section will describe fixed bugs in later versions.

Known Bugs andWorkarounds
• BUG ID 5482 - Progress bar does not indicatewhat is being processed further up a treewhen "Correlate using dis-
parity" or "Correlate with Ocula" options are used. This will be fixed in a subsequent Nuke release.
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• BUG ID 5904 - There is no progress bar when "Correlate with Ocula" option is used. This will be fixed in a sub-
sequent Nuke release.

• BUG ID 5979 - Running out of memory with complicated stereo scripts on 32-bit Windows. This will be fixed in a
subsequent Nuke release.

• BUG ID 6075- Slow processing when "Correlate with Ocula" option is used if source image is an EXR. This will be
fixed in a subsequent Nuke release.

• BUG ID 6428 - ReConverge node: "UseOcula if available" option causes a crash when reloading a script. This will be
fixed in Nuke 5.1v3.
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Appendix B

Node Dependencies
This appendix lists the data each Ocula node requires in its inputs (in addition to a stereo pair of images).

Node Settings Required input data

O_
Solv-
er

O_Dis-
parityGenerator
or precalculated
disparity chan-
nels

O_Occlu-
sionDetector or
precalculated
occlusion mask
channels

O_Vect-
orGenerator
or pre-
calculated
motion vector
channels

Depth
chan-
nels

Stereo
cam-
era

O_Solver any

O_Dis-
parity-
Gen-
erator

any

O_Occlu-
sion-
Detector

any
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Node Settings Required input data

O_
Solv-
er

O_Dis-
parityGenerator
or precalculated
disparity chan-
nels

O_Occlu-
sionDetector or
precalculated
occlusion mask
channels

O_Vect-
orGenerator
or pre-
calculated
motion vector
channels

Depth
chan-
nels

Stereo
cam-
era

O_Colour-
Matcher

Mode: Basic

Mode: 3D
LUT

Mode: Local
Matching &

Occlusion
Com-
pensate:
enabled

Mode: Local
Matching &

Occlusion
Com-
pensate: dis-
abled

O_Focus-
Matcher

Primary
Method:
Rebuild

Primary
Method:
Deblur
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Node Settings Required input data

O_
Solv-
er

O_Dis-
parityGenerator
or precalculated
disparity chan-
nels

O_Occlu-
sionDetector or
precalculated
occlusion mask
channels

O_Vect-
orGenerator
or pre-
calculated
motion vector
channels

Depth
chan-
nels

Stereo
cam-
era

O_Ver-
tical-
Aligner

WarpMode:
Global Align-
ment

WarpMode:
Local Align-
ment

O_
NewView

any

O_Inter-
axial-
Shifter

any

O_Vector-
Gen-
erator

any

O_
Retimer

any

O_Depth-
ToDis-
parity

any

O_Dis-
parity-
ToDepth

any

O_Dis-
parity-
Viewer

any
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Appendix C

Third Party Licences
This appendix lists third party libraries used in Ocula, along with their licences.

Library Description Licence

Boost Source code func-
tion / template lib-
rary

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization
obtaining a copy of the software and accompanying documentation covered
by this license (the “Software”) to use, reproduce, display, distribute, execute,
and transmit the Software, and to prepare derivative works of the Software,
and to permit third-parties to whom the Software is furnished to do so, all
subject to the following:

The copyright notices in the Software and this entire statement, including the
above license grant, this restriction and the following disclaimer, must be
included in all copies of the Software, in whole or in part, and all derivative
works of the Software, unless such copies or derivative works are solely in the
form of machine-executable object code generated by a source language pro-
cessor.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUTWARRANTYOF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUTNOT LIMITED TO THEWARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND
NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHTHOLDERSOR
ANYONEDISTRIBUTING THE SOFTWARE BE LIABLE FOR ANYDAMAGESOR
OTHER LIABILITY, WHETHER IN CONTRACT, TORTOROTHERWISE, ARISING
FROM, OUTOF OR IN CONNECTIONWITH THE SOFTWAREOR THEUSEOR
OTHER DEALINGS IN THE SOFTWARE.
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Library Description Licence

Expat XML parser Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd and
Clark Cooper

Copyright © 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal
in the Softwarewithout restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUTWARRANTYOF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUTNOT LIMITED TO THEWARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORSOR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGESOROTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORTOROTHERWISE, ARISING
FROM, OUTOF OR IN CONNECTIONWITH THE SOFTWAREOR THEUSEOR
OTHER DEALINGS IN THE SOFTWARE.

FreeType Font support Portions of this software are copyright © 2008 The FreeType Project

(www.freetype.org). All rights reserved.
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Library Description Licence

FTGL OpenGL support FTGL - OpenGL font library

Copyright © 2001-2004 Henry Maddocks ftgl@opengl.geek.nz

Copyright © 2008 SamHocevar sam@zoy.org

Copyright © 2008 SeanMorrison learner@brlcad.org

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal
in the Softwarewithout restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUTWARRANTYOF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUTNOT LIMITED TO THEWARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORSOR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGESOROTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORTOROTHERWISE, ARISING
FROM, OUTOF OR IN CONNECTIONWITH THE SOFTWAREOR THEUSEOR
OTHER DEALINGS IN THE SOFTWARE.
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Library Description Licence

VXL Computer vision Copyright © 2000-2003 TargetJr Consortium

GE Corporate Research and Development (GE CRD)

1 Research Circle

Niskayuna, NY 12309

All Rights Reserved

Reproduction rights limited as described below.

Permission to use, copy, modify, distribute, and sell this software and its doc-
umentation for any purpose is hereby granted without fee, provided that (i)
the above copyright notice and this permission notice appear in all copies of
the software and related documentation, (ii) the name TargetJr Consortium
(represented by GE CRD), may not be used in any advertising or publicity relat-
ing to the softwarewithout the specific, prior written permission of GE CRD,
and (iii) any modifications are clearly marked and summarized in a change his-
tory log.

THE SOFTWARE IS PROVIDED “AS IS” AND WITHOUTWARRANTYOF ANY
KIND, EXPRESS, IMPLIED OROTHERWISE, INCLUDING WITHOUT
LIMITATION, ANYWARRANTYOF MERCHANTABILITYOR FITNESS FOR A
PARTICULAR PURPOSE. IN NO EVENT SHALL THE TARGETJR CONSORTIUM BE
LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECTOR CONSEQUENTIAL
DAMAGESOF ANY KIND OR ANYDAMAGESWHATSOEVER RESULTING FROM
LOSSOF USE, DATAOR PROFITS, WHETHERORNOT ADVISED OF THE
POSSIBILITYOF SUCH DAMAGES, ORON ANY THEORYOF LIABILITY ARISING
OUTOF OR IN CONNECTIONWITH THEUSEOR PERFORMANCEOF THIS
SOFTWARE.
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Appendix D

End User License Agreement (EULA)
PLEASE READ THIS EULA CAREFULLY BEFOREORDERING ORDOWNLOADING ANY SOFTWARE FROM THISWEBSITE.
YOUR ATTENTION IS PARTICULARLYDRAWN TOCLAUSES 12 AND 13 WHEREWE LIMIT OUR LIABILITY TOUSERSOF
OUR SOFTWARE PRODUCTS.

IMPORTANTNOTICE TO ALL USERS: BYDOWNLOADING THIS SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS EULA, UNDERSTAND IT AND AGREE TOBE BOUND BY ITS TERMS AND CONDITIONS. IF YOU DONOT
AGREE TO THE TERMSOF THIS EULADONOTDOWNLOAD, INSTALL, COPYOR USE THE SOFTWARE.

IMPORTANTNOTICE TO CONSUMERS: YOU HAVE THE RIGHT TOWITHDRAW FROM YOUR TRANSACTIONWITHOUT
CHARGE AND WITHOUT REASON AT ANY TIME BEFOREDOWNLOADING OUR PRODUCT(S). HOWEVER YOU WILL
LOSE THIS RIGHTONCE YOU BEGIN TODOWNLOAD OUR PRODUCT(S). THIS DOES NOT AFFECT YOUR CONSUMER
RIGHTS IN RELATION TODEFECTIVE PRODUCTSOR SERVICES.

This END USER LICENSE AGREEMENT (this "EULA") is incorporated into the agreement between The Foundry Vision-
mongers Limited, a company registered in England andWales, ("The Foundry"), and you, as either an individual or a
single company or other legal entity ("Licensee") on the terms of which you will purchase the products and services
of The Foundry (the “Agreement”).

1. GRANT OF LICENSE

1.1 Subject to the limitations of clause 3 and all the other terms of the Agreement, The Foundry grants to Licensee a
limited, non-transferable (subject to clause 2.1 (b) below) and non-exclusive license to download, install and use only
(subject to clauses 1.2 and 2.1 (c) below and unless otherwise agreed in writing) in the country in which Licensee is
based at the date of purchase (the “HomeCountry”), amachine readable, object code version (subject to clause 4
below) of the software program identified in the Agreement (the "Software") and accompanying user guide and
other documentation (the "Documentation"), solely for Licensee's own internal purposes (the "License"); provided,
however, Licensee's right to download, install and use the Software and theDocumentation is limited to those rights
expressly set out in this EULA.

1.2 Licenseemay use the Software outside theHomeCountry if traveling or working outside theHomeCountry on a
temporary basis provided that such use does not exceed 70 days in aggregate in any rolling twelvemonth period or,
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in the case of a Licenseewho has purchased a fixed term license for less than twelvemonths, does not exceed the
number of days representing 20% of the term of the license.

1.3 Only to the extent that is proportionate to, and reasonably necessary to support, Licensee’s licensed use of the
Software in accordancewith the Agreement, Licenseemay (provided valid license keys have been obtained) install
the Software onmore than one computer, provided always that Licensee’s concurrent use of different installations
of the Software does not exceed the number of valid Licenses that Licensee has paid for.

2. LICENSE MODELS

2.1 For each product purchased, the License shall be one of the following types of license, and is subject to the fol-
lowing. Please note that some licensingmodels do not apply to certain products. Whichever licensingmodel applies,
Licensee shall not at any one time usemore copies of the Software than the total number of valid licenses purchased
by Licensee.

(a) “Node Locked License”

If Licensee purchases a Node Locked License, Licensee shall install and use only a single copy of the Software on only
one computer at a time, whichmay be located anywhere in theHomeCountry.

(b) “Individual License”

If Licensee purchases an Individual License, Licenseewarrants and represents that Licensee is a natural person and
that only Licensee shall use the Software. Licenseemay assign the Individual License to another natural person
(“Assignee”); subject to Licensee (i) notifying The Foundry and obtaining its express written consent, (ii) paying an
administrative feewith respect to such transfer, and (iii) after transferring a single copy of the Software to the
Assignee, deleting any copies of the Software that Licenseemay have in Licensee’s possession, custody or power. An
Individual License entitles Licensee to use the Software on only one computer at a time, whichmay be located any-
where in theHomeCountry.

(c) “Floating License”

If Licensee purchases a Floating License, use of the Softwaremay be at any site in theHomeCountry.

2.2 Some of the Softwaremay bemade available at concessionary rates as follows:

(a) “Educational License”

If Licensee has purchased the Software on the discount terms offered by The Foundry’s Educational Policy published
on its website (the “Educational Policy”), Licenseewarrants and represents to The Foundry as a condition of the
Agreement that: (i) (if Licensee is a natural person) he or she is a part-time or full-time student at the time of pur-
chase and will not use the Software for any commercial, professional or for-profit purposes; (ii) (if the Licensee is not
a natural person) it is an organization that will use the Software only for the purpose of training and instruction, and
for no other purpose, and (iii) Licenseewill at all times comply with the Educational Policy (as such policy may be
amended from time to time). Unless the Educational License is a Floating License, Licensee shall use the Software on
only one computer at a time, whichmay be located anywhere in theHomeCountry.
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(b) “Personal Learning Edition License”

If the Software is a Personal Learning Edition (“PLE”), it will not require a license key to be issued to Licensee and will
have limited functionality as described in theDocumentation. Licenseemay use it only for the purpose of personal
or internal training and instruction, and for no other purpose. PLE versions of the Softwaremay not be used for com-
mercial, professional or for-profit purposes including, for the avoidance of doubt, the purpose of providing training
or instruction to third parties. Licensee shall use the Software on only one computer at a time, whichmay be located
anywhere in theHomeCountry.

(c) “Modo Steam”

A version of Modo with limited functionality as described in theDocumentation is available to purchase on discount
terms through Valve Corporation’s STEAM store. If Licensee has purchased such version, Licenseewarrants and rep-
resents to The Foundry as a condition of the Agreement that: (i) Licensee is a natural person; and (ii) Licenseewill use
the Software strictly through Steam and only for personal, recreational and non-commercial use, except only that if
Licensee uses the Software to create assets and content Licenseemay sell such assets and content through Valve’s
SteamWorkshop.

(d) “Trial License”

Licenseemay register for a “Trial License” of the Software (not available for all products or in all regions ormarkets).
A Trial License lasts a limited specified period on the expiry of which the Softwarewill automatically cease to func-
tion. Licensee shall use the Software on only one computer at a time, whichmay be located anywhere in theHome
Country.

2.3 If Licensee has purchased a License that permits “non-interactive” use of the Software (“Headless Rendering”),
Licensee is authorized to use a non-interactive version of the Software for rendering purposes only (i.e. without a
user, in a non-interactive capacity) and shall not use such Software on workstations or otherwise in a user-interactive
capacity. Headless Rendering is not available on all products. In all cases except Modo (in respect of which there is no
limit on the amount of Headless Rendering allowed), Headless Rendering licenses are limited to one computer such
that the number of computers on which Headless Rendering can be carried out is limited to the number of valid
Licenses that have been purchased.

3. RESTRICTIONS ON USE

Please note that in order to guard against unlicensed use of the Software a license key is required to access and
enable the Software (other than Softwarewhich is licensed under the Personal Learning Editionmodel – see clause
2.2 (b) above). Licensee is authorized to use the Software inmachine readable, object code form only (subject to
clause 4), and Licensee shall not: (a) assign, sublicense, sell, distribute, transfer, pledge, lease, rent, lend, share or
export the Software, the Documentation or Licensee's rights under this EULA; (b) alter or circumvent the license keys
or other copy protectionmechanisms in the Software or reverse engineer, decompile, disassemble or otherwise
attempt to discover the source code of the Software; (c) (subject to clause 4) modify, adapt, translate or create deriv-
ativeworks based on the Software or Documentation; (d) use, or allow the use of, the Software or Documentation
on any project other than a project produced by Licensee (an "Authorized Project") or to provide a service (whether
or not any charge ismade) to any third party; (e) allow or permit anyone (other than Licensee and Licensee's
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authorized employees to the extent they areworking on an Authorized Project) to use or have access to the Soft-
ware or Documentation; (f) copy or install the Software or Documentation other than as expressly provided for in
this EULA; or (g) take any action, or fail to take action, that could adversely affect the trademarks, servicemarks, pat-
ents, trade secrets, copyrights or other intellectual property rights of The Foundry or any third party with intellectual
property rights in the Software (each, a "Third Party Licensor"). For purposes of this clause 3, the term "Software"
shall include any derivatives of the Software.

If the Software ismoved fromone computer to another, the issuing of replacement or substituted license keys is sub-
ject to and strictly in accordancewith The Foundry’s License Transfer Policy, which is available on The Foundry’s web-
site and which requires a fee to be paid in certain circumstances. The Foundry may from time to time and at its sole
discretion vary the terms and conditions of the License Transfer Policy.

4. SOURCE CODE

Notwithstanding that clause 1 defines “Software” as an object code version and that clause 3 provides that Licensee
may use the Software in object code form only:

4.1 if The Foundry has agreed to license to Licensee (including by way of providing SDKs, upgrades, updates or
enhancements/customization) source code or elements of the source code of the Software, the intellectual property
rights in which belong either to The Foundry or to a Third Party Licensor (“Source Code”), Licensee shall be licensed to
use the Source Code as Software on the terms of this EULA and: (a) notwithstanding clause 3 (c) Licenseemay use
the Source Code at its own risk in any reasonable way for the limited purpose of enhancing its use of the Software
solely for its own internal business purposes and in all respects in accordancewith this EULA; (b) Licensee shall in
respect of the Source Code comply strictly with all other restrictions applying to its use of the Software under this
EULA as well as any other restriction or instruction that is communicated to it by The Foundry at any time during the
Agreement (whether imposed or requested by The Foundry or by any Third Party Licensor);

4.2 to the extent that the Software links to any open source software libraries (“OSS Libraries”) that are provided to
Licenseewith the Software, nothing in the Agreement shall affect Licensee’s rights under the licenses on which the rel-
evant Third Party Licensor has licensed theOSS Libraries, as stated in theDocumentation. To the extent that Third
Party Licensors have licensed OSS Libraries on the terms of v2.1 of the Lesser General Public License issued by the
Free Software Foundation (see http://www.gnu.org/licenses/lgpl-2.1.html) (the “LGPL”), thoseOSS Libraries are
licensed to Licensee on the terms of the LGPL and are referred to in this clause 4.2 as the LGPL Libraries. The
Foundry will at any time during the three year period starting on the date of the Agreement, at the request of
Licensee and subject to Licensee paying to The Foundry a charge that does not exceed The Foundry’s costs of doing
so, provide Licenseewith the source code of the LGPL Libraries (the “LGPL Source”) in order that Licenseemay
modify the LGPL Libraries in accordancewith the LGPL, together with certain object code of the Software necessary
to enable Licensee to re-link any modified LGPL Library to the Software (he “Object”); and

4.3 notwithstanding any other term of the Agreement The Foundry gives no express or implied warranty, under-
taking or indemnity whatsoever in respect of the Source Code, theOSS Libraries (including the LGPL Libraries), the
LGPL Source or theObject, all of which are licensed on an “as is” basis, or in respect of any modification of the Source
Code, theOSS Libraries (including the LGPL Libraries) or the LGPL Sourcemade by Licensee (“Modification”).
Licenseemay not use theObject for any purpose other than its use of the Software in accordancewith this EULA.
Notwithstanding any other term of the Agreement, The Foundry shall have no obligation to provide support,

APPENDIX D |



158

maintenance, upgrades or updates of or in respect of any of the Source Code, theOSS Libraries (including the LGPL
Libraries), the LGPL Source, theObject or any Modification. Licensee shall indemnify The Foundry against all liabilities
and expenses (including reasonable legal costs) incurred by The Foundry in relation to any claim asserting that any
Modification infringes the intellectual property rights of any third party.

5. BACK-UP COPY

Licenseemay store one copy of the Software and Documentation off-line and off-site in a secured location within
theHomeCountry that is owned or leased by Licensee in order to provide a back-up in the event of destruction by
fire, flood, acts of war, acts of nature, vandalism or other incident. In no event may Licensee use the back-up copy of
the Software or Documentation to circumvent the usage or other limitations set forth in this EULA.

6. OWNERSHIP

Licensee acknowledges that the Software (including, for the avoidance of doubt, any Source Code that is licensed to
Licensee) and Documentation and all related intellectual property rights and other proprietary rights are and shall
remain the sole property of The Foundry and the Third Party Licensors. Licensee shall not remove, or allow the
removal of, any copyright or other proprietary rights notice included in and on the Software or Documentation or
take any other action that could adversely affect the property rights of The Foundry or any Third Party Licensor. To
the extent that Licensee is authorized to make copies of the Software or Documentation under this EULA, Licensee
shall reproduce in and on all such copies any copyright and/or other proprietary rights notices provided in and on
thematerials supplied by The Foundry hereunder. Nothing in the Agreement shall be deemed to give Licensee any
rights in the trademarks, servicemarks, patents, trade secrets, confidential information, copyrights or other intel-
lectual property rights of The Foundry or any Third Party Licensor, and Licensee shall be strictly prohibited from
using the name, trademarks or servicemarks of The Foundry or any Third Party Licensor in Licensee's promotion or
publicity without The Foundry's express written approval.

Subject to clause 4.3, The Foundry undertakes (the “Undertaking”) to defend Licensee or at The Foundry’s option
settle any claim brought against Licensee alleging that Licensee’s possession or use of the Software or Docu-
mentation in accordancewith the Agreement infringes the intellectual property rights of a third party in the same
country as Licensee (“Claim”) and shall reimburse all reasonable losses, damages, costs (including reasonable legal
fees) and expenses incurred by or awarded against Licensee in connection with any such Claim, provided that the
undertaking shall not apply where the Claim in question is attributable to possession or use of the Software or Docu-
mentation other than in accordancewith the Agreement, or in combination with any hardware, software or service
not supplied or specified by The Foundry. TheUndertaking is conditional on Licensee giving written notice of the
Claim to The Foundry as soon as reasonably possible, cooperating in the defence of the Claim and not making any
admission of liability or taking any step prejudicial to the defence of the Claim. If any Claim ismade, or in The
Foundry's reasonable opinion is likely to bemade, against Licensee, The Foundry may at its sole option and expense
(a) procure for Licensee the right to continue using the Software, (b) modify the Software so that it ceases to be
infringing, (c) replace the Softwarewith non-infringing software, or (d) terminate the Agreement immediately by
notice in writing to Licensee and refund the License Fee (less a reasonable sum in respect of Licensee's use of the
Software to the date of termination) on return of the Software and all copies. TheUndertaking constitutes Licensee's
exclusive remedy and The Foundry's only liability in respect of Claims.
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7. LICENSE FEE

Licensee acknowledges that the rights granted to Licensee under this EULA are conditional on Licensee's payment in
full of the license fee payable in connection with the Agreement (the "License Fee").

8. UPGRADES/ENHANCEMENTS

Licensee's access to support, upgrades and updates is subject to the terms and conditions of the "Annual Upgrade
and Support Programme” (for which a separate charge ismade) available on The Foundry's website. The Foundry
may from time to time and at its sole discretion vary the terms and conditions of the Annual Upgrade and Support
Programme.

9. TAXES AND DUTIES

Licensee agrees to pay, and indemnify The Foundry from claims for, any local, state or national tax (exclusive of taxes
based on net income), duty, tariff or other impost related to or arising from the transaction contemplated by the
Agreement.

10. LIMITED WARRANTY

10.1 Subject to clause 10.3, The Foundry warrants that, for a period of ninety (90) days after Licensee first down-
loads the Software (“Warranty Period”): (a) that the Softwarewill, when properly used on an operating system for
which it was designed, perform substantially in accordancewith the functions described in theDocumentation; and
(b) that the Documentation correctly describe the operation of the Software in all material respects. If, within the
Warranty Period, Licensee notifies The Foundry in writing of any defect or fault in the Software as a result of which it
fails to perform substantially in accordancewith theDocumentation, The Foundry will, at its sole option, either repair
or replace the Software, provided that Licenseemakes available all the information that may be necessary to
identify, recreate and remedy the defect or fault. This warranty will not apply to any defect or fault caused by unau-
thorised use of or any amendment made to the Software by any person other than The Foundry. If Licensee is a con-
sumer, thewarranty given in this clause is in addition to Licensee’s legal rights in relation to any Software or
Documentation that is faulty or not as described.

10.2 The Foundry does not warrant that the Software or Documentation will meet Licensee's requirements or that
Licensee's use of the Softwarewill be uninterrupted or error free.

10.3 If Licensee purchases a license of the Software that is of a fixed termduration, theWarranty Period in clause
10.1 shall apply only to Licensee’s first purchase of such license and not to any subsequent renewal(s) even if a
renewal involves another download.

11. INDEMNIFICATION

Licensee agrees to indemnify, hold harmless and defend The Foundry, the Third Party Licensors and The Foundry's
and each Third Party Licensor’s respective affiliates, officers, directors, shareholders, employees, authorized resellers,
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agents and other representatives from all claims, defence costs (including, but not limited to, legal fees), judgments,
settlements and other expenses arising fromor connected with any claim that any authorised or unauthorisedmodi-
fication of the Software or Documentation by Licensee or any person connected with Licensee infringes the intel-
lectual property rights or other proprietary rights of any third party.

12. LIMITATION OF LIABILITY TO BUSINESS USERS

This clause applies where Licensee is a business user. Licensee acknowledges that the Software has not been
developed to meet its individual requirements, and that it is therefore Licensee’s responsibility to ensure that the
facilities and functions of the Software as described in theDocumentationmeet such requirements. The Software
and Documentation is supplied only for Licensee’s internal use for its business, and not for any re-sale purposes or
for the provision of services to third parties. The Foundry shall not under any circumstances whatever be liable to
Licensee, whether in contract, tort (including negligence), breach of statutory duty, or otherwise, arising under or in
connection with the Agreement for loss of profits, sales, business, or revenue, business interruption, loss of anti-
cipated savings, loss or corruption of data or information, loss of business opportunity, goodwill or reputation or any
indirect or consequential loss or damage. In respect of any other losses, The Foundry’smaximumaggregate liability
under or in connection with the Agreement whether in contract, tort (including negligence) or otherwise, shall in all cir-
cumstances be limited to the greater of US$5000 and a sumequal to the License Fee. Nothing in the Agreement
shall limit or exclude our liability for death or personal injury resulting fromour negligence, fraud or fraudulent mis-
representation or for any other liability that cannot be excluded or limited by applicable law. This EULA sets out the
full extent of our obligations and liabilities in respect of the supply of the Software and Documents. Except as
expressly stated in this EULA, there are no conditions, warranties, representations or other terms, express or implied,
that are binding on us. Any condition, warranty, representation or other term concerning the supply of the Software
and Documentation whichmight otherwise be implied into, or incorporated in, the Agreement, whether by statute,
common law or otherwise, is excluded to the fullest extent permitted by law.

13. LIMITATION OF LIABILITY TO CONSUMERS

This clause applies where Licensee is a consumer. Licensee acknowledges that the Software has not been developed
to meet Licensee’s individual requirements, and that it is therefore Licensee’s responsibility to ensure that the facil-
ities and functions of the Software as described in theDocumentationmeet such requirements. The Software and
Documentation are only supplied for Licensee’s domestic and private use. Licensee agrees not to use the Software
and Documentation for any commercial, business or re-sale purposes, and The Foundry has no liability to Licensee
for any loss of profit, loss of business, business interruption, or loss of business opportunity. The Foundry is only
responsible for loss or damage suffered by Licensee that is a foreseeable result of The Foundry’s breach of the Agree-
ment or its negligence but The Foundry is not responsible for any loss or damage that is not foreseeable. Loss or
damage is foreseeable if they were an obvious consequence of a breach or if they were contemplated by you and us
at the time of forming the Agreement. Ourmaximumaggregate liability under or in connection with the Agreement,
whether in contract, tort (including negligence) or otherwise, shall in all circumstances be limited to a sumequal to
the greater of US$5000 and a sumequal to the License Fee. Nothing in the Agreement shall limit or exclude our liab-
ility for death or personal injury resulting fromour negligence, fraud or fraudulent misrepresentation or for any
other liability that cannot be excluded or limited by applicable law.
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14. TERM; TERMINATION

The Agreement is effective upon Licensee's download of the Software, and the Agreement will remain in effect until
termination. Licenseemay terminate the Agreement at any time on written notice to The Foundry. If Licensee
breaches the Agreement, The Foundry may terminate the License by notice to Licensee. If the Agreement is ter-
minated, the Licensewill cease immediately and Licenseewill either return to The Foundry all copies of the Software
and Documentation in Licensee's possession, custody or power or, if The Foundry directs in writing, destroy all such
copies. In the latter case, if requested by The Foundry, Licensee shall provide The Foundry with a certificate con-
firming that such destruction has been completed.

15. CONFIDENTIALITY

Licensee agrees that the Software (including, for the avoidance of doubt, any Source Code that is licensed to
Licensee) and Documentation are proprietary to and the confidential information of The Foundry or, as the case
may be, the Third Party Licensors, and that all such information and any related communications (collectively, "Con-
fidential Information") are confidential and a fundamental and important trade secret of The Foundry and/or the
Third Party Licensors. If Licensee is a business user, Licensee shall disclose Confidential Information only to
Licensee's employees who areworking on an Authorized Project and have a "need-to-know" such Confidential
Information, and shall advise any recipients of Confidential Information that it is to be used only as expressly author-
ized in the Agreement. Licensee shall not disclose Confidential Information or otherwisemake any Confidential
Information available to any other of Licensee's employees or to any third parties without the express written con-
sent of The Foundry. Licensee agrees to segregate, to the extent it can be reasonably done, the Confidential Inform-
ation from the confidential information andmaterials of others in order to prevent commingling. Licensee shall take
reasonable security measures, whichmeasures shall be at least as great as themeasures Licensee uses to keep
Licensee's own confidential information secure (but in any case using no less than a reasonable degree of care), to
hold the Software, Documentation and any other Confidential Information in strict confidence and safe custody.
The Foundry may request, in which case Licensee agrees to comply with, certain reasonable security measures as
part of the use of the Software and Documentation. This clause shall not apply to any information that is in or
comes into the public domain, or was in Licensee’s lawful possession before receipt or which Licensee develops inde-
pendently and without breach of this clause. Licensee acknowledges that monetary damagesmay not be a sufficient
remedy for unauthorized disclosure of Confidential Information, and that The Foundry shall be entitled, without
waiving any other rights or remedies, to such injunctive or other equitable relief asmay be deemed proper by a court
of competent jurisdiction.

16. INSPECTION AND INFORMATION

16.1 Unless Licensee is a consumer, Licensee shall advise The Foundry on demand of all locations where the Soft-
ware or Documentation is used or stored. Licensee shall permit The Foundry or its authorized agents to audit all such
locations during normal business hours and on reasonable advance notice.

16.2 The Softwaremay includemechanisms to collect limited information from Licensee’s computer(s) and transmit
it to The Foundry. Such information (the “Information”) may include details of Licensee’s hardware, details of the
operating system(s) in use on such hardware and the profile and extent of Licensee’s use of the different elements of
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the Software. The Foundry may use the Information to (a) model the profiles of usage, hardware and operating sys-
tems in use collectively across its customer base in order to focus development and support, (b) to provide targeted
support to individual customers, (c) to ensure that the usage of the Software by Licensee is in accordancewith the
Agreement and does not exceed any user number or other limits on its use, and (d) to advise Licensee about service
issues such as available upgrades andmaintenance expiry dates. To the extent that any Information is confidential
to Licensee it shall be treated as such by The Foundry. To the extent that any Information constitutes personal data
for the purposes of the Data Protection Act 1998 it shall be processed by The Foundry in accordancewith that Act
and with The Foundry’s privacy policy (see http://www.thefoundry.co.uk/privacy/). Licensee undertakes to make all
of users of the Software aware of the uses which The Foundry will make of the Information and of the terms of The
Foundry’s privacy policy.

17. NON-SOLICITATION

Licensee agrees not during the term of the Agreement to solicit for employment or retention any of The Foundry's
current or future employees who were or are involved in the development and/or creation and/or support ormain-
tenance of the Software. If Licensee breaches this restriction, Licensee agrees to pay to The Foundry on demand as
liquidated damages a sumequal to 30% of the total of that person’s starting annual salary or other contractual pay-
ment with Licensee. Licensee agrees that this amount shall be recoverable as a debt.

18. U.S. GOVERNMENT LICENSE RIGHTS

All Software, including all components thereof, and Documentation qualify as “commercial items,” as that term is
defined at Federal Acquisition Regulation (“FAR”) (48 C.F.R.) 2.101, consisting of “commercial computer software”
and “commercial computer software documentation” as such terms are used in FAR 12.212. Consistent with FAR
12.212 and DoD FAR Supp. 227.7202-1 through 227.7202-4, and notwithstanding any other FAR or other con-
tractual clause to the contrary in any agreement into which this Agreement may be incorporated, a government end
user will acquire the Software and Documentation with only those rights set forth in this Agreement. Use of either
the Software or Documentation or both constitutes agreement by the government that all Software and Docu-
mentation are “commercial computer software” and “commercial computer software documentation,” and con-
stitutes acceptance of the rights and restrictions herein. The Software is the subject of the following notices:

* Copyright © 2001 - 2014 The Foundry Visionmongers Limited. All Rights Reserved.

* Unpublished-rights reserved under the Copyright Laws of theUnited Kingdom.

19. SURVIVAL.

Clause 6 and clauses 9 to 21 inclusive shall survive any termination or expiration of the Agreement.

20. IMPORT/EXPORT CONTROLS

To the extent that any Softwaremade available under the Agreement is subject to restrictions upon export and/or
re-export from theUnited States, Licensee agrees to comply with, and not act or fail to act in any way that would viol-
ate, the applicable international, national, state, regional and local laws and regulations, including, without limitation,
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the United States Foreign Corrupt Practices Act, the Export Administration Act and the Export Administration Regu-
lations, as amended or otherwisemodified from time to time, and neither The Foundry nor Licensee shall be
required under the Agreement to act or fail to act in any way which it believes in good faith will violate any such laws
or regulations.

21. MISCELLANEOUS

Unless Licensee is a consumer, the Agreement is the exclusive agreement between the parties concerning its subject
matter and supersedes any and all prior oral or written agreements, negotiations, or other dealings between the
parties concerning such subject matter. Licensee acknowledges that Licensee has not relied upon any representation
or collateral warranty not recorded in the Agreement inducing it to enter into the Agreement. The Agreement may be
modified only in writing. The failure of either party to enforce any rights granted under the Agreement or to take
action against the other party in the event of any such breach shall not be deemed awaiver by that party as to sub-
sequent enforcement of rights or subsequent actions in the event of future breaches. The Agreement and any dis-
pute or claim arising out of or in connection with it or its subject matter or formation (including, unless Licensee is a
consumer, non-contractual disputes or claims) shall be governed by, and construed in accordancewith English Law
and the parties irrevocably submit to the non-exclusive jurisdiction of the English Courts, subject to any right that a
consumermay have to bring proceedings or to have proceedings brought against them in a different jurisdiction.

If The Foundry fails to insist that Licensee performs any obligation under the Agreement, or delays in doing so, that
will not mean that The Foundry has waived its rights.

Unless Licensee is a consumer, Licensee agrees that The Foundry may refer to Licensee as a client or a user of the
Software, may display its logo(s) for this purpose andmay publish quotations and testimonials from Licensee, its dir-
ectors, partners, officers or employees. The Foundry agrees to promptly cease any such use on your written request.

The Foundry and Licensee intend that each Third Party Licensormay enforce against Licensee under the Contracts
(Rights of Third Parties) Act 1999 (the “Act") any obligation owed by Licensee to The Foundry under this EULA that is
capable of application to any proprietary or other right of that Third Party Licensor in or in relation to the Software.
The Foundry and Licensee reserve the right under section 2(3)(a) of the Act to rescind, terminate or vary this EULA
without the consent of any Third Party Licensor.

Copyright © 2014 The Foundry Visionmongers Limited. All Rights Reserved. Do not duplicate.
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